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Introduction

In This Chapter
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Overview

The Dominion KX Ill is an enterprise-class, secure, KVM-over-IP switch
that provides 1, 2, 4 or 8 users with remote BIOS-level control of 8 to 64
servers.

KX 11l comes with standard features such as DVI/HDMI/DisplayPort
digital and analog video, audio, virtual media, smart card/CAC, blade
server support, and mobile access.

Deploy KX Il individually, or with Raritan’s CommandCenter Secure
Gateway (CC-SG).

What's New in Help

;

Raritan.

Remote Power Control in KVM Clients

The ability for remote power operations from the Virtual KVM Client
(VKC) and Active KVM Client (AKC) - Remote Power Management
via Virtual KVM Client (VKC) or Active KVM Client (AKC) (on
page 83)

Modem Support

Support for the use of a telephone modem connected to the KX I
modem port - Configuring Modem Settings

Collect Diagnostic Files from the Virtual KVM Client (VKC) or Active
KVM Client (AKC)

New feature that collects image, video and text files, and then
bundles them in a zip file so it can be sent to Raritan Technical
Support. The ciles are collect by selecting a single menu command
from the Tools menu in either the Virtual KVM Client (VKC) or Active
KVM Client (AKC) - Collecting a Diaghostic Snapshot of the
Target (on page 66)
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Restore KX Il Backup File to a KX 1lI

To help customers migrating from the previous generation KX Il to
KX I, the KX Il can restore (i.e. import) a backup file exported from
the KX Il to populate many of the KX III's settings and options -
Applying KX 1l Appliance Setting to a KX Il Using a Backup/Restore
File

Package Contents

Each KX 1l ships as a fully-configured stand-alone product in a standard
1U (2U for KX3-864) 19" rackmount chassis. Each KX Il device ships
with the following contents:

1 - KX Il device

1 - KX 1l Quick Setup Guide

1 - Rackmount kit

2 - AC power cords

1 - Set of 4 rubber feet (for desktop use)
1 - Application note

1 - Warranty card

KX Ill Device Photos and Features

Hardware

Integrated KVM-over-IP remote access
1U or 2U rack-mountable (brackets included)

Dual power supplies with failover; autoswitching power supply with
power failure warning

Support for the following CIMs:

= For virtual media and Absolute Mouse Synchronization, use one
of the following CIMs:

= D2CIM-VUSB
= D2CIM-DVUSB
= D2CIM-DVUSB-DVI
= D2CIM-DVUSB-HDMI
= D2CIM-DVUSB-DP
= Required for PS2 connection:
= DCIM-PS2
DVI monitor support from the DVI local port

= VGA support via a DVI to VGA converter

==
—— 8
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= DVI support via a standard DVI cable
Remote access and power management from an iPhone® or iPad®

Support for tiering in which a base KX Il device is used to access
multiple other tiered devices

Multiple user capacity (1/2/4/8 remote users; 1 local user)
UTP (Cat5/5e/6) server cabling

Dual Ethernet ports (10/100/1000 LAN) with failover

Field upgradable

Local USB User port for in-rack access

= USB Keyboard/mouse ports

= One front and three back panel USB ports for supported USB
devices

= Fully concurrent local and remote user access

= Local graphical user interface (GUI) for administration
Serial port to connect to an external modem

Centralized access security

Integrated power control

LED indicators for dual power status, network activity, and remote
user status

Hardware Reset button

Software

Virtual media support in Windows®, Mac® and Linux® environments*
Absolute Mouse Synchronization*

*Note: Virtual media and Absolute Mouse Synchronization require
use of a D2CIM-VUSB, D2CIM-DVUSB, D2CIM-DVUSB-DVI,
D2CIM-DVUSB-HDMI or D2CIM-DVUSB-DP CIM.
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e Support for digital audio over USB

e Port scanning and thumbnail view of up to 32 targets within a
configurable scan set

e Web-based access and management
e Intuitive graphical user interface (GUI)
e Support for dual port video output

e  256-bit encryption of complete KVM signal, including video and
virtual media

e LDAP, Active Directory®, RADIUS, or internal authentication and
authorization

e DHCP or fixed IP addressing

e Smart card/CAC authentication

e SNMP, SNMP3 and Syslog management

e |Pv4 and IPv6 support

e Power control associated directly with servers to prevent mistakes

e Integration with Raritan's CommandCenter Secure Gateway (CC-
SG) management unit

e CC Unmanage feature to remove device from CC-SG control
e Support of Raritan PX1 and PX2 appliances

Dominion KX3-832

KX3-832 Photos

KX3-832 Features

]
i
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Diagram key
Dual Power AC 100V/240V

Dual 10/100/1000 Ethernet access

Local USB ports

DVI-D port

32 KVM ports for UTP Cabling (Cat5/5e/6)

Tier port for tiering devices

Modem port for external modems
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Dominion KX3-864

KX3-864 Photos

Diagram key

0OOOOO

Dual Power AC 100V/240V

Dual 10/100/1000 Ethernet access

Local USB ports

DVI-D port

64 KVM ports for UTP Cabling (Cat5/5e/6)

Tier port for optional tiering devices
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Modem port for optional external modems
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Supported Users and Ports per Model

Model
KX3-864

KX3-832
KX3-808
KX3-464
KX3-432
KX3-416
KX3-232
KX3-216
KX3-132
KX3-116
KX3-108

Ports
64

32
8

64
32
16
32
16
32
16
8

Remote users

R P R NN M BN M O © ©

KX Ill Remote and Local Console Interfaces

i
i
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Use the Remote Console interface to configure and manage the KX I

over a network connection.

The Local Console interface provides access to the KX Il while at the

rack.

See KX Il Remote Console Interface (on page 18), KX Il Local
Console - KX Ill Administration Functions and KX Il Local Console
Interface (on page 27), respectively.
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KX Il KVM Client Applications

KX Il works with the Virtual KVM Client (VKC) and the Active KVM Client
(AKC).

Java™ 1.7 is required to use the Java-based Virtual KVM Client (VKC).

Microsoft .NET® 3.5 (or later) is required to use KX Il with the Microsoft
Windows®-based Active KVM Client (AKC).

For help on using the clients, see Virtual KVM Client (VKC) Help (on
page 38) and Active KVM Client (AKC) Help (on page 84).

KX Il Online Help

KX 1l online help is considered your primary help resource. PDF
versions of help are a secondary resource.

See the KX lll Release Notes for important information on the current
release before you begin using the KX 111,

KVM Client help is provided as part of KX Il online help.

Online help is accompanied by the KX Il Quick Setup Guide, which can
be found on the Raritan Firmware, Upgrades and Documentation page of
Raritan's website (http://www.raritan.com/support/firmware-and-
documentation).

The Firmware, Upgrades and Documentation page also contains a PDF
version of the administrator help.

Note: To use online help, Active Content must be enabled in your
browser.

uj
i
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Getting Started

In This Chapter
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Converting a Binary Certificate to a Base64-Encoded DER Certificate
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Logging IN to the KX ... 17

Install and Configure KX llI

If you have not already done so, install and configure KX III.

See the KX IIl Quick Setup Guide that came with the KX Il device or
download it from the Raritan Support website
http://www.raritan.com/support.

Allow Pop-Ups

Regardless of the browser used, you must allow pop-ups from the
device's IP address to launch the KX 1ll Remote Console.

Security Warnings and Validation Messages

;
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When logging in to KX 11, security warnings and application validation
message may appear.

These include -

e Java" security warnings and requests to validate KX IlI

See Java Validation and Access Warning (on page 10), and
Installing a Certificate (on page 10)

e Additional security warnings based on your browser and security
settings

See Additional Security Warnings (on page 10)
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Java Validation and Access Warning

When logging in to KX III, Java™ 1.7 prompts you to validate KX IIl, and
to allow access to the application.

Raritan recommends installing an SSL certificate in each KX Ill device in
order to reduce Java warnings, and enhance security. See SSL
Certificates

Additional Security Warnings

Even after an SSL certificate is installed in the KX I, depending on your
browser and security settings, additional security warnings may be
displayed when you log in to KX 111

It is necessary to accept these warnings to launch the KX Il Remote
Console.

Reduce the number of warning messages during subsequent log ins by
checking the following options on the security and certificate warning
messages:

¢ Inthe future, do not show this warning
e Always trust content from this publisher

Installing a Certificate

You may be prompted by the browser to accept and validate the KX IlI's
SSL certificate.

Depending on your browser and security settings, additional security
warnings may be displayed when you log in to KX III.

It is necessary to accept these warnings to launch the KX Il Remote
Console. For more information, see Security Warnings and Validation
Messages (on page 9).

Two sample methods on how to install an SSL Certificate in the browser
are provided here, both using Microsoft Internet Explorer 8° and
Windows 7°.

Specific methods and steps depend on your browser and operating
system. See your browser and operating system help for details.

]
i
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Example 1: Import the Certificate into the Browser

In this example, you import the Certificate into the browser.

Time & Session:

December 16, 2013 07.08:17 /i) The certificate used to ilentfy the website i not trusted. The reasons

are ksted below.

l Port Access

§
i
i
i

The certificate Authority that issued ths certficate is not trusted.

&. Do you want to Continue?
| The connection to this website is untrusted. r

The application is being downloaded from a site other than the one

/ specified by the security certificate.
/ ! s Website: httos://192.163.61.20:443 :Madnoﬁom x:'ws.nm
Note: The o

G &»\wc«mnuu’]
This appication wil be blocked n & future Java security Lpdste JAR fie manifest does not
Gentahy atirbute. Ple - More Informaton Note to the Publisher: Seaunity featires to prevent
thorized redistrib f your Java wil cause ths
| to be biocked in the future. See current Java

d about JAR Manifest entries for the changes that
N need to be made.

| Goomrve ||| coce |

NALXEGH K Y SO

7 -
s::: o-;ewn l 8 Note to users: For any questions, please contact the Publsher
| who provided you with this application.

Connected Users:

admn (192.168.51.75)
43 min idie

sahigaisonnl) Lo L€ 0| g 20 o Visit Java.com for more detads [(cose

,
\

Steps
o Open an IE browser, then log in to KX 111,

e Click More Information on the first Java™ security warning.

e Click View Certificate Details on the More Information dialog. You are prompted to
install the certificate. Follow the wizard steps.

Note: If you are not prompted by the browser, manually select Tools > Internet
Options to open the Internet Options dialog.

11
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Intermet Opticns
Generai | i Content | Connactny
Content
9\ Ratings heb you control the Interet co
vewed on the computer
Certficates

Use certficates for encrypted connectol

A
il (Bl > Cetfcates

AutoComplete

Cortiticate lmpont Wizard . A—

Wizard

Pues

Welcome to the Certificate Import

Thvs waed helos you copy cesbcates, cerphcate Vst

-8B ists, and certécate revocason ket from your dek 10 &
s cartiicane store.

A certicate, which & smued by & cercaton sthonty, &
of your dhenity

corvicares are
To contrue, dick Nest.

e 1o protect data o 1o estableh
convectons. A certcate stre | the system wea here
=

- AutoC pove
3 0 wepages and suests matches
for you.
Feeds and Web Sices

7] Feeds and Web Skoes provide updated
) content fom webstes that can be

Ceriicate Ynport Wkt T —— ﬁ
| Completing the Certificate Import

Wizard

read in Intermet Explorer and other
frograms a4

o--

o The import was successhl.

oK

Certfcate brport Wazard e

The certhcate il be mported after you Ak Frsh.

Click the Content tab.

Click Certificates.

The Certificate Import Wizard opens and walks you through each step.

= File to Import - Browse to locate the Certificate

= Certificate Store - Select the location to store the Certificate

Click Finish on the last step of the Wizard.

The Certificate is imported. Close the success message.

Click OK on the Internet Options dialog to apply the changes, then close and reopen

the browser.

=i=Raritan.
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Example 2: Add the KX Il to Trusted Sites and Import the Certificate

In this example, the KX IlI's URL is added as a Trusted Site, and the Self
Signed Certificate is added as part of the process.

ﬂ@ogn‘w.mhwwﬂw! r'y — —— —
S hitps://vwevv googhe.com - a&lel

Delete Beowsing History... Ctrle Shifts Del
InPrivate Browsing Cerle ShifteP

=

InPrivate Fitering - Seanty | privacy | Content | Connections | Programs | Advanced

Reopen Last Browsing Session Tntemet Options

InPrivate Fitering Settings
Select & 20ne 10 view Or Change secunty setangs.
Pop-up Blocker t 0 \/ Q
SmatScreen Filter - a o
Manage Add-ons o
Trusted sites
patituldy View f T zone contars mebanes —_
V' rustret 1o daage yeur o
your files. =
Compatibiity View Settings o s R T e
Subscribe to this Feed. Seautty level for B Jone 1
Feed Discovery £ You anadd andremove webats fom 856 e Al websies s |
Custom o/ 5 ore vl e the 20ne's secunity settngs. [
Windows Update Custom setings.

~Ta change the setings, dick Custom level.
T2 use T recommended setangs, cick Defoultevel

Developer Tocks Add s website 10 the zone: R ‘
hitpr223.345 5667 |

Send to Bluetooth Device... .

OneNote Linked Notes

Cuntom ievel. .. Oefoutievel Webstes:

nd to OneNote Feset ol 20nes 10 defat el l

- o Cancel
&‘» Requre server verficaton (httos:) for ol stes in s xone.
P — POGY oo Y £ W P A P o °_>m

Steps

Open an IE browser, then select Tools > Internet Options to open the Internet Options
dialog

Click the Security tab.

Click on Trusted Sites.

Disable Protected Mode, and accept any warnings.
Click Sites to open the Trusted Sites dialog.

Enter the KX IIl URL, then click Add.

Deselect server verification for the zone (if applicable).
Click Close.

Click OK on the Internet Options dialog to apply the changes, then close and reopen
the browser.

Next, import the Certificate.

13
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Dominion® KX III

Home > Ports

Port Access | Pc:wcrl_vmunl Media | User Management | Device Settings | Security | Maintenance | Diagnosti

More Information 2

Time & Session:
December 16, 2013 07:08:17

Security Warning

Port Access

{

Do you want to Continue?
The connection to this website is untrusted.

c! 5 Website: httos:/192. 163.61.20:443
Note: Th 2

¥ Y
This applicaton future X wdate u] fest
contan the Permissions attrbute. Please contact the Publsher More Information

(i The certificate used to identfy the website is not trusted. The reasons

ore isted below.
Proceed at your own risk.

The certificate Authority that issued ths certificate is not trusted.

The application i being downloaded from a site other than the one
specified by the security certficate.
Dowrioading from "192.168.61.20"

Expecting Raritan KvM
e—yxm

MNote to the Publisher: Seaunty features to prevent
of Java will cause this

to be biodked in the future, See current Java

im-HWJ}H

7 Ports. down

& Ports: idie [ e

Connected Users:
admin (182.168.51.75)
43 min idie

admn (Lgcal Consgle) PU S N

Dominion_KX3_Por

r.) *d o

about JAR Manifest entries for the changes that
need to be made.

Note to users: For any questions, please contact the Publsher
who provided you with this application.

Visit Java.com for more detads

Steps

Open an IE browser, then log in to KX IlI.

Click More Information on the first Java™ security warning.

Click View Certificate Details on the More Information dialog. You are prompted to

install the certificate. Follow the wizard steps.

For details see, Example 1: Import the Certificate into the Browser (on page 11)

=i=Raritan.
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Converting a Binary Certificate to a Base64-Encoded DER Certificate
(Optional)

KX 11l requires an SSL certificate in either Base64-Encoded DER format
or PEM format.

If you are using an SSL certificate in binary format, you cannot install it.

However, you can convert your binary SSL certificate.

V3
Oce7eDe5 17d8 46 fe8feS ... |
shaIRSA

shal

DigiCert Assured ID Root CA, ...
Thursday, November 09, 2006...
Sunday, November 09, 2031 7...
Nini"art & A TN RPant CA

Learn more about certificate details

(1)  Locate the DEGHKVMOOOL.cer binary file on
your Windows machine.

Double-click on the DEGHKVMO0001.cer file to
open its Certificate dialog.

@ Click the Detail tab.

@ Click "Copy to File...".

15
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Welcome to the Certificate Export
Wizard

This wizard helps you copy certificates, certificate trust
lists and certificate revocation lists from a certificate
store to your disk.

A certificate, which is issued by a certification authority, is
a confirmation of your identity and contains information
used to protect data or to establish secure network
connections, A certificate store is the system area where
certificates are kept.

To continue, dick Next.

(o> ] (]

The Certificate Export Wizard opens. Click Next
to start the Wizard.

Certificates can be exported in a variety of file formats,

Select the format you want to use:
(©) DER encoded binary X.509 (.CER)

|_lIndude all certificates in the certification path if possible
Personal Information Exchange - PKCS #12 (.PFX)
|_lIndude all certificates in the certification path if possible
[ |Delete the private key if the export is successful

| |Export all extended properties

Microsoft Serizlized Certificate Store (.SST)

Learn more about certificate file formats

[ <Bak [ mext> ] [ cancel |

@ Select "Base-64 encoded X.509" in the second
Wizard dialog.

=i=Raritan.
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Click Next to save the file as a Base-64 encoded
X.509.

You can now install the certificate on your KX III.

Logging In to the KX I

;
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Log in to your KX Il Remote Console from any workstation with network
connectivity. Java™ 1.7 is required to use the Java-based Virtual KVM
Client (VKC). Alternatively, Microsoft .NET® 3.5 (or later) is required to
use KX Il with the Microsoft Windows®-based Active KVM Client (AKC).

Logging in and using KX Ill requires you to allow pop-ups.

For information on security warnings and validation messages, and steps
to reduce or eliminate them, see Security Warnings and Validation
Messages (on page 9).

>

To log in to the KX I
Launch a supported web browser.
Enter either:

= The URL - http://IP-ADDRESS to use the Java-based Virtual
KVM Client

Or

= http://IP-ADDRESS/akc for the Microsoft .NET-based Active KVM
Client

IP-ADDRESS is the IP address assigned to your KX Il

You can also use HTTPS, or the DNS name of the KX Ill assigned by
your administrator (if applicable).

You are always redirected to the IP address from HTTP to HTTPS.
Enter your username and password, then click Login.
Accept the user agreement (if applicable).

If security warnings appear, accept and/or allow access.

17
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KX 1l Interface and Navigation

In This Chapter

(@ 1YY /<N TR 18
KX 11l Remote Console INtEITACE ......uueiiiiiiiieeieee e 18
KX 111 Local Console INtEIfAaCE ........uuvveiiiiiiiieeee e 27

Overview

The KX 1l Remote Console and the KX Ill Local Console interfaces
provide a web-based interface for device configuration and
administration, as well as target server list and selection.

KX Ill Remote Console Interface

i
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The KX 1l Remote Console is a browser-based graphical user interface
that allows you to log in to KVM target servers and serial targets
connected to the KX Il and to remotely administer the KX 111.

The KX 1l Remote Console provides a digital connection to your
connected KVM target servers. When you log into a KVM target server
using the KX Il Remote Console, a Virtual KVM Client window opens.

There are many similarities among the KX 11l Local Console and the KX
Il Remote Console graphical user interfaces, and where there are
differences, they are noted in the user manual. The following options are
available in the KX Il Remote Console but not the KX IIl Local Console:

e Virtual Media

e Favorites

e Backup/Restore

e Firmware Upgrade
e SSL Certificates

e Audio

18
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Port Access Page (Remote Console Display)

After a successful login, the Port Access page opens listing all ports
along with their status and availability.

Ports connected to KVM target servers (blades and standard servers)
are displayed in blue. Right-click on any of these ports to open the Port
Action menu. For more information, see Port Action Menu (on page 22).

If a KX Il port has no CIM connected or is connected to a CIM with no
name, a default port name of Dominion_Dominion-KX3_Port# is
assigned to the port. Dominion_KX3 is the device model and Port# is the
number of the KX Il physical port.

==Raritan.

Daominio 1
Home > Ports

Time & Session:

irtual Media | User Management | Device Seffings | Security | Maintenance | Disgnostics | Help

December 05, 2013 142127 Port Access
Usar: admin Click on the individual port name to see allowable operations.
State 3 min idle

Your P 192,168 32,165 0/ 4 Remote K\VM channels currently in use.

Last Login: Dec 05, 2013 11:40:42

Views By Group | View By Search | Set Scan
Devies Information:

Device Name: DominionKX-sample L
P Addrese. 192 168.561.20 1 HDMI Target OIA-HDMI =] de
;';’:‘:':L’;gﬁ-tmgﬂn 2 Dorinion-KX2_Port2 VIOV up itk
Hetwork LANT 3 Low Coel DV [PA20540016] Duak-vi ug o
E:g:% ;'“ P Windowes P SR DCw W e
Configured As Gase 5 DP-Craminian-KX2_Paort13 oVI-DP ug de
1 ] Domini DCi ug die
Port States: 7 Deminien-Kx2_Per? Duak-vi ug e
:QP::;:’;::." ] pe-kel-update [Iya— down de
413 Ports: die 9 ¥ KXB4-80-234-TerS TierDevics up die
10 » B3250-241 tierd TierDevice ug e
Connected Users: " ¥ KXE3Z-51-14-Tiarl TiarDevics ug (43
ad ?;"1;!;‘0_:?; Console) 111 DCMS mulatorfortl2S oCiw up die
admin (192 16832 165) 11-2 DCMSimulatorPortd28 DCi up die
3 min ek 11-3 DCMSimulatorPort)Z7 DCie ug e
114 DCMSimulatorPortd3s Dcie ug (43
‘ning Halp AN A
Favorite Devies=: A l;l l;l ﬂ ~Vfepage 15 Rows per Pagcﬂ
Four tabs are provided on the page allowing you to view by port, view by
group, view by search and scan ports.
You can sort by Port Number, Port Name, Status (Up and Down), and
Availability (Idle, Connected, Busy, Unavailable, and Connecting) by
clicking on the column heading.
Use the Set Scan tab to scan for up to 32 targets that are connected to
the KX lll. See Scanning Ports - Remote Console (on page 99)
Tiered Devices - Port Access Page
If you are using a tiered configuration in which a base KX Il device is
used to access multiple other tiered devices, the tiered devices are
viewed on the Port Access page by clicking on the Expand Arrow icon »
to the left of the tier device name.
e 19
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Blade Chassis - Port Access Page

The blade chassis is displayed in an expandable, hierarchical list on the
Port Access page, with the blade chassis at the root of the hierarchy and
the individual blades labeled and displayed below the root. Use the
Expand Arrow icon ® next to the root chassis to display the individual
blades.

Note: To view the blade chassis in a hierarchal order, blade-chassis
subtypes must be configured for the blade server chassis.

Dual Port Video Groups - Port Access Page

Dual video port groups appear on the Port Access page as Dual Port
types.

The primary and secondary ports that are a part of the port group appear
on the Port Access page as Dual Port(P) and Dual Port(S), respectively.
For example, if the CIM type is DCIM, "DCIM Dual Port (P)" is displayed.

When you access a dual port video group from the remote client, you
connect to the primary port, which opens a KVM connection window to
both the primary and secondary ports of the dual port group.

Note: The dual video primary port is defined when the port group is
created.

Note: You cannot remotely connect to the dual video port group by
clicking on a primary port unless two KVM channels are available. If two
channels are not available, the Connect link is not displayed.

Note: The Action menu is not displayed when you click on a secondary
port in a dual video port group.

Note: You cannot connect to the primary port and secondary port at the
same time from the Local Port.

]
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View by Group Tab

The View by Group tab displays blade chassis, 'standard' port groups,
and dual video port groups. Click the Expand Arrow icon * next to a
group to view the ports assigned to the port group.

.-.ov(
Port Access

Ciick on the indrvidual port name to see allowable operations.
0/2 Remote KVM channels curreatly in use,

wailabitity

N 2 Rows par Page [ Sut |
warrion g P g™ P P g e S /

View by Search Tab

The View by Search tab allows you to search by port name. The search
feature supports the use of an asterisk (*) as a wildcard, and full and
partial names.

Set Scan Tab

The port scanning feature is accessed from the Set Scan tab on the Port
Access page. The feature allows you to define a set of targets to be
scanned. Thumbnail views of the scanned targets are also available.
Select a thumbnail to open that target in its Virtual KVM Client window.

See Scanning Ports - Remote Console (on page 99) for more
information.

Raritan. =
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Port Action Menu

When you click a Port Name in the Port Access list, the Port Action menu
appears.

Choose the desired menu option for that port to execute it. Note that only
currently available options, depending on the port's status and
availability, are listed in the Port Action menu.

Home = Ports

Port Access

Click on the individual port name to see allowable operations.
0/ 4 Remote KVM channels currently in use.

Wiew By Part|| View By Group | Viiew By Search | Set Scan

!
{
¢
?

Connect

1 HOMI Target
pd — _Port2
3 Mﬁ, [PO20540016] ﬁ
< Windows XP SP3
1 S T e T v

a——— gk

Connect - Creates a new connection to the target server

For the KX Ill Remote Console, a new Virtual KVM Client page

appears.

For the KX Ill Local Console, the display switches to the target
server, and switches away from the local user interface.

On the local port, the KX III Local Console interface must be visible in

order to perform the switch.

Hot key switching is also available from the local port.

Note: This option is not available from the KX Il Remote Console for
an available port if all connections are busy.

=i=Raritan.
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Switch From
e Switch From - Switches from an existing connection to the selected
port (KVM target server)

This menu item is available only for KVM targets, and only when a
Virtual KVM Client is opened.

Note: This menu item is not available on the KX Ill Local Console.

Home = Ports

Port Access

Click on the individual port name to see allowable operations.
1./ 4 Remote KVM channels currently in use.

Wiew By Port | View By Group | View By Search | Set Scan

Switch From HDMI Target
Connect

3 Low Cost DVM [PQ20540016] -
e, = —
. ! 'D"."' =t v‘ P ’ [ f A sk

Disconnect

e Disconnect - Disconnects this port and closes the Virtual KVM Client
page for this target server

This menu item is available only when the port status is up and
connected, or up and busy.

'-— 23
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Note: This menu item is not available on the KX Ill Local Console.
The only way to disconnect from the switched target in the Local
Console is to use the hot key.

Home = Ports

1
o
Port Access
Click on the individual port name to see allowable aperat:‘ans.f
1 /4 Remote K\VM channels currently in use. :

View By Group | View By Search | Set Scan

2 Dominion-KX2_Fort? /
j"‘ I U R— Y _.LH.UM[PFDHW] !,.‘- -—._..’__‘_’_-/

Power On

Power On - Powers on the target server through the associated
outlet

This option is visible only when there are one or more power
associations to the target, and when the user has permission to
operate this service.

Provided you have privileges to do so, you can manage power from
the Virtual KVM Client (VKC) and Active KVM Client (AKC) as well.
See Remote Power Management via Virtual KVM Client (VKC) or
Active KVM Client (AKC) (on page 83)

Power Off

Power Off - Powers off the target server through the associated
outlets
This option is visible only when there are one or more power

associations to the target, when the target power is on (port status is
up), and when user has permission to operate this service.

Provided you have privileges to do so, you can manage power from
the Virtual KVM Client (VKC) and Active KVM Client (AKC) as well.
See Remote Power Management via Virtual KVM Client (VKC) or
Active KVM Client (AKC) (on page 83)

ERaritan.
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Power Cycle

Raritan.

Power Cycle - Power cycles the target server through the associated
outlets

This option is visible only when there are one or more power
associations to the target, and when the user has permission to
operate this service.

Provided you have privileges to do so, you can manage power from
the Virtual KVM Client (VKC) and Active KVM Client (AKC) as well.
See Remote Power Management via Virtual KVM Client (VKC) or
Active KVM Client (AKC) (on page 83)

25



Chapter 3: KX IIl Interface and Navigation

Left Panel

The left panel of the KX Il interface contains the following information.

Note that some information is conditional - meaning it is displayed based
on your role, features being used and so on. Conditional information is

noted here.
Information Description When displayed?
Time & Session The date and time the Always
current session started
User Username Always
State The current state of the ~ Always
application, either idle or
active. If idle, the
application tracks and
displays the time the
session has been idle.
Your IP The IP address used to Always
access the KX 11l
Last Login The last login date and Always
time
Under CC-SG The IP address of the When the KX Ill is
Management CC-SG device managing being managed by
the KX Il CC-SG

Device Information Information specific to the Always
KX Il you are using

Device Name Name assigned to the Always
device

IP Address The IP address of the KX  Always
1

Firmware Current version of Always
firmware

Device Model Model of the KX 111 Always

Serial number Serial number of the KX  Always
1

Network The name assigned to Always

the current network

]
i
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Information
Powerinl

PowerIn2

Configured As
Base or Configured
As Tiered

Port States

Connect Users

Online Help

Favorite Devices

FIPS Mode

Chapter 3: KX III Interface and Navigation

Description

Status of the power 1
outlet connection. Either
on or off, or Auto-detect

off

Status of the power 2
outlet connection. Either
on or off, or Auto-detect

off

If you are using a tiering

configuration, this

indicates if the KX 1l you
are accessing is the base
device or a tiered device.

The statuses of the ports
being used by the KX IlI

The users, identified by
their username and IP

address, who are

currently connected to the

KX 11

Links to online help

See Managing Favorites

(on page 105)

FIPS Mode: EnabledSSL
Certificate: FIPS Mode

Compliant

When displayed?
Always

Always

When the KX Il is
part of a tiered
configuration

Always

Always

Always

When enabled

When FIPS is
enabled

KX Ill Local Console Interface

;

Raritan.

There are many similarities among the KX Ill Local Console and the KX

Il Remote Console graphical user interfaces. Where there are
differences, they are noted in the help.

For details on using the Local Console see KX Il Local Console (on

page 109).
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Overview

i
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All KX 1l models support virtual media. Virtual media extends KVM
capabilities by enabling target servers to remotely access media from a
client PC and network file servers.

With this feature, media mounted on client PCs and network file servers
are essentially "mounted virtually" by the target server. The target server
can then read from and write to that media as if it were physically
connected to the target server itself.

Each KX 1ll comes equipped with virtual media to enable remote
management tasks using the widest variety of CD, DVD, USB, audio
playback and record devices, internal and remote drives, and images.

Virtual media sessions are secured using 128 or 256 bit AES, or RC4
encryption.

28
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Prerequisites for Using Virtual Media

;

Raritan.

KX Il Virtual Media Prerequisites

e For users requiring access to virtual media, the KX Ill permissions
must be set to allow access to the relevant ports, as well as virtual
media access (VM Access port permission) for those ports. Port
permissions are set at the group-level.

e A USB connection must exist between the device and the target
server.

e If you want to use PC-Share, Security Settings must also be enabled
in the Security Settings page. Optional

e You must choose the correct USB profile for the KVM target server
you are connecting to.

Remote PC VM Prerequisites

e Certain virtual media options require administrative privileges on the
remote PC (for example, drive redirection of complete drives).

Note: If you are using Microsoft Vista or Windows 7, disable User
Account Control or select Run as Administrator when starting
Internet Explorer. To do this, click the Start Menu, locate IE, right-
click and select Run as Administrator.

Target Server VM Prerequisites
e KVM target servers must support USB connected drives.
e USB 2.0 ports are faster and preferred.

CIMs Required for Virtual Media

You must use one of the following CIMs is to use virtual media:
e D2CIM-VUSB

e D2CIM-DVUSB

e D2CIM-DVUSB-DVI

e D2CIM-DVUSB-HDMI

e D2CIM-DVUSB-DP

The black connector on the DVUSB CIMs are used for the keyboard and
mouse. The gray connector is used for virtual media.

Keep both plugs of the CIM connected to the device.

The device may not operate properly if both plugs are not connected to
the target server.

29
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Mounting Local Drives

This option mounts an entire drive, which means the entire disk drive is
mounted virtually onto the target server.

Use this option for hard drives and external drives only. It does not
include network drives, CD-ROM, or DVD-ROM drives.

Notes on Mounting Local Drives

KVM target servers running the Windows XP® operating system may not
accept new mass storage connections after an NTFS-formatted partition
(for example, the local C drive) has been redirected to them.

If this occurs, close the Remote Console and reconnect before
redirecting another virtual media device. If other users are connected to
the same target server, they must also close their connections to the
target server.

Supported Tasks Via Virtual Media

Virtual media provides the ability to perform tasks remotely, such as:
e Transferring files

e Running diagnostics

e Installing or patching applications

e Complete installation of the operating system

e Record and playback of digital audio

Important: Once you are connected to a virtual media drive, do not
change mouse modes in the KVM client if you are performing file
transfers, upgrades, installations or other similar actions. Doing so may
cause errors on the virtual media drive or cause the virtual media drive to
fail.
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Supported Virtual Media Types

The following virtual media types are supported for Windows®, Mac® and
Linux™ clients:

Internal and external hard drives

Internal and USB-mounted CD and DVD drives
USB mass storage devices

PC hard drives

ISO images (disk images)

ISO9660 is the standard supported by Raritan. However, other ISO
standards can be used.

Digital audio devices*

Conditions when Read/Write is Not Available

Virtual media Read/Write is not available in the following situations:

For Linux® and Mac® clients

When the drive is write-protected

When the user does not have Read/Write permission:
= Port Permission Access is set to None or View

= Port Permission VM Access is set to Read-Only or Deny

Supported Virtual Media Operating Systems

The following client operating systems are supported:

Windows® 7 operating system
Windows 8 operating system
Windows XP® operating system
openSUSE® 11.4 Celadon (x86_64)
Fedora® 18

RHEL® 6.4

OSX Mountain Lion® 10.7 (and later)
Solaris® 10

The Active KVM Client (AKC) can be used to mount virtual media types
but only for Windows operating systems.

Raritan.

;
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Number of Supported Virtual Media Drives

With the virtual media feature, you can mount up to two drives (of
different types) that are supported by the USB profile currently applied to
the target. These drives are accessible for the duration of the KVM
session.

For example, you can mount a specific CD-ROM, use it, and then
disconnect it when you are done. The CD-ROM virtual media “channel”
will remain open, however, so that you can virtually mount another CD-
ROM. These virtual media “channels” remain open until the KVM session
is closed as long as the USB profile supports it.

To use virtual media, connect/attach the media to the client or network
file server that you want to access from the target server.

This need not be the first step, but it must be done prior to attempting to
access this media.

Connecting and Disconnecting from Virtual Media

Access a Virtual Media Drive on a Client Computer

Important: Once you are connected to a virtual media drive, do not
change mouse modes in the KVM client if you are performing file
transfers, upgrades, installations or other similar actions. Doing so may
cause errors on the virtual media drive or cause the virtual media drive to
fail.
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> To access avirtual media drive on the client computer:

1. From the KVM client, choose Virtual Media > Connect Drive, or click

the Connect Drive... button D The Map Virtual Media Drive dialog
appears.

Map Virtual Media Drive e

Select a local drive to mount onto the target server.

Local Drive:

ol E {Hard Disk Partition) ,:

Read-Write

| [ QK ][ Cancel ]I

Choose the drive from the Local Drive drop-down list.

If you want Read and Write capabilities, select the Read-Write
checkbox.

This option is disabled for nonremovable drives. See the Conditions
when Read/Write is Not Available (on page 31) for more
information.

When checked, you will be able to read or write to the connected
USB disk.

WARNING: Enabling Read/Write access can be dangerous!
Simultaneous access to the same drive from more than one entity
can result in data corruption. If you do not require Write access,
leave this option unselected.

Click OK. The media will be mounted on the target server virtually.
You can access the media just like any other drive.

Mounting CD-ROM/DVD-ROM/ISO Images
This option mounts CD-ROM, DVD-ROM, and ISO images.

Note: ISO9660 format is the standard supported by Raritan. However,
other CD-ROM extensions may also work.

> To access a CD-ROM, DVD-ROM, or ISO image:

From the KVM client, choose Virtual Media > Connect CD-ROM/ISO

&
Image, or click the Connect CD ROM/ISO button . The Map
Virtual Media CD/ISO Image dialog appears.

33
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2. Forinternal and external CD-ROM or DVD-ROM drives:
a. Choose the Local CD/DVD Drive option.

b. Choose the drive from the Local CD/DVD Drive drop-down list.
All available internal and external CD and DVD drive names will
be populated in the drop-down list.

c. Click Connect.
3. For ISO images:

a. Choose the 1ISO Image option. Use this option when you want to
access a disk image of a CD, DVD, or hard drive. ISO format is
the only format supported.

b. Click Browse.

c. Navigate to the path containing the disk image you want to use
and click Open. The path is populated in the Image Path field.

d. Click Connect.
4. For remote ISO images on a file server:
a. Choose the Remote Server ISO Image option.

b. Choose Hostname and Image from the drop-down list. The file
servers and image paths available are those that you configured
using the File Server Setup page. Only items you configured
using the File Server Setup page will be in the drop-down list.

c. File Server Username - User name required for access to the file
server. The name can include the domain name such as
mydomain/username.

d. File Server Password - Password required for access to the file
server (field is masked as you type).

e. Click Connect.

The media will be mounted on the target server virtually. You can
access the media just like any other drive.

Note: If you are working with files on a Linux® target, use the Linux Sync
command after the files are copied using virtual media in order to view
the copied files. Files may not appear until a sync is performed.

Note: If you are using the Windows 7° operating system®, Removable
Disk is not displayed by default in the Window's My Computer folder
when you mount a Local CD/DVD Drive or Local or Remote ISO Image.
To view the Local CD/DVD Drive or Local or Remote ISO Image in this
folder, select Tools > Folder Options > View and deselect "Hide empty
drives in the Computer folder".

Note: You cannot access a remote ISO image via virtual media using an
IPv6 address due to third-party software technical limitations.

=i=Raritan.
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Disconnect from Virtual Media Drives

» To disconnect the virtual media drives:
e For local drives, choose Virtual Media > Disconnect Drive.

e For CD-ROM, DVD-ROM, and I1SO images, choose Virtual Media >
Disconnect CD-ROM/ISO Image.

Note: In addition to disconnecting the virtual media using the Disconnect
command, simply closing the KVM connection closes the virtual media
as well.

Virtual Media in a Windows XP Environment

If you are running the Virtual KVM Client or Active KVM Client in a
Windows® XP environment, users must have Administrator privileges to
access any virtual media type other than CD-ROM connections, ISOs
and ISO images.

Virtual Media in a Linux Environment

;
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Active System Partitions

You cannot mount active system partitions from a Linux client.

Linux Ext3/4 drive partitions need to be unmounted via umount
/dev/<device label> prior to a making a virtual media connection.

Drive Partitions
The following drive partition limitations exist across operating systems:

e Windows® and Mac targets are not able to read Linux formatted
partitions

e Windows and Linux cannot read Mac formatted partitions
e Only Windows Fat partitions are supported by Linux

Root User Permission Requirement

Your virtual media connection can be closed if you mount a CD ROM
from a Linux client to a target and then unmount the CD ROM.

To avoid these issues, you must be a root user.
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Virtual Media in a Mac Environment

Active System Partition

You cannot use virtual media to mount active system partitions for a Mac
client.

Drive Partitions
The following drive partition limitations exist across operating systems:

e Windows® and Mac targets are not able to read Linux formatted
partitions

e Windows cannot read Mac formatted partitions
e Windows FAT and NTFS are supported by Mac

e Mac users must unmount any devices that are already mounted in
order to connect to a target server. Use >diskutil umount
/dev/disk1s1 to unmount the device and diskutil mount /dev/disk1s1
to remount it.

Virtual Media File Server Setup (File Server ISO Images Only)

This feature is only required when using virtual media to access file
server ISO images. ISO9660 format is the standard supported by
Raritan. However, other CD-ROM extensions may also work.

Note: SMB/CIFS support is required on the file server.

Use the Remote Console File Server Setup page to designate the files
server(s) and image paths that you want to access using virtual media.
File server ISO images specified here are available for selection in the
Remote Server ISO Image Hostname and Image drop-down lists in the
Map Virtual Media CD/ISO Image dialog. See Mounting CD-ROM/DVD-
ROM/ISO Images (on page 33).

> To designate file server ISO images for virtual media access:

1. Choose Virtual Media from the Remote Console. The File Server
Setup page opens.

2. Check the Selected checkbox for all media that you want accessible
as virtual media.

3. Enter information about the file server ISO images that you want to
access:

= |P Address/Host Name - Host name or IP address of the file
server.

== Raritan.
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= Image Path - Full path name of the location of the ISO image. For
example, /sharename0/path0/image0.iso,
\sharenamel\pathl\imagel.iso, and so on.

Note: The host name cannot exceed 232 characters in length.

4. Click Save. All media specified here are now available for selection
in the Map Virtual Media CD/ISO Image dialog.

Note: If you are connecting to a Windows 2003° server and attempt to
load an ISO image from the server, you may receive an error stating
"Virtual Media mounting on port failed. Unable to connect to the file
server or incorrect File Server username and password". If this occurs,
disable "Microsoft Network Server: Digitally Sign Communications"
option on the server under the Domain Controllers policies.
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Overview

Time & Seaxiorc
Decensber 13, 23132117 8

Whenever you access a target server from the Port Access page of KX
Il the Remote Console, a Virtual KVM Client (VKC) window opens.
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There is one Virtual KVM Client for each target server connected.

Virtual KVM Client windows can be minimized, maximized, and moved
around your computer desktop.

I &] 3
et ——a— ’ T T T TN

IMPORTANT: Refreshing your browser closes the Virtual KVM Client

connection, so exercise caution.

Recommended Minimum Virtual KVM Client (VKC) Requirements

Raritan recommends the Virtual KVM Client (VKC) machines meet the
following minimum requirements for use with KX III.

e Client machine with either a -
= 'modern' dual-core CPU for a single connections, or

= 'modern' quad core CPU for two or more simultaneous
connections

e 4GB of RAM
= VKC requires 50MB of RAM per connection
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Virtual KVM Client Java Requirements - KX 1lI

Java™ 1.7 is required to use the Java-based Virtual KVM Client (VKC).

Proxy Server Configuration for Use with Virtual KVM Client (VKC) and
Active KVM Client (AKC)

When the use of a Proxy Server is required, a SOCKS proxy must also
be provided and configured on the remote client PC.

Note: If the installed proxy server is only capable of the HTTP proxy
protocol, you cannot connect.

> To configure the SOCKS proxy:
1. On the remote client PC, select Control Panel > Internet Options.

a. Onthe Connections tab, click 'LAN settings'. The Local Area
Network (LAN) Settings dialog opens.

b. Select 'Use a proxy server for your LAN'.
c. Click Advanced. The Proxy Settings dialog opens.
d. Configure the proxy servers for all protocols.

IMPORTANT: Do not select 'Use the same proxy server for
all protocols'.

Note: The default port for a SOCKS proxy (1080) is different from
HTTP proxy (3128).

e. Click OK at each dialog to apply the settings.
2. Next, configure the proxy settings for the Java™ applets:
a. Select Control Panel > Java.

b. On the General tab, click Network Settings. The Network
Settings dialog opens.

c. Select "Use Proxy Server".
d. Click Advanced. The Advanced Network Settings dialog opens.
e. Configure the proxy servers for all protocols.

IMPORTANT: Do not select 'Use the same proxy server for
all protocols'.

Note: The default port for a SOCKS proxy (1080) is different from
HTTP proxy (3128).

uj
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Connect to a Target from Virtual KVM Client (VKC) or Active KVM Client
(AKC)

i
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Once you have logged on to the KX Ill Remote Console, access target
servers via the Virtual KVM Client (VKC) or Active KVM Client (AKC).

» To connect to an available server:

1. On the Port Access page, click on the port name of the target server
you want to connect to. The Port Action menu opens.

2. Click Connect.

Home = Forts

Port Access

Click on the individual
0/ 4 Remote K\VM char

View By Grg
4 No. Name
R e

See Port Action Menu (on page 22) for details on additional available
menu options.
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Configuring Connection Properties

Access Connection Properties

> To access connection properties:

Click Connection > Properties, or click the Connection... icon to open the
Connection Properties dialog.

Connection USB Profile Keyboard Video Mouse Tools View Virtual Media Audio SmartCard Help
SNEEh@REAQAICOR@E {

 Connection

Video Mode: Full Color 2

About Connection Properties

The Virtual KVM Client (VKC) and Active KVM Client (AKC) support
connection property management.

Connection properties manage streaming video performance over
remote connections to target servers.

The properties are applied only to your connection - they do not impact
the connection of other users accessing the same target servers via VKC
or AKC.

If you make changes to connection properties, they are retained by VKC
and AKC.
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Default Connection Property Settings - Optimized for Best
Performance

KX 11l comes configured to provide optimal performance for the majority
of video streaming conditions.

Default connection settings are:

e Optimized for: Text Readability - video modes are designed to
maximize text readability.

This setting is ideal for general IT and computer applications, such as
performing server administration.

e Video Mode - defaults to Full Color 2.

Video frames transmit in high-quality, 24-bit color. This setting is
suitable where a high-speed LAN is used.

¢ Noise Filter - defaults to 2.
The noise filter setting does not often need to be changed.

Click Reset on the Connection Properties dialog at any time to return to
the default settings.

Tip: Use the Connection Information dialog to monitor the connection in
real-time. See Access and Copy Connection Information (on page 46)

Connection Info

Data Description

Dominionk2 Device Name
192.168.61.15 IP Address
Port
Data In/Second
Data Out/Second
FPS
Connect Time
Horizontal Resolution
Vertical Resolution
Refresh Rate
Protocol Version

: Copy to Clipboard | [
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Optimize for: Selections

Text Readability

When Text Readability is selected, all video modes are designed to
provide high-quality, readable text.

This setting is ideal when working with computer GUIs, such as when
performing server administration and so on.

When working in full color video modes, a slight contrast boost is
provided, and text is sharper.

In lower quality video modes, bandwidth is decreased at the expense of
accuracy.

Color Accuracy

When Color Accuracy is selected, all video modes are rendered in full
color with flat color response.

This setting applies to viewing video streams such as movies or other
broadcast streams.

In lower quality video modes, sharpness of fine detail, such as text, is
sacrificed.

Video Mode

The Video Mode slider controls each video frame's encoding, affecting
video quality, frame rate and bandwidth.

| Connection Properties

Optimize for: .TextR.eadabiIity =

Video Mode: Full Color 2

U

Best Least
Qualty Noise Filter: 2 Gy

U

- ==

[ QK J[_Cancel ][ Apply ]
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In general, moving the slider to the left results in higher quality at the cost
of higher bandwidth and, in some cases, lower frame rate.

Moving the slider to the right enables stronger compression, reducing the
bandwidth per frame, but video quality is reduced.

In situations where system bandwidth is a limiting factor, moving the
video mode slider to the right can result in higher frame rates.

When Text Readability is selected as the Optimized setting, the four
rightmost modes provide reduced color resolution or no color at all.

These modes are appropriate for administration work where text and GUI
elements take priority, and bandwidth is at a premium.

Click Reset on the Connection Properties dialog at any time to return to
the default settings.

Noise Filter

Unless there is a specific need to do so, do not change the noise filter
setting. The default setting is designed to work well in most situations.

The Noise Filter controls how much interframe noise is absorbed by the
KX III.

I Connection Properties

Optimize for: :TextReadabiIit\-I v:

Video Mode: Full Color 2

U

Best Least
Quality Noise Filter: 2 Bandwidth

U

(o ) o ) Lo )

Moving the Noise Filter slider to the left lowers the filter threshold,
resulting in higher dynamic video quality. However, more noise is likely to
come through, resulting in higher bandwidth and lower frame rates.

Moving the slider to the right raises the threshold, allows less noise and
less bandwidth is used. Video artifacts may be increased.

Moving the noise filter to the right may be useful when accessing a
computer GUI over severely bandwidth-limited connections.

Click Reset on the Connection Properties dialog at any time to return to
the default settings.
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Connection Information

Open the Connection Information dialog for real-time connection
information, and copy the information from the dialog as needed.

This is useful if, for example, you want to gather real-time information on
your current connection. See Configuring Connection Properties (on
page 42)

The following information is displayed about the current connection:
e KX Il Name - The name of the KX lII.

e |P Address - The IP address of the KX IlI.

e Port- The KVM communication TCP/IP port used to access the KX
I,

e Data In/Second - Data rate received from the KX III.

e Data Out/Second - Data rate sent to the KX III.

e Connect Time - The duration of the current connection.

e FPS - Video frames per second transmitted received from the KX IlI.
e Horizontal Resolution - The target server horizontal resolution.

e Vertical Resolution - The target server vertical resolution.

e Refresh Rate - Refresh rate of the target server.

e Protocol Version - Raritan communications protocol version.

Access and Copy Connection Information

Connection USB Profile Keyboard Video Mouse Tools View Virtual Media Audio SmartCard Help

Connection Info

§

Description Data
Device Name KX3-61-20

IP Address 192.168.61.20
Port

Data In/Second

Data Out/Second

FPS

Connect Time

Horizontal Resolution

Vertical Resolution

Refresh Rate

Protocol Version

{__Copy to Cipboard_| |

1
2
3
4
3
3
7

. e D
- o
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Steps
° Click Connection > Info... to open the Connection Info dialog.

e Click Copy to Clipboard. Paste the information in a file of your choosing.

USB Profiles

i
i

Set a USB profile for a target server from the Virtual KVM Client (VKC)
by clicking USB Profile in the menu, then selecting from the menu
choices.

Connection [USBPmﬁIe Keyboard Video Mouse Tools View Virtual Media Audic SmartCard Help

% h E @ Generic

Other Profiles

Help on USB Profiles

Mac O5-X (10.4.9 and later)

ELDINVIE

o7

Raritan.

HP Proliant DL360/DL380 G4 (Windows 2003 Server Installation])
BIOSIBM Thinkcentre Lenovo

RUBY Industrial Mainboard (AwardBIOS)

HP Proliant DL260/DL380 G4 (HP SmartStart CD)
BIOS Dell Powerkdge Keyboard and Mouse Only
Supermicro Mainbeard (Phoenix AwardBIOS)
SuSE Linux 9.2

el o

P

.

Select a USB profile that best applies to the KVM target server.

For example, if the server is running Windows® operating system, it
would be best to use the Generic profile.

Or, to change settings in the BIOS menu or boot from a virtual media
drive, depending on the target server model, a BIOS profile may be more
appropriate.

For details on USB profiles, see USB Profiles - Overview.
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Keyboard

Send Ctrl+Alt+Del Macro
Due to its frequent use, a Ctrl+Alt+Delete macro is preprogrammed.
Selecting Keyboard > Send Ctrl+Alt+Del, or clicking on the

Ctrl+Alt+Delete button & in the toolbar sends this key sequence to the
server or to the KVM switch to which you are currently connected.

In contrast, if you were to physically press the Ctrl+Alt+Del keys, the
command would first be intercepted by your own PC due to the structure
of the Windows operating system, instead of sending the key sequence
to the target server as intended.

Send LeftAlt+Tab (Switch Between Open Windows on a Target
Server)

Select Keyboard > Send LeftAlt + Tab to switch between open windows
on the target server or KVM switch you are connected to.

Setting CIM Keyboard/Mouse Options

> To access the DCIM-USBG2 setup menu:

Put the mouse focus on a window such as Note Pad (Windows®
operating system) or an equivalent.

2. Select Set CIM Keyboard/Mouse options. This is the equivalent of
sending the Left-Control and Num Lock to the target. The CIM setup
menu options are then displayed.

Set the language and mouse settings.

Exit the menu to return to normal CIM functionality.

Send Text to Target

> To usethe Send Text to Target function for the macro:

Click the Keyboard > Send Text to Target. The Send Text to Target
dialog appears.

2. Enter the text you want sent to the target.

Note: Non-English characters are not supported by the Send Text to
Target function.

3. If the target uses a US/International keyboard layout, select the
"Target system is set to the US/International keyboard layout"
checkbox.

== Raritan.
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4. Click OK.

Keyboard Macros

Keyboard macros ensure that keystroke combinations intended for the
target server are sent to and interpreted only by the target server.
Otherwise, they might be interpreted by the computer on which the
Virtual KVM Client (VKC) is running (your client PC).

Macros are stored on the client PC and are PC-specific. Therefore, if you
use another PC, you cannot see your macros.

In addition, if another person uses your PC and logs in under a different
name, that user will see your macros since they are computer-wide.

Keyboard macros created in Virtual KVM Client (VKC) cannot be used in
Active KVM Client (AKC) or vice versa.

Build a New Macro

» To build a macro:

1. Click Keyboard > Keyboard Macros. The Keyboard Macros dialog
appears.

2. Click Add. The Add Keyboard Macro dialog appears.

3. Type a name for the macro in the Keyboard Macro Name field. This
name appears in the Keyboard menu after it is created.

4. From the Hot-Key Combination field, select a keyboard combination
from the drop-down list. This allows you to execute the macro with a
predefined keystroke. Optional

5. Inthe Keys to Press drop-down list, select each key you would like to
use to emulate the keystrokes that is used to perform the command.
Select the keys in the order by which they are to be pressed. After
each selection, select Add Key. As each key is selected, it appears
in the Macro Sequence field and a Release Key command is
automatically added after each selection.

For example, create a macro to close a window by selecting Left Ctrl
+ Esc. This appears in the Macro Sequence box as follows:

Press Left Alt
Press F4

Esc

Release F4
Esc

Release Left Alt

6. Review the Macro Sequence field to be sure the macro sequence is
defined correctly.
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7.

To remove a step in the sequence, select it and click Remove.

To change the order of steps in the sequence, click the step and
then click the up or down arrow buttons to reorder them as
needed.

Click OK to save the macro. Click Clear to clear all field and start
over. When you click OK, the Keyboard Macros dialog appears and
lists the new keyboard macro.

Click Close to close the Keyboard Macros dialog. The macro now
appears on the Keyboard menu in the application.

Select the new macro on the menu to run it or use the keystrokes
you assigned to the macro.

Import Macros

>

To import macros:

Choose Keyboard > Import Keyboard Macros to open the Import
Macros dialog. Browse to the folder location of the macro file.

Click on the macro file and click Open to import the macro.

a. If too many macros are found in the file, an error message is
displayed and the import terminates once OK is selected.

b. If the import fails, an error dialog appears and a message
regarding why the import failed is displayed. Select OK to
continue the import without importing the macros that cannot be
imported.

Select the macros to be imported by checking their corresponding
checkbox or using the Select All or Deselect All options.

Click OK to begin the import.

a. If a duplicate macro is found, the Import Macros dialog appears.
Do one of the following:

{

ERaritan.
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= Click Yes to replace the existing macro with the imported
version.

= Click Yes to All to replace the currently selected and any
other duplicate macros that are found.

= Click No to keep the original macro and proceed to the next
macro

= Click No to All keep the original macro and proceed to the
next macro. Any other duplicates that are found are skipped
as well.

= Click Cancel to stop the import.

= Alternatively, click Rename to rename the macro and import
it. If Rename is selected, the Rename Macro dialog appears.
Enter a new name for the macro in the field and click OK.
The dialog closes and the process proceeds. If the name
that is entered is a duplicate of a macro, an alert appears
and you are required to enter another name for the macro.

b. If during the import process the number of allowed, imported
macros is exceeded, a dialog appears. Click OK to attempt to
continue importing macros or click Cancel to stop the import
process.

The macros are then imported. If a macro is imported that contains a hot
key that already exists, the hot key for the imported macro is discarded.

Export Macros

1. Choose Tools > Export Macros to open the Select Keyboard Macros
to Export dialog.

Close Window Select All
Deselect Al

2. Select the macros to be exported by checking their corresponding
checkbox or using the Select All or Deselect All options.

3. Click Ok. An "Export Keyboard Macros to" dialog is displayed.
Locate and select the macro file. By default, the macro exists on your
desktop.
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4. Select the folder to save the macro file to, enter a name for the file
and click Save. If the macro already exists, you receive an alert
message.

5. Select Yes to overwrite the existing macro or No to close the alert
without overwriting the macro.

Video Properties

Refreshing the Screen

The Refresh Screen command forces a refresh of the video screen.
Video settings can be refreshed automatically in several ways:

e The Refresh Screen command forces a refresh of the video screen.

e The Auto-sense Video Settings command automatically detects the
target server's video settings.

e The Calibrate Color command calibrates the video to enhance the
colors being displayed.

In addition, you can manually adjust the settings using the Video Settings
command.

> To refresh the video settings, do one of the following:
e Choose Video > Refresh Screen, or click the Refresh Screen button

@ in the toolbar.

Auto-Sense Video Settings

The Auto-sense Video Settings command forces a re-sensing of the
video settings (resolution, refresh rate) and redraws the video screen.

> To automatically detect the video settings, do the following:
e Choose Video > Auto-sense Video Settings, or click the Auto-Sense

Video Settings button ==\ in the toolbar.
A message stating that the auto adjustment is in progress appears.

]
i
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Calibrating Color

Use the Calibrate Color command to optimize the color levels (hue,
brightness, saturation) of the transmitted video images. The color
settings are on a target server-basis.

Note: The Calibrate Color command applies to the current connection
only.

> To calibrate the color, do the following:
e Choose Video > Calibrate Color, or click the Calibrate Color button

@ in the toolbar.

The target device screen updates its color calibration.

Adjusting Video Settings

Use the Video Settings command to manually adjust the video settings.

> To change the video settings:
1. Choose Video > Video Settings to open the Video Settings dialog.

2. Adjust the following settings as required. As you adjust the settings
the effects are immediately visible:

a. PLL Settings

Clock - Controls how quickly video pixels are displayed across
the video screen. Changes made to clock settings cause the
video image to stretch or shrink horizontally. Odd number
settings are recommended. Under most circumstances, this
setting should not be changed because the autodetect is usually
quite accurate.

Phase - Phase values range from 0 to 31 and will wrap around.
Stop at the phase value that produces the best video image for
the active target server.

b. Brightness: Use this setting to adjust the brightness of the target
server display.

c. Brightness Red - Controls the brightness of the target server
display for the red signal.

d. Brightness Green - Controls the brightness of the green signal.

e. Brightness Blue - Controls the brightness of the blue signal.
f. Contrast Red - Controls the red signal contrast.

g. Contrast Green - Controls the green signal.

h. Contrast Blue - Controls the blue signal.
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If the video image looks extremely blurry or unfocused, the
settings for clock and phase can be adjusted until a better image
appears on the active target server.

Warning: Exercise caution when changing the Clock and Phase
settings. Doing so may result in lost or distorted video and you may
not be able to return to the previous state. Contact Raritan Technical
Support before making any changes.

Horizontal Offset - Controls the horizontal positioning of the
target server display on your monitor.

Vertical Offset - Controls the vertical positioning of the target
server display on your monitor.

Select Automatic Color Calibration to enable this feature.

4. Select the video sensing mode:

Best possible video mode

The device will perform the full Auto Sense process when
switching targets or target resolutions. Selecting this option
calibrates the video for the best image quality.

Quick sense video mode

With this option, the device will use a quick video Auto Sense in
order to show the target's video sooner. This option is especially
useful for entering a target server's BIOS configuration right after
a reboot.

5. Click OK to apply the settings and close the dialog. Click Apply to
apply the settings without closing the dialog.

]
i
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Note: Some Sun background screens, such as screens with very dark

borders, may not center precisely on certain Sun servers. Use a different
background or place a lighter colored icon in the upper left corner of the

Contrast Blue: 80

Horizontal Offset: 265

screen.
Video Settings ‘

PLL Settings
Clock: 1,312/ 1028 - { {1812
Phase: 1] o 1 31

Color Settings
Brightness Red: o o [} 127
Brightness Green: 0 o ” 127
Brightness Blue: 4= o {} 127
Contrast Red: ssl2| o i 127
Contrast Green: 87> 0 ” 127

Vertical Offset: 31

Automatic Color Calibration

Video Sensing

(@) Best possible video mode

() Quick sense video mode

Screenshot from Target Command (Target Screenshot)

You are able to take a screenshot of a target server using the
Screenshot from Target server command. If needed, save this

screenshot to a file location of your choosing as a bitmap, JPEG or PNG

file.

> To take a screenshot of the target server:

Select Video > Screenshot from Target, or click the Target

Screenshot button ﬂ on the toolbar.

2. Inthe Save dialog, choose the location to save the file, name the file,

and select a file format from the 'Files of type' drop-down.

3. Click Save to save the screenshot.
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Mouse Options

You can operate in either single mouse mode or dual mouse mode.

When in a dual mouse mode, and provided the option is properly
configured, the mouse cursors align.

When controlling a target server, the Remote Console displays two
mouse cursors - one belonging to your KX Il client workstation, and the
other belonging to the target server.

When there are two mouse cursors, the device offers several mouse
modes:

e Absolute (Mouse Synchronization)
e Intelligent (Mouse Mode)
e Standard (Mouse Mode)

When the mouse pointer lies within the KVM Client target server window,
mouse movements and clicks are directly transmitted to the connected
target server.

While in motion, the client mouse pointer slightly leads the target mouse
pointer due to mouse acceleration settings.

On fast LAN connections, you can use single mouse mode, and view
only the target server's pointer.

You can toggle between these two modes (single mouse and dual
mouse).



i
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Dual Mouse Modes

Absolute Mouse Synchronization

In this mode, absolute coordinates are used to keep the client and target
cursors in synch, even when the target mouse is set to a different
acceleration or speed.

This mode is supported on servers with USB ports and is the default
mode for virtual media CIMs.

Absolute Mouse Synchronization requires the use of a virtual media CIM

e D2CIM-VUSB

e D2CIM-DVUSB

e D2CIM-DVUSB-DVI

e D2CIM-DVUSB-HDMI
e D2CIM-DVUSB-DP

> To enter Absolute Mouse Synchronization:
e Choose Mouse > Absolute from the KVM client.

The black connector on the DVUSB CIMs are used for the keyboard and
mouse. The gray connector is used for virtual media.

Keep both plugs of the CIM connected to the device.
The device may not operate properly if both plugs are not connected to
the target server.

Intelligent Mouse Mode

In Intelligent Mouse mode, the device can detect the target mouse
settings and synchronize the mouse cursors accordingly, allowing mouse
acceleration on the target. Intelligent mouse mode is the default for non-
VM targets.

Enter Intelligent Mouse Mode

> To enter intelligent mouse mode:
e Choose Mouse > Intelligent.
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Intelligent Mouse Synchronization Conditions

The Intelligent Mouse Synchronization command, available on the
Mouse menu, automatically synchronizes mouse cursors during
moments of inactivity. For this to work properly, however, the following
conditions must be met:

e The active desktop should be disabled on the target.
e No windows should appear in the top left corner of the target page.

e There should not be an animated background in the top left corner of
the target page.

e The target mouse cursor shape should be normal and not animated.

e The target mouse speeds should not be set to very slow or very high
values.

e Advanced mouse properties such as “Enhanced pointer precision" or
“Snap mouse to default button in dialogs” should be disabled.

e Choose “Best Possible Video Mode” in the Video Settings window.

e The edges of the target video should be clearly visible (that is, a
black border should be visible between the target desktop and the
remote KVM console window when you scroll to an edge of the
target video image).

e When using the intelligent mouse synchronization function, having a
file icon or folder icon located in the upper left corner of your desktop
may cause the function not to work properly. To be sure to avoid any
problems with this function, Raritan recommends you do not have file
icons or folder icons in the upper left corner of your desktop.

After autosensing the target video, manually initiate mouse
synchronization by clicking the Synchronize Mouse button on the toolbar.
This also applies when the resolution of the target changes if the mouse
cursors start to desync from each other.

If intelligent mouse synchronization fails, this mode will revert to standard
mouse synchronization behavior.

Please note that mouse configurations will vary on different target
operating systems. Consult your OS guidelines for further details. Also
note that intelligent mouse synchronization does not work with UNIX
targets.

]
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Standard Mouse Mode

Standard Mouse mode uses a standard mouse synchronization
algorithm. The algorithm determines relative mouse positions on the
client and target server.

In order for the client and target mouse cursors to stay in synch, mouse
acceleration must be disabled. Additionally, specific mouse parameters
must be set correctly.

» To enter Standard Mouse mode:
e Choose Mouse > Standard.

Mouse Synchronization Tips

If you have an issue with mouse synchronization:

1. Verify that the selected video resolution and refresh rate are among
those supported by the device. The KVM Client Connection Info
dialog displays the actual values that the device is seeing.

Force an auto-sense by clicking the KVM Client auto-sense button.

3. If that does not improve the mouse synchronization (for Linux, UNIX,
and Solaris KVM target servers):

a. Open a terminal window.
b. Enter the following command: xset mouse 1 1

c. Close the terminal window.
4. Click the "KVM Client mouse synchronization" button m

Synchronize Your Mouse

In dual mouse mode, the Synchronize Mouse command forces
realignment of the target server mouse cursor with the client mouse
cursor.

> To synchronize the mouse cursors, do one of the following:

e Click the Synchronize Mouse button ”} in the KVM client toolbar, or
select Mouse > Synchronize Mouse from the menu bar.

Note: This option is available only in Standard and Intelligent mouse
modes.
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Single Mouse Mode

Single Mouse mode uses only the target server mouse cursor; the client
mouse cursor no longer appears onscreen.

Note: Single mouse mode does not work on Windows or Linux targets
when the client is running on a Virtual Machine.

P> To enter single mouse mode, do one the following:
e Choose Mouse > Single Mouse Cursor.

e Click the Single/Double Mouse Cursor button h in the toolbar.

Single Cursor

—

You are about to enter Single Cursor mode, While you are in this mode,
W this software will have exclusive control over the mouse and keyboard.
To exit single cursor mode, you must press Ctrl+ LeftAlt+0

[7] Scale the video (no scroll bars)

ok || cancel

> To exit single mouse mode:

1. Press Ctrl+Alt+O on your keyboard to exit single mouse mode.

Tool Options

General Settings

> To set the tools options:
Click Tools > Options. The Options dialog appears.

2. Select the Enable Logging checkbox only if directed to by Technical
Support.

This option creates a log file in your home directory.
3. Choose the Keyboard Type from the drop-down list (if necessary).
The options include:
= US/International
=  French (France)

= German (Germany)

]
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Japanese

United Kingdom
Korean (Korea)
French (Belgium)
Norwegian (Norway)
Portuguese (Portugal)
Danish (Denmark)
Swedish (Sweden)
German (Switzerland)
Hungarian (Hungary)
Spanish (Spain)
Italian (Italy)
Slovenian
Translation: French - US

Translation: French - US International

In AKC, the keyboard type defaults to the local client, so this option
does not apply.

Configure hotkeys:

Exit Full Screen Mode - Hotkey.

When you enter Full Screen mode, the display of the target
server becomes full screen and acquires the same resolution as
the target server.

This is the hot key used for exiting this mode.
Exit Single Cursor Mode - Hotkey.

When you enter single cursor mode, only the target server
mouse cursor is visible.

This is the hot key used to exit single cursor mode and bring
back the client mouse cursor.

Disconnect from Target - Hotkey.

Enable this hotkey to allow users to quickly disconnect from the
target.

For hotkey combinations, the application does not allow you to
assign the same hotkey combination to more than one function.

For example, if Q is already applied to the Disconnect from Target
function, it won't be available for the Exit Full Screen Mode function.
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Further, if a hotkey is added to the application due to an upgrade and
the default value for the key is already in use, the next available
value is applied to the function instead.

5. Click OK.
Options b\ ‘ u‘

e

General | Client Launch Settings | Scan 5etﬁngs|

Keyboard Type: |Englsh (US/Int1) -
Exit Full Screen Made - Hotiey: | Ctrl+LeftAlt+M = I
Exit Single Cursor Mouse Mode - Hotiey: Ctrl+LeftAlt+0 -
Disconnect From Target - Hotkey: .Ctr|+Leﬂ:A|t+Q -

I oK ] [ Cancel ] [ Apply ]

Keyboard Limitations

Turkish Keyboards

If using a Turkish keyboard, you must connect to a target server through
the Active KVM Client (AKC). It is not supported by other Raritan clients.

Slovenian Keyboards

The < key does not work on Slovenian keyboards due to a JRE
limitation.

Language Configuration on Linux

Because the Sun JRE on Linux has problems generating the correct Key
Events for foreign-language keyboards configured using System
Preferences, Raritan recommends that you configure foreign keyboards
using the methods described in the following table.

Language Configuration method

uUs Intl Default

French Keyboard Indicator

German System Settings (Control Center)

=Y
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Language Configuration method
Japanese System Settings (Control Center)
UK System Settings (Control Center)
Korean System Settings (Control Center)
Belgian Keyboard Indicator

Norwegian Keyboard Indicator

Danish Keyboard Indicator

Swedish Keyboard Indicator

Hungarian System Settings (Control Center)
Spanish System Settings (Control Center)
Italian System Settings (Control Center)
Slovenian System Settings (Control Center)

Portuguese System Settings (Control Center)

Note: The Keyboard Indicator should be used on Linux systems using
Gnome as a desktop environment.

Client Launch Settings

Configuring client launch settings allows you to define the screen
settings for a KVM session.

>

To configure client launch settings:
Click Tools > Options. The Options dialog appears.
Click on the Client Launch Settings tab.

To configure the target window settings:

Select 'Standard - sized to target Resolution' to open the window
using the target's current resolution. If the target resolution is
greater than the client resolution, the target window covers as
much screen area as possible and scroll bars are added (if
needed).

Select 'Full Screen' to open the target window in full screen
mode.

To configure the monitor on which the target viewer is launched:

Select 'Monitor Client Was Launched From' if you want the target
viewer to be launched using the same display as the application
that is being used on the client (for example, a web browser or

applet).
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b. Use 'Select From Detected Monitors' to select from a list of
monitors that are currently detected by the application. If a
previously selected monitor is no longer detected, 'Currently
Selected Monitor Not Detected' is displayed.

= To configure additional launch settings:

a. Select 'Enable Single Cursor Mode' to enable single mouse
mode as the default mouse mode when the server is accessed.

b. Select 'Enable Scale Video' to automatically scale the display on
the target server when it is accessed.

c. Select 'Pin Menu Toolbar' if you want the toolbar to remain
visible on the target when it is in Full Screen mode. By default,
while the target is in Full Screen mode, the menu is only visible
when you hover your mouse along the top of the screen.

3. Click OK.
Options . A ‘ §1

General | Client Launch Settings | Scan Seth'ngs|

Window Mode
(@ Standard - sized to target resolution

() Full Screen

Monitor I
(@ Monitor Client Was Launched From

(7) Select From Detected Monitors

Monitor A
Detected Monitors:

Other

Enable Single Mouse Cursor |
Enable Scale Video

I QK ][ Cancel H Apply ]
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Configuring Port Scan Settings in VKC and AKC

Configuring port scan options in VKC and AKC applies to scanning from
the KX Il Remote Console.

To configure port scan options for the Local Console, see Configure
Local Console Scan Settings (on page 116)

Use the port scanning feature to search for selected targets, and display
them in a slide show view, allowing you to monitor up to 32 targets at
one time.

You can connect to targets or focus on a specific target as needed.
Scans can include standard targets, blade servers, tiered Dominion
devices, and KVM switch ports.

Configure scan settings from either the Virtual KVM Client (VKC) or
Active KVM Client (AKC).

See Scanning Ports - Remote Console (on page 99)

Use the Scan Settings tab to customize the scan interval and default
display options.

Configure Port Scan

> To set scan settings:
1. Click Tools > Options. The Options dialog appears.
2. Select the Scan Settings tab.

3. Inthe "Display Interval (10-255 sec):" field, specify the number of
seconds you want the target that is in focus to display in the center of
the Port Scan window.

4. Inthe "Interval Between Ports (10 - 255 sec):" field, specify the
interval at which the device should pause between ports.

5. Inthe Display section, change the default display options for the
thumbnail size and split orientation of the Port Scan window.
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6. Click OK.

e —

Options i~ ‘ M.‘

i

| General I Client Launch Settings | Scan Settings |

Scan Intervals
Display Interval {10-255 sec): 10|

Interval Between Ports (10-255 sec): |10

Display
Thumbnail Size: 160x120 v
Split Orientation: j'u'ertiml -

o (ol (oot ]

Collecting a Diagnostic Snapshot of the Target

Administrators are able to collect a "snapshot” of a target from either the
Virtual KVM Client (VKC) or Active KVM Client (AKC).

The "snapshot" function generate log files and image files from the
target.

It then bundles these files in a zip file that can be sent to Raritan
Technical Support in order to help diagnose technical problems you may
be encountering.

The following files are included in the zip file:

screenshot_image.png

This is a screenshot of the target that captures a picture of the issue
you are experiencing. This feature is operates in the same as the
"Screenshot from Target" feature.

raw_video_image.png:

A snapshot image created from raw video data. Please note that
client's postprocessing is applied, just as if it were a "regular” screen
update.

raw_video_ychcr420.bin:

Binary file of the raw snapshot.

raw_video_ycbcr420.txt:

Text file containing data used by Raritan to help diagnose issues.

=Y
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Log.txt file:
These are the client logs.

Note that the logs are included even if you have not enabled
information to be captured in them. VKC uses internal memory to

capture the information in this case.

Collect a Diagnostic Snapshot from the Virtual KVM Client (VKC) or Active
KVM Client (AKC)

Raritan.
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> To capture a diagnostic snapshot:

. -088z0

A EE A B

1w video yebollibn | raw ndeo ycholint e video ugegng  sovenictmagepny  dagrosscs sve kg

et s O s ) Te f L2803 00

Steps

@ Access a target via Virtual KVM Client (VKC) or Active KVM Client (AKC), and
then click Tools > Collect a Diagnostic Snapshot.

Several messages are displayed as the information is collected.

@ You are prompted to save the zip file containing the diagnostic files.

@ The zip file containing the diagnostic files that were collecting opens.

=i=Raritan.
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View Options

View Toolbar

You can use the Virtual KVM client with or without the toolbar display.

>

To toggle the display of the toolbar (on and off):
Choose View > View Toolbar.

View Status Bar

By default, the status bar is displayed at the bottom of the target window.

» To hide the status bar:

e Click View > Status Bar to deselect it.
» To restore the status bar:

e Click View > Status Bar to select it.
Scaling

Scaling your target window allows you to view the entire contents of the
target server window.

This feature increases or reduces the size of the target video to fit the
Virtual KVM Client window size, and maintains the aspect ratio so that
you see the entire target server desktop without using the scroll bar.

>

To toggle scaling (on and off):
Choose View > Scaling.
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Full Screen Mode

When you enter Full Screen mode, the target's full screen is displayed
and acquires the same resolution as the target server.

The hot key used for exiting this mode is specified in the Options dialog,
see Tool Options (on page 60).

While in Full Screen mode, moving your mouse to the top of the screen
displays the Full Screen mode menu bar.

If you want the menu bar to remain visible while in Full Screen mode,
enable the Pin Menu Toolbar option from the Tool Options dialog. See
Tool Options (on page 60).

» To enter full screen mode:

e Choose View > Full Screen, or click the Full Screen button IEI

» To exit full screen mode:

e Press the hot key configured in the Tool's Options dialog. The default
is Ctrl+Alt+M.

If you want to access the target in full screen mode at all times, you can
make Full Screen mode the default.

» To set Full Screen mode as the default mode:
1. Click Tools > Options to open the Options dialog.

2. Select Enable Launch in Full Screen Mode and click OK.

Connect to Virtual Media

See Virtual Media (on page 28)

70
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Smart Cards

i
i
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Using the KX 1lI, you are able to mount a smart card reader onto a target
server to support smart card authentication and related applications.

For a list of supported smart cards, smart card readers, and additional
system requirements, see Smart Card Minimum System
Requirements, CIMs and Supported/Unsupported Smart Card
Readers (on page 71).

Note: The USB Smart Card token (eToken NG-OTP) is only supported
from the remote client.

Smart card reader mounting is also supported from the Local Console.

See Local Console Smart Card Access (on page 117) in your
Dominion device help.

Smart Card Minimum System Requirements, CIMs and
Supported/Unsupported Smart Card Readers

Before you begin using a smart card reader, review the following:

e Smart Card Minimum System Requirements (on page 145)

e Supported Computer Interface Module (CIMs) Specifications (on
page 139)

e Supported and Unsupported Smart Card Readers

Authentication When Accessing a Smart Card Reader

When accessing a server remotely, you can select an attached smart
card reader and mount it onto the server.

Smart card authentication is used with the target server, it is not used to
log into the device. Therefore, changes to smart card PIN and
credentials do not require updates to device accounts.

PC Share Mode and Privacy Settings when Using Smart Cards

When PC-Share mode is enabled on the device, multiple users can
share access to a target server.

However, when a smart card reader is connected to a target, the device
will enforce privacy regardless of the PC-Share mode setting.

In addition, if you join a shared session on a target server, the smart card
reader mounting will be disabled until exclusive access to the target
server becomes available.
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Smart Card Reader Detected

After a KVM session is established with a target server, a Smart Card
menu and button are available in VKC and AKC.

Once the Smart Card button is selected or Smart Card is selected from
the menu, the smart card readers that are detected as attached to the
remote client are displayed in a dialog.

From this dialog, you can attach additional smart card readers, refresh
the list of smart card readers attached to the target, and detach smart
card readers.

You are also able to remove or reinsert a smart card. This function can
be used to provide notification to a target server OS that requires a
removal/reinsertion in order to display the appropriate login dialog. Using
this function allows the notification to be sent to a single target without
affecting other active KVM sessions.

Mount a Smart Card Reader

When mounted onto the target server, the card reader and smart card
will cause the server to behave as if they had been directly attached.

Removal of the smart card or smart card reader will cause the user
session to be locked or you will be logged out depending on how the
card removal policy has been setup on the target server OS.

When the KVM session is terminated, either because it has been closed
or because you switch to a new target, the smart card reader will be
automatically unmounted from the target server.

» To mount a smart card reader from VKC or AKC:

Click the Smart Card menu and then select Smart Card Reader.

Alternatively, click the Smart Card button Q in the toolbar.

2. Select the smart card reader from the Select Smart Card Reader
dialog.

Click Mount.

A progress dialog will open. Check the 'Mount selected card reader
automatically on connection to targets' checkbox to mount the smart
card reader automatically the next time you connect to a target. Click
OK to begin the mounting process.
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Update a Smart Card Reader

> To update the smart card in the Select Smart Card Reader
dialog:

e Click Refresh List if a new smart card reader has been attached to
the client PC.

Send Smart Card Remove and Reinsert Notifications

» To send smart card remove and reinsert notifications to the
target:

e Select the smart card reader that is currently mounted and click the
Remove/Reinsert button.

Unmount (Remove) a Smart Card Reader

» To unmount a smart card reader:

e Select the smart card reader to be unmounted and click the Unmount
button.
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Digital Audio

The KX Il supports end-to-end, bidirectional, digital audio connections
for digital audio playback and capture devices from a remote client to a
target server.

The audio devices are accessed over a USB connection.
Current device firmware is required.

One of the following CIMs must be used:

e D2CIM-DVUSB

e D2CIM-DVUSB-DVI

e D2CIM-DVUSB-HDMI
e D2CIM-DVUSB-DP

Windows®, Linux® and Mac® operating systems are supported. The
Virtual KVM Client (VKC) and Active KVM Client (AKC) support
connections to audio devices.

Note: Audio CDs are not supported by virtual media so they do not work
with the audio feature.

Before you begin using the audio feature, Raritan recommends you
review the audio related information documented in the following
sections of Help:

e Supported Audio Device Formats (on page 74)
e Recommendations for Dual Port Video

e Dual Video Port Group Supported Mouse Modes
e CIMs Required for Dual Video Support

¢ Informational Notes, Audio (on page 175)

Supported Audio Device Formats

The KX 1l supports one playback and capture device and one record
device on a target at a time. The following audio device formats are
supported:

e Stereo, 16 bit, 44.1K

e Mono, 16 bit, 44.1K

e Stereo, 16 bit, 22.05K

e Mono, 16 bit, 22.05K

e Stereo, 16 bit, 11.025K
e Mono, 16 bit, 11.025K

]
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Digital Audio VKC and AKC Icons

Audio
icons

o))
o

Ilcon name

Speaker

Microphone

Description

These icons are located in status bar at the
bottom of the client window.

Green, blinking waves indicate an audio
playback session is currently streaming.

A black speaker icon is displayed when the
session is muted.

The icon is grayed out when no audio is
connected.

These icons are located in the status bar at the
bottom of the client window.

Red, blinking waves indicate an audio capture
session is currently underway.

The Speaker icon, indicating a playback session
is streaming, is also displayed when a session is
underway.

A black Microphone icon is displayed when the
session is muted.

When the Microphone icon is grayed out, no
audio is connected.

Audio Playback and Capture Recommendations and Requirements

Audio Level

Set the target audio level to a mid-range setting.
For example, on a Windows® client, set the audio to 50 or lower.

This setting must be configured through the playback or capture audio
device, not from the client audio device control.

;
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Recommendations for Audio Connections when PC Share Mode is
Enabled

If you are using the audio feature while running PC Share mode, audio
playback and capture are interrupted if an additional audio device is
connected to the target.

For example, User A connects a playback device to Targetl and runs an
audio playback application then User B connects a capture device to the
same target. User A's playback session is interrupted and the audio
application may need to be restarted.

The interruption occurs because the USB device needs to be re-
enumerated with the new device configuration.

It may take some time for the target to install a driver for the new device.

Audio applications may stop playback completely, go to the next track, or
just continue playing.

The exact behavior is dependent on how the audio application is
designed to handle a disconnect/reconnect event.

Bandwidth Requirements

The table below details the audio playback and capture bandwidth
requirements to transport audio under each of the selected formats.

Audio format Network bandwidth requirement
44.1 KHz, 16bit stereo 176 KB/s
44.1 KHz, 16bit mono 88.2 KB/s
2.05 KHz, 16bit stereo 88.2 KB/s
22.05 KHz, 16bit mono 44.1 KB/s

11.025 KHz, 16bit stereo 44.1 KB/s
11.025 KHz, 16bit mono Audio 22.05 KB/s

]
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In practice, the bandwidth used when an audio device connects to a
target is higher due to the keyboard and video data consumed when
opening and using an audio application on the target.

A general recommendation is to have at least a 1.5MB connection before
running playback and capture.

However, high video-content, full-color connections using high-target
screen resolutions consume much more bandwidth and impact the
quality of the audio considerably.

To help mitigate quality degeneration, there are a number of
recommended client settings that reduce the impact of video on audio
quality at lower bandwidths:

e Connect audio playback at the lower quality formats. The impact of
video consuming bandwidth is much less notable at 11k connections
than at 44k

e Set the connection speed under Connection Properties to a value
that best matches the client to server connection

e Under Connection Properties, set the color depth to as low a value
as possible. Reducing the color depth to 8 bit color considerably
reduces the bandwidth consumed

e Set Smoothing, to High. This will improve the appearance of the
target video by reducing displayed video noise

e Under Video settings, set the Noise Filter to its highest setting of 7
(highest value) so less bandwidth is used for target screen changes
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Saving Audio Settings

Audio device settings are applied on a per KX Il device basis.

Once the audio devices settings are configured and saved on the KX 1l
the same settings are applied to it.

For example, you can configure a Windows® audio device to us a stereo,
16 bit, 44.1K format.

When you connect to different targets and use that Windows audio
device, the stereo, 16 bit, 44.1K format is applied to each target server.

For both playback and recording devices, the device type, device format,
and the buffer settings applied to the device are saved.

See Connecting and Disconnecting from a Digital Audio Device (on
page 79) for information on connecting to and configuring an audio
device, and Adjusting Capture and Playback Buffer Size (Audio Settings)
for information on audio device buffer settings.

If you are using the audio feature while running PC Share mode and VM
Share mode so multiple users can access the same audio device on a
target at once, the audio device settings of the user who initiates the
session are applied to all users who join the session.

So, when a user joins an audio session, the target machine settings are
used. See Connecting to Multiple Targets from a Single Remote
Client (on page 78).

Connecting to Multiple Targets from a Single Remote Client

Connect to audio on up to four (4) target servers at the same time from a
single, remote client.

See Connecting and Disconnecting from a Digital Audio Device (on
page 79) for information on connecting to audio devices.

A Speaker icon 43«' is displayed in the status bar at the bottom of the

client window. It is grayed out when no audio is being used. When the
1

s
Speaker icon and Microphone icon '.gﬁ.' are displayed in the status bar,
the session is being captured as it is streamed.

Note: When an audio session is underway, be sure to keep the session
active or change the KX IlI's idle timeout time so the audio session does
not time out.

]
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Operating System Audio Playback Support

Review the table shown here to see which Raritan client works with
audio playback/capture for each operating system:

Operating system Audio playback and capture supported
by:

Windows® e Active KVM Client (AKC)
e Virtual KVM Client (VKC)

Linux® e Virtual KVM Client (VKC)

Mac® e Virtual KVM Client (VKC)

Connecting and Disconnecting from a Digital Audio Device

Audio device settings are applied on a per KX Ill device basis.

Once the audio devices settings are configured and saved on the KX IlI,
the same settings are applied to it.

See Saving Audio Settings (on page 78) for more information.

Note: If you are using the audio feature while running PC Share mode
and VM Share mode, see Audio Playback and Capture
Recommendations and Requirements (on page 75) for important
information. See also Connecting to Multiple Targets from a Single
Remote Client (on page 78).

Connect to a Digital Audio Device

» To connect to an audio device:

1. Connect the audio device to the remote client PC prior to launching
the browser connection to the KX III.

2. Connect to the target from the Port Access page.

3. Once connected, click the Audio button Eﬁ'}] in the toolbar.

The Connect Audio Device dialog appears. A list of available audio
device connected to the remote client PC is displayed.

Note: If there are no available audio devices connected to the remote
client PC, the Audio icon is grayed out. .

4. Check Connect Playback Device if you are connecting to a playback
device.

5. Select the device that you wish to connect from the drop-down list.
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6.

10.

Select the audio format for the playback device from the Format:
drop-down.

Note: Select the format that you wish to use based on the available
network bandwidth. Formats with lower sampling rates consume less
bandwidth and may tolerate more network congestion.

Check Connect Recording Device if you are connecting a recording
device.

Note: The device names listed in the Connect Recording Device
drop-down are truncated to a maximum of 30 characters for Java
clients.

Select the device that you wish to connect from the drop-down list.

Select the audio format for the recording device from the Format:
drop-down.

Click OK. If the audio connection is established, a confirmation
message appears. Click OK.

If the connection was not established, an error message appears.

Once an audio connection is established, the Audio menu is changed
to Disconnect Audio. Additionally, the settings for the audio device
are saved and applied to the audio device.

]
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A Speaker icon 4]:1 is displayed in the status bar at the bottom of the
client window. It is grayed out when no audio is being used. When

the Speaker icon and Microphone icon m are displayed in the
status bar, the session is being captured as it is streamed.

Note to ensure proper operation attach audio devices to client PC
prior to launching browser. If you haven't afready done so, please
' close then reopen your browser after attaching the aodio devices.

Playback I
| Connect Playback Device
| |
[Pri.l'l'la.r"_i' Sound Driver - ]
Farmat:
|
’sterec, 16 hit, 44,100 Hz - ]
Recording
[] Conniect Recording Device
|F‘rimary Sound Capture Driver - |
Format:
|sterec., 16 bit, 11,025 Hz - |
ok || cancel |
L ~

Disconnect from an Audio Device

» To disconnect from the audio device:

e Click the Audio icon @ in the toolbar and select OK when you are
prompted to confirm the disconnect. A confirmation message
appears. Click OK.

e
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Adjusting Capture and Playback Buffer Size (Audio Settings)

Once an audio device is connected, the capture and playback buffer size
can be adjusted as needed.

This feature is useful for controlling the quality of the audio, which may
be impacted by bandwidth limitations or network spikes.

Increasing the buffer size improves the audio quality but may impact the
delivery speed.

The maximum available buffer size is 400 milliseconds since anything
higher than that greatly impacts audio quality.

The buffer size can be adjusted whenever needed, including during an
audio session.

Audio settings are configured in VKC or AKC.

Adjust Audio Settings

> To adjust audio settings:

1. Select Audio Settings from the Audio menu. The Audio Settings
dialog opens.

2. Adjust the capture and/or playback buffer size as needed. Click OK.

Capture Buffer Size: - miliseconds

Playback Buffer Size: e miliseconds

uj
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Remote Power Management via Virtual KVM Client (VKC) or Active KVM
Client (AKC)

Target power is managed by controlling the outlet it is connected to.

Specifically, you can power on, power off, and power cycle a target via
the outlet it is connected to.

To do this, access the target from the KX Il via the Virtual KVM Client
(VKC) or Active KVM Client (AKC), and then select a power control
option from the Power Control menu.

Connection USB Profile Keyboard Video Mouse Tools View Virtual Media Audio SmartCard [Power Control | Help

ShEEAEBEQY LR @E —

Power Off

Power Cycle

Note that you must have the correct permission to perform a power
operation. If you do not, the menu option is disabled.

Note: This feature is also supported when KX Il is under CC-SG
management, as well as when accessing VKC or AKC via direct port
access.

Version Information - Virtual KVM Client

This menu command provides version information about the Virtual KVM
Client, in case you require assistance from Raritan Technical Support.

» To obtain version information:
Choose Help > About Raritan Virtual KVM Client.

2. Use the Copy to Clipboard button to copy the information contained
in the dialog to a clipboard file so it can be accessed later when
dealing with support (if needed).

i
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Overview

The Active KVM Client (AKC) is based on Microsoft Windows .NET®
technology.

This allows you to run the client in a Windows environments without
using the Java® Runtime Environment (JRE), which is required to run
Raritan's Virtual KVM Client (VKC).

AKC also works with CC-SG.

AKC provides the same features as VKC with the exception of the
following:

e Keyboard macros created in AKC cannot be used in VKC

e Direct port access configuration (see Enabling Direct Port Access via
URL)

e AKC server certification validation configuration (see Prerequisites
for Using AKC (on page 85))

e AKC automatically loads favorites, VKC does not. See Managing
Favorites (on page 105)

For details on using the features, see Virtual KVM Client (VKC) Help
(on page 38).

Recommended Minimum Active KVM Client (AKC) Requirements

;
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Raritan recommends the Active KVM Client (AKC) machines meet the
following minimum requirements for use with KX IlI.

e Client machine with either a -

= 'modern' dual-core CPU for a single connections, or
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= 'modern' quad core CPU for two or more simultaneous
connections

e 4GB of RAM

AKC Supported Microsoft .NET Framework

The Active KVM Client (AKC) requires Windows .NET® version 3.5, 4.0
or 4.5. AKC works with both 3.5 and 4.0 installed.

AKC Supported Operating Systems

When launched from Internet Explorer®, the Active KVM Client (AKC)
allows you to reach target servers via the KX IlI.

AKC is compatible with the following platforms:

e Windows XP® operating system

e Windows Vista® operating system (up to 64 bit)
e Windows 7° operating system (up to 64 bit)

e Windows 8° operating system (up to 64 bit)

Note: You must be using Windows 7 if WINDOWS PC FIPs is turned on
and you are accessing a target using AKC and a smartcard.

Since .NET is required to run AKC, if you do not have .NET installed or
you have an unsupported version of .NET installed, you will receive a
message instructing you to check the .NET version.

Note: Raritan recommends Windows XP® operating system users verify
you have a working version of .NET 3.5 or 4.0 already installed before
you launch AKC. If you do not verify your .NET version is working, you
may be prompted to download a file versus receiving the default
message to check your .NET version.

AKC Supported Browsers

e Internet Explorer® 8 (and later)

If you attempt to open AKC from a browser other than Internet
Explorer 8 (and later), you will receive an error message instructing
you to check your browser and to switch to Internet Explorer.

Prerequisites for Using AKC

Allow Cookies

Ensure the cookies from the IP address of the device that is being
accessed are not currently being blocked.

i
i
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Include KX IIl IP Address in 'Trusted Sites Zone'

Windows Vista®, Windows® 7 and Windows 2008 server users should
ensure that the IP address of the device being accessed is included in
their browser's Trusted Sites Zone.

Disable 'Protected Mode'

Windows Vista®, Windows® 7 and Windows 2008 server users should
ensure that Protected Mode is not on when accessing the Raritan
device.

Enable AKC Download Server Certificate Validation

If the Raritan device (or CC-SG) administrator has enabled the Enable
AKC Download Server Certificate Validation option:

e Administrators must upload a valid certificate to the device or
generate a self-signed certificate on the device. The certificate must
have a valid host designation.

e Each user must add the CA certificate (or a copy of self-signed
certificate) to the Trusted Root CA store in their browser.

Proxy Server Configuration for Use with Virtual KVM Client (VKC) and
Active KVM Client (AKC)

When the use of a Proxy Server is required, a SOCKS proxy must also
be provided and configured on the remote client PC.

Note: If the installed proxy server is only capable of the HTTP proxy
protocol, you cannot connect.

> To configure the SOCKS proxy:
1. On the remote client PC, select Control Panel > Internet Options.

a. Onthe Connections tab, click 'LAN settings'. The Local Area
Network (LAN) Settings dialog opens.

b. Select 'Use a proxy server for your LAN'.
Click Advanced. The Proxy Settings dialog opens.
d. Configure the proxy servers for all protocols.

IMPORTANT: Do not select 'Use the same proxy server for
all protocols'.

Note: The default port for a SOCKS proxy (1080) is different from
HTTP proxy (3128).

e. Click OK at each dialog to apply the settings.

== Raritan.
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2. Next, configure the proxy settings for the Java™ applets:
a. Select Control Panel > Java.

b. On the General tab, click Network Settings. The Network
Settings dialog opens.

Select "Use Proxy Server".
d. Click Advanced. The Advanced Network Settings dialog opens.
e. Configure the proxy servers for all protocols.

IMPORTANT: Do not select 'Use the same proxy server for
all protocols'.

Note: The default port for a SOCKS proxy (1080) is different from
HTTP proxy (3128).

Connect to a Target from Virtual KVM Client (VKC) or Active KVM Client
(AKC)

i
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Once you have logged on to the KX Ill Remote Console, access target
servers via the Virtual KVM Client (VKC) or Active KVM Client (AKC).

» To connect to an available server:

On the Port Access page, click on the port name of the target server
you want to connect to. The Port Action menu opens.

2. Click Connect.

Home > Ports

Port Access

Click on the individual
0/ 4 Remote KVM char

View By Grg
4 No. Name
= e

See Port Action Menu (on page 22) for details on additional available
menu options.
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Remotely Access Targets Using a Mobile Device

;
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KX 11l supports remote access to targets from Apple® iPad® and iPhone®
with 10S 4.0 (or later).

Mobile access is provided through Mobile Access Client, which requires
the use of CommandCenter Secure Gateway (CC-SG).

Access and power control of your targets is supported using the Mobile
KVM Client (MKC).

MKC launches automatically from mobile devices. There is no
configuration or selection of MKC required. See Connect to a Target
Using the Mobile KVM Client (on page 89)

You connect to each interface using the same links as when accessing
from PC. When MKC opens, use the touch screen equivalent to each
mouse click operation for navigating. See Touch Mouse Functions (on
page 89).

The mobile device does not provide file storage for keyboard macros, so
keyboard macros that you have created and would like to use in MKC
can be stored on CC-SG with your profile data. You must import user-
defined keyboard macros, using the desktop Access Client, before they
will be available in MKC. See Manage Mobile Client Keyboard Macros
(on page 94).

88



Chapter 7: Mobile KVM Client (MKC) Help

Connect to a Target Using the Mobile KVM Client

Mobile access using the Mobile Access Client requires the use of
CommandCenter Secure Gateway (CC-SG).

Enable pop-ups in your mobile device browser before accessing Mobile
KVM Client (MKC) or CC-SG Mobile Access Client.

MKC does not support connections over IPv6.

> To connect to atarget via KX lll on a mobile device:

1. Login to the Access Client using your mobile device browser.

2. Touch the node you want to access in the node list, then touch the
blue interface link in the Node Profile to the right.

3. The Mobile KVM Client opens and connects to the target.

Raritan.

;

Touch Mouse Functions

Use the touchscreen equivalent for each mouse function to navigate the
Mobile KVM Client (MKC) on your mobile device.

To view this chart in MKC, touch the Help icon (?) in the MKC toolbar.

Single Finger Touch
touch down - move - release

short tap
double short tap

short tap - touch down - move -
release

Two Finger Touch
touch down - move - release

touch down - change distance -
release

short tap
double short tap

short tap - touch down - move -
release

Mouse Equivalent
move mouse pointer

left click
left double-click

hold down left mouse button and
move, as in drag and drop or
select

Mouse Equivalent
move screen

resize screen (short pause at
100% zoom)

right click
right double-click

hold down right mouse button and
move, as in right drag and drop
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Using the MKC Toolbar

The MKC toolbar may not be completely visible at one time, depending
on the resolution of your mobile device.

» To view the whole toolbar:

e Touch and swipe to move the toolbar icons to the left and right,
bringing different icons into view.

> To usethe keyboard button icons:

The toolbar contains icons for each keyboard button you may need.
Touch and swipe left and right to view all icons.

e Touch an icon for a button press.

e For a button hold, such as for Control and Alt used in
Control+Alt+Delete, touch the icon once to activate it. The icon color
will darken to indicate it is currently pressed. To release the icon,
touch again.

MKC Toolbar Icons

Depending on your mobile device screen size and resolution, you may
not see all toolbar icons at once. For example, on tablet device, such as
an iPad you may see F4 as the final icon to the right.

? MENU SHIFT CTRL ALT
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Touch and swipe the toolbar to the left, to view the F5 through F12 icons.
Swipe the toolbar back to the right to return to the default view.

On a mobile phone device, such as an iPhone, you will see fewer icons.
Use the same touch-and-swipe motion left and right to view additional
icons.

> Keyboard Icon

Provides access to the mobile device's native soft keyboard. See
Display Mobile Device Keyboard (on page 92).

P> Shift (SHIFT) - Control (CTRL) - Alternate (ALT)

Provide the modifier keys to be used together with other keys on the
toolbar. See Using the MKC Toolbar (on page 90).

>  Windows (WIN)

Provides access to the Windows Start menu. This is the equivalent of the
Windows key on a standard Windows keyboard.

> Application Key or "Right-Click" Key

Provides access to a right-click menu. This is the equivalent of the
Application key on a standard Windows keyboard. The Application key
has an image of a mouse pointer on a menu, and it is positioned
between the Alt and Ctrl keys to the right of the spacebar.

Touch the Application icon to display the selected item's right-click menu.

> Left Arrow, Up Arrow, Down Arrow, Right Arrow

Provide document navigation.

> Tab (TAB) - Escape (ESC) - Delete (DEL) - Function 1 (F1) thru
Function 12 (F12)

Provide standard press and release key operation.
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Display Mobile Device Keyboard

Toggle on and off the MKC keyboard to display or hide it.

The keyboard is configured on the mobile device. For example, on iPad
choose Settings > General > Keyboard > International Keyboards to see
the available keyboards or to add a keyboard. From the soft keyboard
touch the globe icon to toggle between available keyboards.

> To display/hide mobile device keyboard:

e Inthe MKC toolbar, touch the keyboard icon, next to the Menu button
to display the keyboard.

¢ Inthe keyboard, touch the icon in the bottom right corner to hide the
keyboard.

Display Connection Info

Display information about your connection to see how much bandwidth is
being used in transmitting and receiving data.

This information can be helpful in determining how much of the available
bandwidth is being consumed, the effect of selecting a lower video
quality setting, or for troubleshooting if image updates are slower than
expected. See Set Video Connection Quality (on page 96).

Incoming kpx/s pixel updates per second
kB/s bytes per second

Outgoing msg/s messages per second
kB/s bytes per second

> To display connection info:
¢ Inthe MKC toolbar, touch Menu, then touch Connection Info.
The connection information appears in the viewer.

To turn off the connection information display, touch Menu, then
touch Connection Info. The display toggles off.
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Set Keyboard Type

The default keyboard in MKC is US/International English. Select the
language keyboard to match the language keyboard setting of the target
you are accessing. This is required to provide the correct keyboard
mapping in the target.

You must correctly set the keyboard type in MKC based on the language
mapping required by the target. This setting is in addition to the keyboard
language setting on your mobile device itself.

> To set keyboard type:
1. Inthe MKC toolbar, touch Menu, then touch Keyboard Type.

2. Touch the keyboard language to set it.

i

Raritan.

Keyboard Languages

e Danish (Denmark)

e English (UK)

e English (US/Int')

e French (Belgium)

e French (France)

e German (Germany)

e German (Switzerland)
e Hungarian

o ltalian (ltaly)

e Japanese

e Korean (Korea)

e Norwegian (Norway)
e Portuguese (Portugal)
e Slovenian

e Spanish (Spain)

e Swedish (Sweden)
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Manage Mobile Client Keyboard Macros

Each user must import their user-defined keyboard macros to make them
available for use while connected to targets using the Mobile KVM Client
(MKC).

Export the file from Virtual KVM Client (VKC), then import it using the
desktop Access Client. You cannot import macros using a mobile device.
Imported macros are available per user in MKC when you connect to a
target using your mobile device.

Launch Keyboard Macro

Pre-defined macros are always available in MKC. You must import user-
defined macros using the desktop Access Client before they are
available on MKC. See Manage Mobile Client Keyboard Macros (on
page 94).

SUN macros are available in MKC if you are connected to a target that
has the SUN CIM.

> To launch keyboard macro:
1. Inthe MKC toolbar, touch Menu, then touch Keyboard Macros.
2. Touch the macro you want to launch.

The macro is launched and the results display on the target.

Set Mouse Mode

When controlling a target server, the MKC displays two mouse cursors: a
red bullseye indicates where the mobile touch gestures are relative to the
target, and the cursor that belongs to the target server.

Single mouse mode is not available in MKC.

Your mouse will operate in dual mouse mode only. When properly
configured, the two mouse cursors align.

There are several mouse modes when in dual mouse mode. Mouse
modes are available based on the attached CIM and selected USB
profile.

e See Absolute Mouse Mode (on page 95).
e See Intelligent Mouse Mode (on page 95).
e See Standard Mouse Mode (on page 95).

» To set mouse mode:
1. Inthe MKC toolbar, touch Menu, then touch Mouse.

== Raritan.
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2. Touch Mouse Mode, then touch Absolute, Intelligent, or Standard.

Absolute Mouse Mode

In this mode, absolute coordinates are used to keep the client and target
cursors in synch, even when the target mouse is set to a different
acceleration or speed.

This mode is supported on servers with USB ports and is the default
mode for virtual media CIMs.

Absolute Mouse Synchronization requires the use of a virtual media CIM

e D2CIM-VUSB

e D2CIM-DVUSB

e D2CIM-DVUSB-DVI

e D2CIM-DVUSB-HDMI

D2CIM-DVUSB-DP

Note: For KX II, Absolute Mouse Synchronization is available for use with
the virtual media-enabled USB CIM (D2CIM-VUSB and D2CIM-DVUSB)
only.

Intelligent Mouse Mode

In Intelligent Mouse mode, the device can detect the target mouse
settings and synchronize the mouse cursors accordingly, allowing mouse
acceleration on the target. Intelligent mouse mode is the default for non-
VM targets.

During synchronization, the mouse cursor does a “dance” in the top left
corner of the screen and calculates the acceleration. For this mode to
work properly, certain conditions must be met.

See the Dominion KXII User Guide for more details on Intelligent Mouse
mode.

Standard Mouse Mode

Standard Mouse mode uses a standard mouse synchronization
algorithm. The algorithm determines relative mouse positions on the
client and target server.

In order for the client and target mouse cursors to stay in synch, mouse
acceleration must be disabled. Additionally, specific mouse parameters
must be set correctly.
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Sync Mouse in Intelligent or Standard Mouse Mode

In Intelligent or Standard mouse mode, the Sync Mouse command forces
realignment of the target server mouse pointer with the MKC mouse
pointer.

» To sync mouse:
1. Inthe MKC toolbar, touch Menu, then touch Mouse.

2. Touch Sync Mouse. Wait several seconds while the synchronization
occurs.

Auto-Sense Video Settings

The Auto-sense Video Settings command forces a re-sensing of the
video settings (resolution, refresh rate) and redraws the video screen.

Auto-sensing video settings can eliminate target video misalignment and
sometimes mouse synchronization problems.

> To auto-sense video settings:
1. Inthe MKC toolbar, touch Menu, then touch Video.
2. Touch Auto Sense Video Settings.

Set Video Connection Quality

Adjust the bandwidth consumed by the connection by setting the video
connection quality. A lower quality setting will consume less bandwidth
by providing lower video quality.

Use the connection information display to get bandwidth information to
help adjust the video connection quality. See Display Connection Info
(on page 92).

> To set video connection quality:
1. Inthe MKC toolbar, touch Menu, then touch Video.

2. Touch Connection Quality Settings, then touch High, Medium, or
Low. The default setting is High.
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View MKC Help

Descriptions of the touchscreen techniques can be accessed in MKC.

> To view MKC help:
e Touch the Help icon (?) icon in the toolbar. The help opens.
e See Touch Mouse Functions (on page 89) to view this information.

97



Chapter 8 KX Il Remote Console

In This Chapter
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Overview

When you log in to the KX Il via a network connection, you access the
Remote Console. The first page accessed is the Port Access page.

See Logging In to the KX Il (on page 17) and Port Access Page
(Remote Console Display) (on page 19)

= _ = = -
Rﬂrﬁan Power | Virfual Media | User Management | Device Setfings | Security | Maintenance | Diagnostics | Help

m Haome > Pars Leazut

Time & Session:
December 05, 2013 142127 Port Access

Uaar: sdmin Click on the individual port name to see allowable operations.

State 3 min ik ;
e i ST oS 0/ 4 Remeote K\VM channeis currently in use.

Last Login: Dec 05, 2013 11:40:42

Group | View By Search | Set Scan

Devies Information:

- . Availability
Device: Name: Daminion X-sample
P Addrese. 192 168.561.20 1 HOMI Targ=t D I-HDMI up de
Firmware: 3.0.0.1.369 - -
et H Dorinion-KX2_Port2 TVIA-DV up it
Hetwork LANT 3 Low Coel DV [PA20540016] Duak-vi ug o
Fowernt: on o
4 W P {0
Powed off Vindows PSP o up e
Configured As Base 3 DP-Doaminion-KXZ_Paort13 I-DP ug de
1 & Dorini De up it
Fort States: T Dominien-Ixa_Port? Duskvh ug L
353 Ports: up
54 Porie: down 8 po-kef-update Hot Avaiabk down e
413 Ports: die E] ¥ KNB480-234 Ters TisrDevics up e
10 B x@3250.241-ler2 TiaiDevics ug ke
Connected Users: 1 ¥ KEE3Z-E1-14-Tiarl TharDavica ug e
admn (Local Consalk)
38 min idle 114 DCME?mulatorfortl29 oCiw up He
odmin (152 16832 165) 12 DCMSimulatorPorti?5 L] up e
3 min idle
o 13 DS 1027 D o e
11-4 DCMSImulatorPorti3s Do ug e
nline Halp

-

.
Favorite Device s: l:l lz' El El --page 15 Riows per Paqc

Use the Remote Console to access and scan target servers, manage
favorites, and change your password.

For more in the Remote Console interface elements, see KX |ll Remote
Console Interface (on page 18).
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Scanning Ports - Remote Console

;

Raritan.

Use the port scanning feature to search for selected targets and display
them in individual thumbnails as part of a slide show.

This feature allows you to monitor up to 32 targets at one time since you
can view each target server individually as it is displayed during the slide
show.

Connect to targets or focus on a specific target as needed.

Scans can include standard targets, blade servers, tiered Dominion
devices, and KVM switch ports.

For dual video port groups, the primary port is included in a port scan,
but the secondary port is not included when connecting from a remote
client. Both ports can be included in the scan from the Local Port.

Note: The scan port feature is available from the Remote Console and
Local Console, but the feature varies slightly.
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Scanning Ports Slide Show - Remote Console
When you start a scan, the Port Scan window opens.
As each target is found, it is displayed as a thumbnail in a slide show.

The slide show scrolls through the target thumbnails based on the
default interval of 10 seconds or according to the interval you specify.

As the scan scrolls through the targets, the target that is the focus of the
slide show displays in the center of the page.

The name of the target is displayed below its thumbnail and in the task
bar at the bottom of the window.

If a target is busy, a blank screen is displayed instead of the target server
access page.

2 Port Scan - Virtual KVM Client i ol B e N e e el

Scan Options

» Control Panel » Al Control Panet ltems » Display » Screen Resolution

Change the appearance of your display

Display 2. Rantan an ~| B - Lowlpat

Resclution: [1440x900 ~

[lmds(apc

B 4 - TLORE46HKET200. .

B 5 - Dominion 002 Ports

& L -Damnionx2_Ports

100

Configure scan settings for the Remote Console from either the Virtual
KVM Client (VKC) or Active KVM Client (AKC).

See Configuring Port Scan Settings in VKC and AKC (on page 65)

Note: Scan port settings for the Local Console are configured on the
Local Port Settings page. See Scanning Ports - Local Console (on
page 113)
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Target Status Indicators During Port Scanning - Remote Console

The status of each target is indicated by green, yellow and red lights that
are displayed below the target thumbnail.

As the target is the focus of the rotation, the indicator is in the task bar
also shows the status.

Lights for each target are gray until they are the focus of the slide show.
The status lights indicate the following:

e Green - the target is up/idle or up/connected

e Yellow - the target is down but connected

e Red - the target is down/idle, busy, or otherwise not accessible

| £ Port Scan - Virtual KVM Client e . B

can Options

» Control Paned » Al Control Paned ltems » Display » Soreéen Resolution

[2. Rarttan covs ~ |

| 1420 x 300 -|

Crienation: [Landscape

Change the appearance of your display -

va

il 2 -KX3 Local Port

B 4 - T1D0-46HKET00.

B 5 - Dorinion012_Ports

B |- Domikon+X32 Ports [
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Using Scan Port Options

Following are options available to you while scanning targets.

With the exception of the Expand/Collapse icon, all of these options are
selected from the Options menu in the upper left of the Port Scan viewer.

The options will return to their defaults when you close the window.

Note: Configure scan settings such as the display interval from either the
Virtual KVM Client (VKC) or Active KVM Client (AKC). See Configuring
Port Scan Settings in VKC and AKC (on page 65)

> Hide or View Thumbnails
4
e Use the Expand/Collapse icon P at the upper left of the window to
hide or view thumbnails. Expanded is the default view.

» Pause the Thumbnail Slide Show

o Pause thumbnails from rotating between one target and the next by
selecting Options > Pause. Rotating thumbnails is the default setting.

> Resume the Thumbnail Slide Show
¢ Resume the thumbnalil rotation by selecting Options > Resume.

> Size the Thumbnails in the Port Scan Viewer

e Enlarge the size of the thumbnails by selecting Options > Size >
360x240.

e Minimize the size of the thumbnails by selection Options > Size >
160x120. This is the default thumbnail size.

> Change the Orientation of the Port Scan Viewer

e View thumbnails along the bottom of the Port Scan viewer by
selecting Options > Split Orientation > Horizontal.

e View thumbnails along the right of the Port Scan viewer by selecting
Options > Split Orientation > Vertical. This is the default view.
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|4 Port Scan - Virtual KVM Client EX - i ~_ - - o 5

(Scul OE!ionsk

Pause

Resume
Thumbnail Size ¥
Spht Orientation »

» Control Panel » Al Control Panel ltems » Display » Screen Resolution

Change the appearance of your display

Display: 2 Raritan M ~| 9 2 -«xsLomlport

Resciutiore 1440 = 900 'I

Scan for Targets

> To scan for targets:
1. Click the Set Scan tab on the Port Access page.

2. Select the targets you want to include in the scan by selecting the
checkbox to the left of each target, or select the checkbox at the top
of the target column to select all targets.

3. Leave the Up Only checkbox selected if you only want targets that
are up to be included in the scan. Deselect this checkbox if you want
to include all targets, whether up or down.

4. Click Scan to begin the scan.

As each target is scanned, it is displayed in slide show view on the
page.

Home * Parb Logout

Port Access

Click on the individual port name to see allowable operations.
0 /4 Remote KVIM channels currently in use.

s T

tip Only

Vigw By Port | View By Group

Viewr By Search |[SSESGaN

Narme Avaslability

| 2 Low Coat VM [PO2054001E] CuakvM ] 13
] 3 DR_Dominon-KxZ_Fort3 DVN-OP up ik
i 4 WinkPC2 DuabWM up e
il 5 Daminion-442_Ports WM up die
= ] Daminion-¥X2_Ports CuaH¥M upg aie
e ./J
S0 qawn:e'PaqeiI
. ks W gt ™ B ot AT A s B B e B B B

5. Click Options > Pause to pause the slide show and stop it from
moving between targets, click Options > Resume to resume the slide
show.

6. Click on a target thumbnail to scan it next.

7. Connect to a target by double clicking on its thumbnail.
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Changing a Password

> To change your KX Il password:

Choose User Management > Change Password. The Change
Password page opens.

Type your current password in the Old Password field.

3. Type a new password in the New Password field. Retype the new
password in the Confirm New Password field. Passwords can be up
to 64 characters in length and can consist of English alphanumeric
characters and special characters.

Click OK.

You will receive confirmation that the password was successfully
changed. Click OK.

Note: If strong passwords are in use, this page displays information
about the format required for the passwords. For more information about
passwords and strong passwords, see Strong Passwords in online help.

Home = User Management = Change Fasaword

Change Password

Old Password

Hew Password

Confirm Hew Password

0K | Cancel
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Managing Favorites

i

Raritan.

A Favorites feature is provided so you can organize and quickly access
the devices you use frequently.

The Favorite Devices section is located in the lower left side (sidebar) of
the Port Access page and provides the ability to:

e Create and manage a list of favorite devices
e Quickly access frequently-used devices

e List your favorites either by Device Name, IP Address, or DNS
hostname

e Discover KX Il devices on its subnet (before and after login)

e Retrieve discovered KX lll devices from the connected Dominion
device (after login)
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Enable Favorites

e Click Enable in the Favorite Devices section of the left panel of the
KX Ill interface.

Once enabled, the Enable button becomes a Disable button.

= .
== Raritan.
Bominion™
Time & 5eslon:
January 041, 2000 22:52:18 Port Access
g:;r =dm":'.." Click on the Inaivie
8 acive r 4 Rem
Your P: 192 168 32 170 0re atre KU ¢
LastLogin: Jen 01, 2000 19:51:08
J View By Port | View By
Device Information:
& =]
Davica ame: Domnionl o Hame
IP Addresx: 182 185 81.20 1 Window
Firmmsars: 3.0.0.1.444
Device Model OI ? Law Ce
Mateorc Lan 3 DE-Domw
Poweerind: an P WP
5 Daminio
\ —
Port States: a pamii
5 Ports: up T Dominio
2T Poris: down
32 Poria: B & Dominio
5 Dominio
1
Connected Users: o Lamiia
admin [182.163.32.1T3) 11 Domniie
actwe —
12 Draminio
1 13 Dominio
Online Help 14 Dominiic
Ll
1 15 Domini
Favorite Devices: —
16 Draminic
Enabl= h = po—
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Access and Display Favorites

» To access a favorite KX Ill device:

e Click the device name (listed beneath Favorite Devices). A new
browser opens to that device.

> To display favorites by name:
e Click Display by Name.

> To display favorites by IP Address:
e Click Display by IP.

> To display favorites by the host name:
e Click Display by Host Name.

Favorite Devices:
NewJersey_RemoteOffice
Sydney_RemoteOffice

/ .

:

This option discovers the devices on your local subnet, which is the
subnet where the KX 1l Remote Console is running. These devices can
be accessed directly from this page or you can add them to your list of
favorites.

Manage I Display By Hame l

Display By Host Name I Display By IP |

—Nea A 3
R G- ' anie W
- ’t-A A PV
~ .
Ve etad

Discovering Devices on the Local Subnet

» To discover devices on the local subnet:

Choose Manage > Discover Devices - Local Subnet. The Discover
Devices - Local Subnet page appears.

2. Choose the appropriate discovery port:

107



Chapter 8: KX Ill Remote Console

= To use the default discovery port, select the Use Default Port
5000 checkbox.

= To use a different discovery port:

a. Deselect the Use Default Port 5000 checkbox.

b. Type the port number in the Discover on Port field.
c. Click Save.

Click Refresh. The list of devices on the local subnet is refreshed.

To add devices to your Favorites List:
Select the checkbox next to the device name/IP address.
Click Add.

To access a discovered device:

Click the device name or IP address for that device. A new browser
opens to that device.

Discovering Devices on the KX lll Subnet

This option discovers devices on the device subnet, which is the subnet
of the KX Il device IP address itself. You can access these devices
directly from this the Subnet page or add them to your list of favorites.
See Favorites List Page.

This feature allows multiple KX 11l devices to interoperate and scale
automatically. The KX Il Remote Console automatically discovers the
KX Il devices, and any other Raritan device, in the subnet of the KX 111,

>
1.
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To discover devices on the device subnet:

Choose Manage > Discover Devices - KX Ill Subnet. The Discover
Devices - KX Il Subnet page appears.

Click Refresh. The list of devices on the local subnet is refreshed.

To add devices to your Favorites List:
Select the checkbox next to the device name/IP address.
Click Add.

To access a discovered device:

Click the device name or IP address for that device. A new browser
opens to that device.
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KX Il Local Console

In This Chapter
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Overview

The Local Console interface provides access to the KX Il while at the
rack.

This section contains help on tasks performed by end users at the Local
Console.

Accessing a Target Server

i

Raritan.

P> To access atarget server:

Click the Port Name of the target you want to access. The Port
Action Menu is displayed.

2. Choose Connect from the Port Action menu. The video display
switches to the target server interface.
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Local Console Video Resolutions

Once a monitor is connected to the KX 11l Local Console, KX Il detects
the native resolution of the monitor. This is typically the highest
resolution supported by the monitor.

As long as the monitor's native resolution is supported by the Local
Console, KX Il uses that resolution.

If the native resolution is not supported by the Local Console, and no
other resolution is supported by the monitor and Local Console, KX III
uses the resolution of the last monitor that was connected to the Local
Console.

For example, you connect a monitor set to a resolution of
1600x1200@60Hz to the KX Il Local Console. KX Il uses that resolution
since it is supported by the Local Console.

If the next monitor you connect to the Local Console is not set to a
supported resolution, KX Il uses the resolution of 1024x768@60.

For a list of supported Local Console video resolutions, see Supported
KX Il Local Port DVI Resolutions (see "KX Ill Supported Local Port
DVI Resolutions” on page 138).

Considering also reviewing Video Mode and Resolution Notes (on
page 169) for additional information.

Simultaneous Users

The KX Il Local Console provides an independent access path to the
connected KVM target servers.

Using the Local Console does not prevent other users from
simultaneously connecting over the network. And even when remote
users are connected to the KX Ill, you can still simultaneously access
your servers from the rack via the Local Console.
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Local Port Hot Keys and Connect Keys

Because the KX Il Local Console interface is completely replaced by the
interface for the target server you are accessing, a hot key is used to
disconnect from a target and return to the local port GUI.

A connect key is used to connect to a target or switch between targets.

The Local Port hot key allows you to rapidly access the KX Il Local
Console user interface when a target server is currently being viewed.

See Select the Local Port Hotkey and Select the Local Port Connect Key
for more information.
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Return to the KX Il Local Console from a Target Server - Default

Hot Key

> Toreturn to the KX Il Local Console from the target server:

e Press the Scroll Lock hot key twice rapidly

The video display switches from the target server interface to the KX
[ll Local Console interface.

Local Port Auto-Sense (Video Refresh) - Default Hot Key

> To perform an auto-sense (video refresh) on the KX Il local port

via hot key:

e Press and hold the Shift key, and quickly press the Scroll Lock key
twice, and then release.

Connect Key Examples

Standard servers

Connect key action

Access a port from the
local port

Switch between ports

Key sequence example
e Press Left ALT > Press and Release 5 > Release Left
ALT

e Press Left ALT > Press and Release 1 > Press and
Release 1 > Release Left ALT

Disconnect from atarget e Double-click Scroll Lock
and return to the local port

Blade chassis

Connect key action

Access a port from
the local port GUI

Switch between
ports

Disconnect from a
target and return to
the local port GUI

Key sequence example
Access port 5, slot 2:

e Press Left ALT > Press and Release 5 > Press and Release
- > Press and Release 2 > Release Left ALT

Switch from target port 5, slot 2 to port 5, slot 11:

e Press Left ALT > Press and Release 5 > Press and Release
- > Press and Release 1 > Press and Release 1 > Release
Left ALT

Disconnect from target port 5, slot 11 and return to the local port
GUI (the page from which you connected to target):

e Double Click Scroll Lock
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Special Sun Key Combinations

The following key combinations for Sun™ Microsystems server’s special
keys operate on the local port. These special are available from the
Keyboard menu when you connect to a Sun target server:

Sun key Local port key combination
Again Ctrl+ Alt +F2

Props Ctrl + Alt +F3

Undo Ctrl + Alt +F4

Stop A Break a

Front Ctrl + Alt + F5
Copy Ctrl + Alt + F6
Open Ctrl + Alt + F7

Find Ctrl + Alt + F9

Cut Ctrl + Alt + F10
Paste Ctrl + Alt + F8

Mute Ctrl + Alt + F12
Compose Ctrl+ Alt + KPAD *
Vol + Ctrl + Alt + KPAD +
Vol - Ctrl + Alt + KPAD -
Stop No key combination
Power No key combination

112
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Scanning Ports - Local Console

;

Raritan.

Use the port scanning feature to search for selected targets and display
them in individual thumbnails as part of a slide show.

This feature allows you to monitor up to 32 targets at one time since you
can view each target server individually as it is displayed during the slide
show.

Connect to targets or focus on a specific target as needed.

Scans can include standard targets, blade servers, tiered Dominion
devices, and KVM switch ports.

For dual video port groups, the primary port is included in a port scan,
but the secondary port is not included when connecting from a remote
client. Both ports can be included in the scan from the Local Port.

Click on the thumbnail of any target server to exit scan mode and
connect to the target, or use the Local Port ConnectKey sequence.

To exit scan mode, click the Stop Scan button in the thumbnail view, or
use the DisconnectKey sequence hot key.

Note: The scan port feature is available from the Remote Console and
Local Console, but the feature varies slightly. See Scanning Ports -
Remote Console (on page 99)
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Scanning Port Slide Show - Local Console

When you start a scan, the Port Scan window opens.
As each target is found, it is displayed as a thumbnail in a slide show.

The slide show scrolls through the target thumbnails based on the
default interval of 10 seconds or according to the interval you specify.

As the scan scrolls through the targets, the target that is the focus of the
slide show displays in the center of the page.

The name of the target is displayed below its thumbnail and in the task
bar at the bottom of the window.

If a target is busy, a blank screen is displayed instead of the target server
access page.

Configure the time between the slide show thumbnail rotation and the
thumbnail focus interval on the Local Port Settings page.

See Configure Local Console Scan Settings (on page 116)

Note: Configure scan settings for the Remote Console from either the
Virtual KVM Client (VKC) or Active KVM Client (AKC). See Configuring
Port Scan Settings in VKC and AKC (on page 65)

Connection USB Profile Keyboard Video Mouse Tools Yiew Virtusl Media Audic SmartCard Help
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Target Status Indicators During Port Scanning - Local Console

In thumbnail view on the Local Console, the status of each target is
indicated below the thumbnail on the page until it is the focus of the slide
show view.

The scanning status of each target is displayed as:

e not scanned
e connecting
e scanned

e skipped

Connection USB Profile Keyboard Video Mouse Tools View Virtual Media Audic SmartCard Help

B RhEHEKEEQD DO @

Scanning...

#3-6: Blade_Chassis_Port4_Slot6 #4-1: Blade_Chassis_Port4_Slotl #4-2: Blade_Chassis_Port4_Slot2
scanned! scanned connecting !
[=]

Configure Local Console Scan Settings

Do the following to configure Local Console scan port options.

Note: Configure scan settings for the Remote Console from either the
Virtual KVM Client (VKC) or Active KVM Client (AKC). See Configuring
Port Scan Settings in VKC and AKC (on page 65)

To configure the Local Console scan port settings:
On the Local Console, select Device Settings.

In the Local Port Settings section, select Local Port Scan Mode.

w N =Y

Change the display interval as needed:
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= Display Interval - changes the scan display interval.

= Interval Between Ports - change interval between switching
different port during scan.

Scan for Targets - Local Console

> To scan for targets:
1. Click the Set Scan tab on the Port Access page.

2. Select the targets you want to include in the scan by selecting the
checkbox to the left of each target, or select the checkbox at the top
of the target column to select all targets.

3. Leave the Up Only checkbox selected if you only want targets that
are up to be included in the scan. Deselect this checkbox if you want
to include all targets, whether up or down.

4. Click Scan to begin the scan.

As each target is scanned, it is displayed in slide show view on the
page.

Local Console Smart Card Access

;

Raritan.

To use a smart card to access a server at the Local Console, plug a USB
smart card reader into the KX Il using one of the USB ports located on
the KX 111

Once a smart card reader is plugged in or unplugged from the KX IlI, the
KX Il autodetects it.

For a list of supported smart cards and additional system requirements,
see Supported Smart Card Readers (on page 147), Unsupported
Smart Card Readers (on page 148) and Smart Card Minimum System
Requirements (on page 145).

When mounted onto the target server, the card reader and smart card
will cause the server to behave as if they had been directly attached.

Removal of the smart card or smart card reader will cause the user
session to be locked or you will be logged out depending on how the
card removal policy has been setup on the target server OS.

When the KVM session is terminated, either because it has been closed
or because you switch to a new target, the smart card reader will be
automatically unmounted from the target server.

> To mount a smart card reader onto atarget via the KX Il Local
console:

1. Plug a USB smart card reader into the KX Il using one of the USB
ports located on the device. Once attached, the smart card reader
will be detected by the KX III.
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From the Local Console, click Tools.

Select the smart card reader from the Card Readers Detected list.
Select None from the list if you do not want a smart card reader
mounted.

Click OK. Once the smart card reader is added, a message will
appear on the page indicating you have completed the operation
successfully. A status of either Selected or Not Selected will appear
in the left panel of the page under Card Reader.

To update the Card Readers Detected list:

Click Refresh if a new smart card has been mounted. The Card
Readers Detected list will be refreshed to reflect the newly added
smart card reader.

Card Readers Detected

USE SmartCard Reader (Gemplus)

QK Refresh | Cancel |

118
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Local Console USB Profile Options

i

Raritan.

From the USB Profile Options section of the Tools page, you can choose
from the available USB profiles.

The ports that can be assigned profiles are displayed in the Port Name
field and the profiles that are available for a port appear in the Select
Profile To Use field after the port is selected. The profiles selected for
use with a port appear in the Profile In Use field.

> To apply a USB profile to a local console port:

In the Port Name field, select the port you want to apply the USB
profile to.

2. Inthe Select Profile To Use field, select the profile to use from
among those available for the port.

3. Click OK. The USB profile will be applied to the local port and will
appear in the Profile In Use field.

USB Profile Options

Port Name Select Profile To Use

No Port Selected Genernc

Mac 05-X (104 9 and later)
HP Proliant DL360/DL380 G4 (Windows 2003 Server

Lo

I Y
'\v’\ L"\ o A

Profile In Use

ﬁ] Refresh | Cance |
T A naaad s m e A _..J"'"“‘. ) <w—~"‘ S e L ,"‘“...d““‘".\

NLans
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KX Ill Local Console Factory Reset

Note: It is recommended that you save the audit log prior to performing a
factory reset.

The audit log is deleted when a factory reset is performed and the reset
event is not logged in the audit log. For more information about saving
the audit log, see Audit Log.

> To perform a factory reset:

1. Choose Maintenance > Factory Reset. The Factory Reset page
opens.

2. Choose the appropriate reset option from the following options:

= Full Factory Reset - Removes the entire configuration and resets
the device completely to the factory defaults. Note that any
management associations with CommandCenter will be broken.
Because of the complete nature of this reset, you will be
prompted to confirm the factory reset.

= Network Parameter Reset - Resets the network parameters of
the device back to the default values (click Device Settings >
Network Settings to access this information).

3. Click Reset to continue. You will be prompted to confirm the factory
reset because all network settings will be permanently lost.

4. Click OK proceed. Upon completion, the KX Il device is
automatically restarted.

120

Resetting the KX Il Using the Reset Button on the Device

On the back panel of the device, there is a Reset button. It is recessed to
prevent accidental resets (you need a pointed object to press this
button).

The actions that are performed when the Reset button is pressed are
defined on the Encryption & Share page. See Encryption & Share in
online help.

Note: It is recommended that you save the audit log prior to performing a
factory reset.

The audit log is deleted when a factory reset is performed and the reset
event is not logged in the audit log. For more information about saving
the audit log, see Audit Log.

» To reset the device:
1. Power off the KX III.

]
i
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Use a pointed object to press and hold the Reset button.

While continuing to hold the Reset button, power the KX 11l device
back on.

Continue holding the Reset button for 10 seconds.

RESET LAN1Y
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Appendix A

Connecting a KX lll and Cat5 Reach
DVI - Provide Extended Local Port
Functionality

In This Chapter
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Overview

An extended local port extends the reach of the local port beyond the
rack the KX Il is located, for example to another KVM switch.

This can be achieved by configuring a KX Il to work with a Raritan Cat5
Reach DVI transmitter and receiver, which are then connected to a
remote console or other device.

Once connected to the Cat5 Reach DVI, the KX Ill can be accessed up
500 feet (152 m) away.

Connecting the KX Il to the Cat5 Reach DVI by daisy chaining Ethernet
switches extends can extend the KX IlI's reach up to 3000 feet (914 m).

About the Cat5 Reach DVI

i

Raritan.

For details on the Cat5 Reach DVI, see the Cat5 Reach DVI online help
available on the Raritan Support page
http://www.raritan.com/support.

Contact Raritan (http://www.raritan.com/contact-us/) for additional
information on the Cat5 Reach DVI, or for information on purchasing.
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Connect a KX lll and Cat5 Reach DVI

;
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Note: The images used in the diagrams are not specific to KX Il but the
connections are accurate.

This section introduces three scenarios involving KVM switches.

Connect the Cat5 Reach DVI between any KVM switch and its local
console.

Connect the Cat5 Reach DVI between two KVM switches.

Connect the Cat5 Reach DVI between a computer/server and a KVM
switch.

Turn off all devices before making the connections.

For detailed information on setting up the local and remote consoles, see
Connecting a Keyboard/Mouse/Video Source in Cat5 Reach DVI
Help for more information.

>

1.

To connect a KX Ill and Cat5 Reach DVI:

If you have not already done so, set up the local and remote
consoles with the Cat5 Reach DVI transmitter and receiver,
respectively.

See Basic Installation in Cat5 Reach DVI Help for more
information.

Use a Catb5e/6 cable to connect the transmitter and receiver.

Connect the transmitter and receiver to an appropriate power source
respectively.

Connect the local console ports of the KVM switch to the transmitter.

a. Plug one end of the Raritan-provided DVI cable into the DVI-I IN
port on the transmitter, and the other end into the KVM switch's
video port.

b. Plug the USB-B connector of the Raritan-provided USB cable
into the USB-B port on the transmitter, and the other end into the
KVM switch's local USB-A port.
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5. Turn on the KVM switch.

BB R

| 2 e e

(i

| Tl |

Tip: The local or remote console can be equipped with a KVM drawer
instead of a set of keyboard, mouse and monitor. See the illustration
below.

» Toincrease the distance between two tiered KVM switches:
Set up a remote console by connecting the receiver to a KVM switch.
a. Connect a USB CIM to the receiver.

b. Connect this USB CIM to any channel port on the KVM switch
via a Catb cable.

Use a Cat5e/6 cable to connect the transmitter and receiver.

3. Connect the transmitter and receiver to an appropriate power source
respectively.

4. Connect the KVM switch to the transmitter.

124
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5.

Turn on both KVM switches.
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To increase the distance between any computer and a KVM
switch:

Set up an optional local console with the transmitter.
Set up a remote console by connecting the receiver to a KVM switch.
Use a Cat5e/6 cable to connect the transmitter and receiver.

Connect the transmitter and receiver to an appropriate power source
respectively.

Connect the computer to the transmitter.

Turn on the computer.

Raritan.
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Appendix B Accessing a Paragon Il from the KX
1

In This Chapter

OVEIVIEW ...ttt ettt ettt e ettt e e et e e e e enb e e e e st e e e e nnees 126
Supported Paragon Il CIMS and Configurations...........cccccccoevvvvvvenennnn. 127
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Overview

Connect the Paragon Il system to a KX Ill device that is managed by CC-
SG so that Paragon Il is accessible from CC-SG.

This diagram indicates the configuration integrating KX lII.

Note: The images are for example purposes only, and may not look
exactly like your device.

HE SR

The Paragon Il system involving Paragon Il switches,
servers and user stations

The user station with a DCIM-USB G2 attached
KX I

@® @ ©
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When you access the Paragon Il system from KX Il or CC-SG (if the KX
IIl'is managed by CC-SG), the Paragon Il OSUI login screen appears for
you to log in.

In this integration, you can perform any OSUI functions implemented with
current Paragon Il firmware or any KX IlI function implemented with
current KX Il firmware except for the virtual media feature.

When accessing the Paragon Il OSUI through KX Ill, DO NOT attempt to
synchronize the mouse manually. A mouse is not necessary on the OSUI
screen and mouse synchronization will delay the keyboard response for
seconds.

See Supported Paragon Il CIMS and Configurations (on page 127) for
additional information.

Supported Paragon Il CIMS and Configurations

The KX 1l supports the P2CIM-APS2DUAL and P2CIM-AUSBDUAL
CIMs, which provide two RJ45 connections to different KVM switches.

Support of these CIMs provides a second path to access the target in the
event that one of the KVM switches is blocked or fails.

Paragon CIM Supports Does not support

P2CIM-APS2DUAL Servers with IBM® Virtual media
PS/2-type keyboard
and mouse ports

Smart cards

. e Absolute Mouse
e Automatic skew

; mode

compensation (when

the CIMs are e Use with blade

connected to chassis

Paragon I, notfroma o Cascaded KVM

KX1H) configurations
¢ Intelligent Mouse

mode

e Standard Mouse
mode

;
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Paragon CIM Supports Does not support

P2CIM-AUSBDUAL e Servers with USB- or Virtual media
Sun™ USB-type
keyboard and mouse
ports e Absolute Mouse

mode

Smart cards

e Automatic skew
compensation (when ®  Use with blade
the CIMs are chassis
connected to e Cascaded KVM
Paragon II, not from a configurations
KX 111y

¢ Intelligent Mouse
mode

e Standard Mouse
mode
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KX lll-to-KX 1l Paragon CIM Guidelines

The following system configuration guidelines should be followed when
you are using Paragon CIMs in a KX IlI-to-KX Il configuration:

Concurrent Access

Both KX Il KVM switches should be configured with the same policy for
concurrent access to targets - both PC-Share or both Private.

If Private access to targets is required, both KVM switches must be
configured accordingly:

e From Security > Security Settings > Encryption & Share, set PC
Share Mode to ‘Private’

This guarantees that concurrent access to targets is prohibited, for all
targets by all user groups.

The KX Il allows for more granular control of concurrent access to
targets on a per user group basis. This is done by setting the user
group’s PC Share permissions. However, this is only enforced within the
boundary of a KX lll. User Group PC Share permissions must not be
relied on if Privacy must be guaranteed when using the P2CIM-
APS2DUAL or P2CIM-AUSBDUAL with the KX lII.

CIM Name Updates

The P2CIM-APS2 and P2CIM-AUSB names are stored within the CIM’s
memory. There are two memory locations provided to accommodate the
Paragon naming convention (12 characters) and the KX Ill naming
convention (32 characters).

When first connected to a KX I, the Paragon name will be retrieved from
memory and written into the CIM memory location used by KX .
Subsequent queries for the CIM name or updates to the CIM name from
the KX Il will be made to the memory location used by the KX III.
Updates will not be made by the KX Il to the memory location used by
Paragon Il.

When the CIM name is updated by one KX IlI, the other KX 11l will detect
and retrieve the updated name on the next attempt to connect to that
target. Until that time, the name will not be updated on the other KX .

Port Status and Availability

The port status, displayed on the KX Il Port Access page as either Up or
Down, is updated to show whether the CIM is powered up and
connected to the KX Il port.

The port availability, as displayed on the KX IIl Port Access page as Idle,
Busy or Connected, is only updated to reflect activity on a target that has
been initiated from that same KX IIl.
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If a connection to the target is in place from the other KX 1lI, the
availability is checked when a connection is attempted. Access is denied
or allowed consistent with the PC-Share policy in place for the KX IlI.
Until that time, the availability is not be updated on the other KX .

If access is denied because the target is busy, a notification is displayed.
Working from CC-SG

Operations initiated from CC-SG are based on the Status, Availability
and CIM name reported by the managed KX Ill. When the target is
connected to two managed KX llIs and the devices are added to CC-SG,
two nodes will be created. Each node will have its own oob-kvm interface
associated with it. Alternatively, a single node can be configured with an
oob-kvm interface from each KX IlI.

If the KX llls are configured for ‘Private’ mode, when a second
connection is attempted the user is notified that they cannot connect and
access is denied.

When a port name change is initiated via the CC-SG Port Profile pane,
the changed name is pushed to the managed KX Ill. The corresponding
port name of the other KX Il will not be updated in CC-SG until a
connection is attempted to the target port via the other KX llI’'s oob-kvm
interface.

KX lll-to-Paragon Il Guidelines

The P2CIM-APS2DUAL or P2CIM-AUSBDUAL can be connected to a
KX Il and Paragon II.

Concurrent Access

The KX Il and Paragon Il must be configured with the same policy for
concurrent access to targets.

Paragon Il Mode description Supported?
operation

mode

Private A server or other device Supported.

on a specific channel
port can be accessed
exclusively by only one
user at a time.

Paragon Il and the KX 1lI
must be set to Private. The
Private setting is applied on
to KX 1l device, not per user

group.

The Paragon Il uses Red to
indicate ‘busy’ or Green to
indicate ‘available’.

PC Share A server or other device Supported.

on a specific channel However, PC Share Idle

==
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Mode description

port can be selected and
controlled by more than
one user, but only one
user has keyboard and
mouse control at any
one time.

While one user is
accessing a server or
other device on a
specific channel port,
other users can select
that channel port and
view the video output
from that device.
However, only the first
user will have keyboard
and mouse control until
they disconnect or
switch away.

CIM Name Updates

Supported?

Timeout, which is configured
on the Paragon I, is not
supported. Both users will
have concurrent keyboard
and mouse control.

The Paragon Il uses Green
to indicate ‘available’. This
will also be true if another
user is already accessing
the target.

Not supported.

This mode cannot be used
when connecting the CIM to
a Paragon Il and the KX III.

The Paragon Il uses Yellow
to indicate it is in P-View
mode.

e CIM names updated from Paragon Il are stored and retrieved from
the CIM memory location corresponding to the Paragon naming

convention.

e CIM names updated from the KX Il are stored and retrieved from the
CIM memory location corresponding to the KX Ill naming convention.

e CIM name updates do not propagate between the Paragon Il and the

KX II.

Supported Connection Distances Between Paragon Il and KX IlI

When using KX III as the front end of a Paragon Il system, you should
restrict the cable length (distance) for good video quality.

Supported distance from the Paragon Il user station to the target server
is 500 cable feet (152 m). Greater distances may result in video
performance that may or may not be acceptable to you.

Supported distance from KX 11l to the Paragon Il user station is up to 150

cable feet (45 m).
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Connecting the Paragon Il to the KX 1l

>

To connect the Paragon Il system to a KX III:

Check whether the Paragon Il user station that you want to connect
to the KX Il is implemented with version 4.6 firmware (or later). If
not, upgrade it.

The Paragon Il user station can be one of these:

= P2-UST
= P2-EUST
= P2-EUST/C

See Paragon Il Help for information on upgrading.

Plug a compatible DCIM-USB into the USB and video ports on the
Paragon Il user station.

If the system is a two- or three-tier system, ensure the Paragon Il
user station is connected to the base KX Il device (first tier).

Connect the Paragon Il user station to a KX Il device via a Cat5
UTP cable up to 150 feet (45 m).

= Plug one end of the cable to the DCIM's RJ-45 port and the other
end to one of the channel ports on the KX 1l device.

If you want to have more paths to access the same Paragon Il
system in KX Il or CC-SG, repeat Steps 1 to 3 to connect additional
user stations to the KX III.

]
i

==Raritan.



Appendix C Specifications

In This Chapter
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Hardware
KX 1l Dimensions and Physical Specifications
Dominion KX Description Power & Dimensions Weight Operating Humidity
Il model heat (WxDxH) temp
dissipation
DKX3-108 = 8server Dual Power 17.3"x 8.60lbs 0°-45°C 0-85%
ports 110Vv/240V, 13.15"x RH
= 1 remote 50-60Hz 1.73"
user 1.8A 60W 439x334x44  3.9kg 320-113°
= 1 local 52 KCAL mm F
port for
use at
the rack
DKX3-116 = 16 server Dual Power 17.3"x 8.60lbs 0°-45°C 0-85%
ports 110Vv/240V, 13.15"x RH
= 1remote 50-60Hz 1.73"
user 1.8A 60W 439x334x44 3.9kg 320-113°
= 1 |ocal 52 KCAL mm =
port for
use at
the rack
DKX3-132 = 32server Dual Power 17.3"x 8.60lbs 0°-45°C 0-85%
ports 110Vv/240V, 13.15"x RH
= 1 remote 50-60Hz 1.73"
user 1.8A 60W 439x334x44 3.9kg 320-113°
= 1] |ocal 52 KCAL mm =
port for
use at
the rack
DKX3-216 = 16 server Dual Power 17.3"x 9.08lbs 0°-45°C 0-85%
ports 110V/240V, 13.15"x RH
= 2remote 50-60Hz 1.73"
users 1.8A 60W 439x334x44  4.12kg 320-113°
Raritan. 18
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Dominion KX

11l model

DKX3-232

DKX3-416

DKX3-432

DKX3-464

DKX3-808

134

Description

= 1 local
port for
use at
the rack

= 32 server
ports

= 2 remote
users

= 1 |ocal
port for
use at
the rack

= 16 server
ports

= 4 remote
users

= 1 local
port for
use at
the rack

= 32 server
ports

= 4 remote
users

= 1 local
port for
use at
the rack

= 64 server
ports

= 4 remote
users

= 1 |ocal
port for
use at
the rack

= 8 server
ports

= 8 remote
users

= 1 |ocal

Power &
heat
dissipation
52 KCAL

Dual Power
110Vv/240V,
50-60Hz

1.8A 60W
52 KCAL

Dual Power
110Vv/240V,
50-60Hz

1.8A 60W
52 KCAL

Dual Power
110V/240V,
50-60Hz

1.8A 60W
52 KCAL

Dual Power
110Vv/240V,
50-60Hz

1.8A 60W
52 KCAL

Dual Power
110V/240V,
50-60Hz

1.8A 60W
52 KCAL

Dimensions Weight

(WxDxH)

mm

17.3" X
13.15" x
1.73"

439x334x44
mm

17.3"x
13.15" x
1.73"

439x334x44
mm

17.3"x
13.15" x
1.73"

439x334x44
mm

17.3"x
13.3"x 3.5"

439x338x89
mm

17.3"x
13.15" x
1.73"

439x334x44
mm

9.08lbs

4.12kg

9.08lIbs

4.12kg

9.08Ibs

4.12kg

12.39Ibs

5.62kg

9.96lbs

4.52kg

Operating Humidity

temp

F

0°-45°C 0-85%
RH

320-113°

F

0°-45°C 0-85%
RH

32°0-113°

F

0°-45°C 0-85%
RH

320-113°

F

0°-45°C 0-85%
RH

320-113°

F

0°-45°C 0-85%
RH

320-113°

F

=Y .
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Dominion KX

11 model

DKX3-832

DKX3-864

;

Description

port for
use at
the rack

32 server
ports

= 8 remote
users

= 1 local
port for
use at
the rack

= 64 server
ports

= 8 remote
users

= 1 local
port for
use at
the rack

Raritan.

Power &
heat
dissipation

Dual Power
110V/240V,
50-60Hz

1.8A 60W
52 KCAL

Dual Power
110V/240V,
50-60Hz

1.8A 60W
52 KCAL

Dimensions Weight

(WxDxH)

17.3"x
13.15" x
1.73"

439x334x44
mm

17.3"x
13.3"x 3.5"

439x338x89
mm

9.96lbs

4.52kg

12.39Ibs

5.62kg

Appendix C: Specifications

Operating
temp

0°-45°C

32°-113°

=

0°-45°C

32°-113°
F

Humidity

0-85%
RH

0-85 %
RH
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KX 1l Supported Target Server Video Resolutions

When using digital CIMs, you set the target's video resolution to match
your monitor's native display resolution. The native display resolution is
set when configuring ports for digital CIMs (see Configure the CIM
Target Settings).

Following is a complete list of KX Il supported video resolutions when
accessing a target from the remote console.

640x350@70Hz
640x350@85Hz
640x400@56Hz
640x400@84Hz
640x400@85Hz
640x480@60Hz
640x480@66.6Hz
640x480@72Hz
640x480@75Hz
640x480@85Hz
720x400@70Hz
720x400@84Hz
720x400@85Hz
800x600@56Hz
800x600@60HZz
800x600@70Hz
800x600@72Hz
800x600@75Hz
800x600@85Hz
800x600@90Hz
800x600@100Hz
832x624@75.1Hz
1024x768@60Hz
1024x768@70Hz
1024x768@72Hz
1024x768@85Hz
1024x768@75Hz
1024x768@90Hz
1024x768@100Hz

]
i
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1152x864@60Hz
1152x864@70Hz
1152x864@75Hz
1152x864@85Hz
1152x870@75.1Hz
1280x720@60Hz
1280x960@60Hz
1280x960@85Hz
1280x1024@60Hz
1280x1024@75Hz
1280x1024@85Hz
1360x768@60Hz
1366x768@60Hz
1368x768@60Hz
1400x1050@60Hz
1440x900@60Hz
1600x1200@60Hz
1680x1050@60Hz
1920x1080@60Hz

Appendix C: Specifications

1920x1200@60Hz (Requires Reduced Blanking Time)
For 1920x1200@60Hz, you must use a digital CIM and set the CIM’s

preferred resolution to 1920x1200@60Hz.
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KX 1l Supported Local Port DVI Resolutions

Following are the resolutions supported when connecting to a DVI
monitor from the KX Il local port.

e 1920x1080@60Hz
e 1280x720@60Hz
e 1024x768@60Hz (default)
o 1024x768@75Hz
e 1280x1024@60Hz
o 1280x1024@75Hz
e 1600x1200@60Hz
e  800x480@60Hz

e 1280x768@60Hz
e 1366x768@60Hz
e 1360x768@60Hz
e 1680x1050@60Hz
e  1440x900@60Hz

Target Server Video Resolution Supported Connection Distances
and Refresh Rates

The maximum supported distance is a function of many factors including
the type/quality of the Cat5 cable, server type and manufacturer, video
driver and monitor, environmental conditions, and user expectations.

The following table summarizes the maximum target server distance for
various video resolutions and refresh rates:

Target server video resolution Maximum distance
1024x768@60Hz (and below) 150' (45 m)
1280x1024@60Hz 100' (30 m)
1280x720@60Hz 75' (22 m)
1600x1200@60Hz 50' (15 m)
1920x1080@60Hz 50' (15 m)

See KX Il Supported Target Server Video Resolutions (on page 136)
for the video resolutions supported by the KX III.

Note: Due to the multiplicity of server manufacturers and types, OS
versions, video drivers, and so on, as well as the subjective nature of
video quality, Raritan cannot guarantee performance across all distances
in all environments.

== Raritan.
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Supported Computer Interface Module (CIMs) Specifications

Digital CIMs support Display Data Channels (DDC) and Enhanced Extended Display
Identification Data (E-EDID).

Note: Both plugs must be plugged in for the HDMI and DVI CIMs.

CIM model

D2CIM-DVUSB

D2CIM-VUSB

;

Raritan.

Description

Dual USB CIM for:

BIOS virtual media
Smartcard/CAC
Audio

Absolute Mouse
Synchronization

TR |

USB CIM for:

BIOS virtual media

Absolute Mouse
Synchronization

Dimensions
(WxDxH)

= 1.7"x35"x0.8" = 0.25Ib
= 43x90x19mm = 0.11kg

Weight

= 1.3"x3.0"x0.6" = 0.20lb
= 33x76x15mm = 0.09kg
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CIM model

140

D2CIM-DVUSB-DP

D2CIM-DVUSB-
HDMI

D2CIM-DVUSB-DVI

Description Dimensions Weight
(WxDxH)
Digital CIM that provides = 1.7"x35"x0.8" = 0.25Ib

digital-to-analog conversion = 43x90x19mm = 0.11kg
and support for:

=  BIOS virtual media
=  Smartcard/CAC
= Audio

= Absolute and Relative
Mouse Synchronization

TR |

Digital CIM that provides = 1.7"x35"x0.8" = 0.25Ib

digital-to-analog conversion = 43x90x19mm = 0.11kg
and support for:

=  BIOS virtual media
=  Smartcard/CAC
= Audio

= Absolute and Relative
Mouse Synchronization

Digital CIM that provides = 1.7"x35"x0.8" = 0.25Ib

digital-to-analog conversion = 43x90x19mm = 0.11kg
and support for:

=  BIOS virtual media
=  Smartcard/CAC
= Audio

= Absolute and Relative
Mouse Synchronization

]
i
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CIM model Description Dimensions Weight
(WxDxH)
DCIM-PS2 CIM for PS2 = 1.3"x3.0"x0.6" = 0.20lb
= 33x76x15mm = 0.09kg
DCIM-USBG2 CIM for USB and Sun USB = 1.3"x3.0"x0.6" = 0.20Ib
= 33x76x15mm = 0.09kg
Supported Digital Video CIMs for Mac
Use a digital video CIM to connect to the following Mac® ports:
Mac port CIM
DVI D2CIM-DVUSB-DVI
HDMI D2CIM-DVUSB-HDMI
DisplayPort or Thunderbolt D2CIM-DVUSB-DP
==R 1 141
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If the Mac’s HDMI or DisplayPort video has a mini connector, a passive
adapter cable may be required to connect to the full sized HDMI and
DisplayPort plugs on the digital CIMs.

Alternatively, use the Mac VGA adapter with the D2CIM-VUSB or
D2CIM-DVUSB. Note that this may be less reliable and the video quality
may suffer.

For information on established modes supported by the KX IIl 2.5.0 (and
later) for Mac, see Digital CIM Established and Standard Modes (on
page 142).

Digital CIM Timing Modes

Following are the default timing modes that are used when the KX 11|
communicates with a video source via a digital CIM.

The timing mode that is used is dependent on the native resolution of the
video source.

e 1024x768@60Hz
e 1152x864@60Hz
e 1280x720@60Hz
e 1280x960@60HZz
o 1280x1024@60Hz (default resolution applied to digital CIMs)
e 1360x768@60HZz
e 1400x1050@60Hz
e 1440x900@60Hz
e 1600x1200@60Hz
e 1680x1050@60Hz
e 1920x1080@60Hz
e 1920x1200@60Hz

See Configuring CIM Ports in online help for more information.

Digital CIM Established and Standard Modes

The following additional established and standard resolutions and timing
modes are supported by the KX III 3.0.0 (and later).

142
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Digital CIM Established Modes

e 720x400@70Hz IBM, VGA

e 640x480@60Hz IBM, VGA

e 640x480@67Hz Apple Mac® Il
e 640x480@72Hz VESA

e 640x480@75Hz VESA

e B800x600@56Hz VESA

e B800x600@60Hz VESA

e B800x600@72Hz VESA

e 800x600@75Hz VESA

e 832x624@75Hz Apple Mac
e 1024x768@60Hz VESA

e 1024x768@70Hz VESA

e 1024x768@75Hz VESA

e 1280x1024@75Hz VESA

e 1152x870@75Hz Apple Mac Il

Digital CIM Standard Modes

e 1152x864@75Hz VESA
e 1280x960@60Hz VESA
e 1280x1024@60Hz VESA
e 1360x768@60Hz VESA
e 1400x1050@60Hz VESA
e 1440x900@60Hz VESA
e 1600x1200 @60Hz VESA
e 1680x1050@60Hz VESA
e 1920x1080@60Hz VESA

DVI Compatibility Mode

DVI Compatibility Mode may be required if you are using an HDMI CIM
to connect to a Dell Optiplex target with an Intel video card, or a Mac®
Mini with an HDMI video port.

Selecting this mode ensures a good video quality from the targets.

See Configuring CIM Ports in online help.
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Supported Remote Connections

Remote
connection

Network

Protocols

Details

10BASE-T, 100BASE-T, and 1000BASE-T (Gigabit)

Ethernet

TCP/IP, UDP, SNTP, HTTP, HTTPS, RADIUS,
LDAP/LDAPS

Network Speed Settings

KX Il network speed setting

Network
switch port
setting

144

Auto
Auto
1000/Full
100/Full

100/Half
100/Half
10/Full

10/Half
10/Half

1000/Full 100/Full 100/Half
100/Half

No No
Communica | Communicat
tion ion

100/Half

No No No

Communica | Communica | Communicat

tion tion ion

No No No

Communica | Communica | Communicat

tion tion ion

10/Full 10/Half
10/Half

No No

Communica | Communicat

tion ion

No No

Communica | Communicat

tion ion

No No

Communica | Communicat

tion ion

=i=Raritan.
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Legend:

Does not function as expected

Supported

Functions; not recommended

NOT supported by Ethernet specification; product will

- communicate, but collisions will occur

Per Ethernet specification, these should be “no
communication,” however, note that the KX Il behavior
deviates from expected behavior

Raritan.

Note: For reliable network communication, configure the KX Ill and the
LAN switch to the same LAN Interface Speed and Duplex. For example,
configure the KX Il and LAN Switch to Autodetect (recommended), or
set both to a fixed speed/duplex such as 100MB/s/Full.

Dell Chassis Cable Lengths and Video Resolutions

In order to maintain video quality, Raritan recommends using the
following cable lengths and video resolutions when you are connecting to
Dell® blade chassis from the KX 11I:

Video resolution Cable length
1024x768@60Hz 50" (15.24 m)

1280x1024@60Hz  50' (15.24 m)
1600x1200@60Hz  30' (9.14 m)

Smart Card Minimum System Requirements

Local Port Requirements

The basic interoperability requirement for local port attachment to the KX
llis:

e All devices (smart card reader or token) that are locally attached
must be USB CCID-compliant.
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Target Server Requirements

When using smart card readers, the basic requirements for
interoperability at the target server are:

e The IFD (smart card reader) Handler must be a standard USB CCID
device driver (comparable to the generic Microsoft® USB CCID
driver).

e Adigital CIM or D2CIM-DVUSB (Dual-VM CIM) is required and must
be using firmware version 3A6E or later.

e Blade chassis server connections, where a CIM per blade is used,
are supported.

e Blade chassis server connections, where a CIM per chassis is used,
is only supported for IBM® BladeCenter® models H and E with auto-
discovery enabled.

Windows XP Targets

Windows XP® operating system targets must be running Windows XP
SP3in order to use smart cards with the KX III. If you are working with
.NET 3.5 in a Windows XP environment on the target server, you must
be using SP1.

Linux Targets

If you are using a Linux® target, the following requirements must be met
to use smart card readers with the Raritan device.

e CCID Requirements

If the Raritan D2CIM-DVUSB VM/CCID is not recognized as a smart
card reader by your Linux target, you may need to update the CCID
driver version to 1.3.8 or above and update the driver configuration
file (Info.plist).

Operating system CCID requirements
RHEL 5 ccid-1.3.8-1.el5
SuSE 11 pcsc-ccid-1.3.8-3.12
Fedora® Core 10 ccid-1.3.8-1.fc10.i386
146 /= -
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Remote Client Requirements

The basic requirements for interoperability at the remote client are:

e The IFD (smart card reader) Handler must be a PC/SC compliant
device driver.

e The ICC (smart card) Resource Manager must be available and be
PC/SC compliant.

e The JRE® Java™ 1.7 with smart card APl must be available for use by
the Raritan client application.

Remote Linux Client Requirements

If you are using a Linux® client, the following requirements must be met
to use smart card readers with the Raritan device.

Note: User login to client, on smart card insertion, may take longer when
1 or more KVM sessions are actively in place to targets. As the login
process to these targets is also under way.

e PC/SC Requirements

Operating system Required PC/SC

RHEL 5 pcsc-lite-1.4.4-0.1.el5

SuSE 11 pcsc-lite-1.4.102-1.24
Fedora® Core 10 pcsc-lite-1.4.102.3.fc10.i386

e Create a Java® Library Link

A soft link must be created to the libpcsclite.so after upgrading RHEL
4, RHEL 5 and FC 10. For example, In —s /usr/lib/libpcsclite.so.1
lusr/lib/libpesclite.so, assuming installing the package places the
libraries in /usr/lib or /user/local/lib

e PC/SC Daemon

When the pcsc daemon (resource manager in framework) is
restarted, restart the browser

Supported Smart Card Readers

Type Vendor Model Verified

USB SCM Microsystems SCR331 Verified on local and
remote

USB Activldentity® Actividentity USB Reader v2.0  Verified on local and
remote

Raritan.
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Type
usB

usB

usB

USB Keyboard/Card
reader combo

USB Keyboard/Card
reader combo

USB reader for SIM-
sized cards

Integrated (Dell
Latitude D620)

PCMCIA
PCMCIA

Vendor
SCM Microsystems

Activldentity

Gemalto®

Dell®

Cherry GmbH

Omnikey

O2Micro

Actividentity
SCM Microsystems

Model
SCR331

Actividentity USB Reader v3.0
GemPC USB-SW

USB Smart Card Reader
Keyboard

G83-6744 SmartBoard

6121

0OZ776

Actividentity PCMCIA Reader
SCR243

Verified

Verified on local and
remote

Verified on local and
remote

Verified on local and
remote

Verified on local and
remote

Verified on local and
remote

Verified on local and
remote

Remote only

Remote only

Remote only

Note: SCM Microsystems SCR331 smart card readers must be using
SCM Microsystems firmware v5.25.

Unsupported Smart Card Readers

This table contains a list of readers that Raritan has tested and found not
to work with the Raritan device, therefore they are unsupported.

If a smart card reader does not appear in the supported smart card
readers table or in the unsupported smart card readers table, Raritan
cannot guarantee it will function with the device.

Type

USB Keyboard/Card

reader Combo

USB Keyboard/Card

reader Combo

USB Token

Vendor Model

HP® ED707A

SCM SCR338

Microsystems

Aladdin® eToken
PRO™

—
==

Notes

No interrupt endpoint
=> not compatible with
Microsoft® driver

Proprietary card
reader implementation
(not CCID-compliant)

Proprietary
implementation

Raritan.
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Audio Playback and Capture Recommendations and Requirements

Audio Level
e Set the target audio level to a mid-range setting.

For example, on a Windows® client, set the audio to 50 or lower.
This setting must be configured through the playback or capture audio
device, not from the client audio device control.

Recommendations for Audio Connections when PC Share Mode is Enabled

If you are using the audio feature while running PC Share mode, audio
playback and capture are interrupted if an additional audio device is
connected to the target.

For example, User A connects a playback device to Targetl and runs an
audio playback application then User B connects a capture device to the
same target. User A's playback session is interrupted and the audio
application may need to be restarted.

The interruption occurs because the USB device needs to be re-
enumerated with the new device configuration.

It may take some time for the target to install a driver for the new device.

Audio applications may stop playback completely, go to the next track, or
just continue playing.

The exact behavior is dependent on how the audio application is
designed to handle a disconnect/reconnect event.

Bandwidth Requirements

The table below details the audio playback and capture bandwidth
requirements to transport audio under each of the selected formats.

Audio format Network bandwidth requirement
44.1 KHz, 16bit stereo 176 KB/s
44.1 KHz, 16bit mono 88.2 KB/s
2.05 KHz, 16bit stereo 88.2 KB/s
22.05 KHz, 16bit mono 44.1 KB/s

11.025 KHz, 16bit stereo 44.1 KB/s
11.025 KHz, 16bit mono Audio 22.05 KB/s
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In practice, the bandwidth used when an audio device connects to a
target is higher due to the keyboard and video data consumed when
opening and using an audio application on the target.

A general recommendation is to have at least a 1.5MB connection before
running playback and capture.

However, high video-content, full-color connections using high-target
screen resolutions consume much more bandwidth and impact the
quality of the audio considerably.

To help mitigate quality degeneration, there are a number of
recommended client settings that reduce the impact of video on audio
quality at lower bandwidths:

e Connect audio playback at the lower quality formats. The impact of
video consuming bandwidth is much less notable at 11k connections
than at 44k

e Set the connection speed under Connection Properties to a value
that best matches the client to server connection

e Under Connection Properties, set the color depth to as low a value
as possible. Reducing the color depth to 8 bit color considerably
reduces the bandwidth consumed

e Set Smoothing, to High. This will improve the appearance of the
target video by reducing displayed video noise

e Under Video settings, set the Noise Filter to its highest setting of 7
(highest value) so less bandwidth is used for target screen changes

Audio in a Mac Environment

Following are known issues in a Mac® environment.

e On Mac clients, only one playback device is listed on the Connect
Audio panel when accessing the device through the Virtual KVM
Client (VKC). The device listed is the default and is displayed on the
Connect Audio panel as Java Sound Audio Engine.

e Using audio on a Mac target through Skype® may cause the audio to
be corrupted.

Number of Supported Audio/Virtual Media and Smartcard
Connections

Following are the number of simultaneous Audio/Virtual Media and
Smartcard connections that can be made from a client to a target:

e 1 smartcard

e 1 virtual media

e 1 Smartcard and 1 virtual media
e 2 virtual media

150
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Certified Modems

USRobotics® 56K 5686E
ZOOM® v90

ZOOM v92

USRobotics Sportster® 56K
USRobotics Courier™ 56K

KX Il Supported Keyboard Languages

The KX 11l provides keyboard support for the languages listed in the
following table.

Note: You can use the keyboard for Chinese, Japanese, and Korean for
display only; local language input is not supported at this time for the KX
Il Local Console functions. For more information about non-US
keyboards, see Informational Notes (on page 159).

Note: Raritan strongly recommends that you use system-config-keyboard
to change languages if you are working in a Linux environment.

Language Regions
US English United States of America and

most of English-speaking
countries: for example, Canada,
Australia, and New Zealand.

US English United States of America and
International  most of English-speaking

countries: for example,
Netherlands

UK English United Kingdom

Chinese Hong Kong S. A. R., Republic of
Traditional China (Taiwan)

Chinese Mainland of the People’s
Simplified Republic of China

Korean South Korea

Japanese Japan

French France

German Germany and Austria

French Belgium

Norwegian Norway

Keyboard layout
US Keyboard layout

US Keyboard layout

UK layout keyboard

Chinese Traditional

Chinese Simplified

Dubeolsik Hangul
JIS Keyboard

French (AZERTY)
layout keyboard.

German keyboard
(QWERTZ layout)

Belgian

Norwegian
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Keystroke

Press C during
startup

Press D during
startup

Press Option-
Command-P-R until
you hear startup
sound a second
time.

Press Option
during startup

Press Eject, F12, or
hold the mouse

152

Language Regions Keyboard layout

Danish Denmark Danish

Swedish Sweden Swedish

Hungarian Hungary Hungarian

Slovenian Slovenia Slovenian

Italian Italy Italian

Spanish Spain and most Spanish Spanish
speaking countries

Portuguese Portugal Portuguese

Mac Mini BIOS Keystroke Commands

The following BIOS commands have been tested on Intel-based Mac®
Mini target servers and Mac Lion® servers running Mac Snow Leopard®.
The servers were attached to a KX Il with D2CIM-DVUSB and D2CIM-
VUSB CIMs. See below for the supported keys and any notes.

Description Virtual Media CIM Dual Virtual Mac Lion Server
Media CIM
HDMI CIM
Start up from a v v
bootable CD or DVD,
such as the Mac OS X
Install disc
Start up in Apple v v v

Hardware Test (AHT)
May need BIOS May need BIOS

Mac profile for the = Mac profile for
mouse to work mouse to work

May need BIOS
Mac profile for
the mouse to
work

Reset NVRAM v v
Start up in Startup v v v
Manager, where you

can select a Mac OS X

volume to start from

Ejects any removable v v

media, such as an

Raritan.
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Keystroke

button

Press N during
startup

Press T during
startup

Press Shift during
startup

Press Command-V
during startup

Press Command-S
during startup

Press Option-N
during startup

Press Command-R
during startup

Port
HTTP, Port 80

;
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Description Virtual Media CIM Dual Virtual Mac Lion Server
Media CIM
HDMI CIM
optical disc
Start up from a v v v

compatible network
server (NetBoot)

Start up in Target Disk v

mode

Start up in Safe Boot v v Known issue with

mode and temporarily LION to boot to

disable login items safe mode. "Safe
Mode" in red
does not appear
for Lion

Start up in Verbose v v v

mode.admin

Start up in Single-User ./ v v

mode

Start from a NetBoot v v v

server using the default

boot image

Start from Lion N/A N/A v

Recoveryl

Using a Windows Keyboard to Access Mac Targets

A Windows® keyboard can be used to access a Mac® connected to a KX
I1l. Windows keys are then used to emulate the special Mac keys. This is
the same as connecting a Windows keyboard directly to the Mac.

TCP and UDP Ports Used

Description
This port can be configured as needed. See HTTP and HTTPS Port
Settings.

By default, all requests received by the KX Il via HTTP (port 80) are
automatically forwarded to HTTPS for complete security.

The KX 1l responds to Port 80 for user convenience, relieving users
from having to explicitly type in the URL field to access the KX Ill, while
still preserving complete security.
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Port Description
HTTPS, Port 443 This port can be configured as needed. See HTTP and HTTPS Port
Settings.

By default, this port is used for multiple purposes, including the web
server for the HTML client, the download of client software (Virtual KVM
Client (VKC)) onto the client's host, and the transfer of KVM and virtual
media data streams to the client.

KX 1l (Raritan KVM- This port is used to discover other Dominion devices and for
over-IP) Protocaol, communication between Raritan devices and systems, including CC-
Configurable Port SG for devices that CC-SG management is available.

5000 By default, this is set to Port 5000, but you may configure it to use any

TCP port not currently in use. For details on how to configure this
setting, see Network Settings.

SNTP (Time Server) The KX Il offers the optional capability to synchronize its internal clock
on Configurable to a central time server.

UDP Port 123 This function requires the use of UDP Port 123 (the standard for

SNTP), but can also be configured to use any port of your designation.

Optional
LDAP/LDAPS on If the KX 1l is configured to remotely authenticate user logins via the
Configurable Ports  LDAP/LDAPS protocol, ports 389 or 636 will be used, but the system
389 or 636 can also be configured to use any port of your designation. Optional
RADIUS on If the KX 1l is configured to remotely authenticate user logins via the
Configurable Port RADIUS protocaol, either port 1812 will be used, but the system can also
1812 be configured to use any port of your designation. Optional

RADIUS Accounting If the KX Il is configured to remotely authenticate user logins via the

on Configurable Port RADIUS protocol, and also employs RADIUS accounting for event

1813 logging, port 1813 or an additional port of your designation will be used
to transfer log notifications.

SYSLOG on If the KX 1l is configured to send messages to a Syslog server, then the
Configurable UDP indicated port(s) will be used for communication - uses UDP Port 514.
Port 514

SNMP Default UDP  Port 161 is used for inbound/outbound read/write SNMP access and

Ports port 162 is used for outbound traffic for SNMP traps. Optional
TCP Port 22 Port 22 is used for the KX Ill command line interface (when you are
working with Raritan Technical Support).
SSH (Secure Shell) SSH port can be configured. The default is port 22.
154 ) /e @
=&=Raritan.



Appendix C: Specifications

Software

Supported Operating Systems, Browsers and Java Versions
Operating Systems Browsers Java
Windows 7° Home Premium SP1 64-bit Internet Explorer® 10, 11 Java” 1.7 up to
Windows 7 Ultimate SP1 64-bit Firefox® 29.0.1, 30 update 60
Windows 7 Ultimate 32-bit Chrome® 35
Windows 8° 64-bit Safari® 7.0.3, 7.0.5

Windows XP® Home Edition with SP 3
Windows Server 2012° Standard 64-bit
Windows Server 2008 ©

Windows Server 2003°

openSUSE® 11.4 Celadon (x86_64) Firefox 16.0.2
Fedora® 18 (Spherical Cow) Firefox 24
RHEL® 6.4 Firefox 21
Mac® OS X Mountain Lion® 10.7.5 Firefox 25
Safari 6.0.5
Mac OS X Mountain Lion 10.8.5 * Firefox 25
Safari 6.1.1
Solaris® 10 64-bit Firefox 3.6.23

*Note: Upon upgrading from OS X 10.8.2 to OS X 10.8.3, Safari® may
block Java™.
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JRE Requirements and Browser Considerations for Mac

Java Runtime Environment Requirements for Mac

Install Java Runtime Environment 7 (JRE)® on PCs and Macs® when
using the Virtual KVM Client (VKC) to access target servers via KX Il.

This ensures in order to provide high performance, KVM-over-IP video
processing when remotely accessing target servers/PCs/Macs.

The latest version of JRE for Mac can be downloaded from the Apple
Support website.

Browser Considerations for Mac

Java may be disabled by default in certain browsers. Enable Java and
accept all security warnings in order to use KX 111

Certain versions of Safari® block Java for security reasons. Since Java is
required to use KX lll, Raritan recommends you use Firefox® instead.

Additionally, you may be required to navigate through a number of
messages. Select ‘Do Not Block' if these messages are displayed.

Virtual KVM Client (VKC) and Active KVM Client (AKC)
Requirements

Microsoft .NET® 3.5 (or later) is required to use KX Il with the Microsoft
Windows®-based Active KVM Client (AKC).

Java™ 1.7 is required to use the Java-based .

KX Il checks your current Java version and prompts you to update it if it
is not compatible.

VKC can only be launched from a 32-bit browser, or 64-bit browser.

Following are the Java 32-bit and 64-bit Windows operating system
requirements.

Mode Operating system Browser

Windows x64  Windows XP® e Internet Explorer® 6.0

32-bit mode SP1+o0r7.0,9.0,10.0 or
11.0

e Firefox® 1.06 - 4 or later
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Mode Operating system
Windows Server 2003°

Windows Vista®

Windows 7¢

Windows x64  Windows XP
64-bit mode
Windows XP
Professional®

Windows XP Tablet®
Windows Vista
Windows Server 2003
Windows Server 2008
Windows 7

Appendix C: Specifications

Browser

Internet Explorer 6.0
SP1++, 9.0, 10.0 0r 11.0

e Firefox 1.06 - 3

e Internet Explorer 9.0,
10.0 0r 11.0

¢ Internet Explorer 9.0,
10.0 or 11.0

e Firefox 1.06 - 4 or later
64bit OS, 32bit browsers:

e Internet Explorer 6.0
SP1+,7.00r8.0

e Firefox 1.06 - 4 or later
64bit mode, 64bit browsers:

= Internet Explorer 7.0, 8.0,
9.0, 10.0 or 11.0

Note that a JRE™ plug-in is available for the Windows® 32-bit and 64-bit

operating systems.

See Java Runtime Environment (JRE) Notes (on page 159) for

additional information.

Multi-Language Keyboard JRE Requirement

In order for multi-language keyboards to work in the KX Il and Virtual
KVM Client (VKC), install the multi-language version of JRE™.
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Events Captured in the Audit Log and Syslog

Following is a list and description of the events that are captured by the
KX Il audit log and syslog:

e Access Login - A user has logged in to the KX III

e Access Logout - A user has logged out of the KX llI

e Active USB Profile - The USB profile is active

e CIM Connected - A CIM was connected

e CIM Disconnected - A CIM was disconnected

e Connection Lost - The connection to the target was lost

e Disconnected User - A user was disconnected from a port
e End CC Control - CC-SG management ended

e Login Failed - User login failed

e Password Changed - Password change occurred

e Port Connect - Port was connected

e Port Disconnect - Port was disconnected

e Port Status Change - Change in the port status

e Scan Started - A target scan was started

e Scan Stopped - A target scan was stopped

e Session Timeout - A session timeout occurred

¢ VM Image Connected - A VM image was connected

¢ VM Image Disconnected - A VM image was disconnected
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Informational Notes
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Overview

This section includes important notes on KX Il usage. Future updates
will be documented and available online through the Help link in the KX
Il Remote Console interface.

Note: Some topics in this section reference other multiple Raritan
devices because various devices are impacted by the information.

Java Runtime Environment (JRE) Notes

;

Raritan.

Disable Java Caching and Clear the Java Cache

It is highly recommended that you disable Java caching in Microsoft
Windows®, and clear the Java™ cache.

> To disable Java caching and clear the cache:
1. From the Windows Start menu, click Control Panel.

2. Double-click on the Java icon to launch it. The Java Control Panel
dialog appears.

3. Todisable Java caching:

a. From the General tab, click the Settings button. The Temporary
Files Settings dialog appears.
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b. Click the View Applets button. The Java Applet Cache Viewer
opens.

c. Deselect the Enable Caching checkbox if it is already checked.
d. Click OK.
4. To clear the Java cache:

a. From the Temporary Files Settings dialog, click the Delete Files
button. The Delete Temporary Files dialog appears.

b. Select the temporary files that you want to delete.
c. Click OK.

Java Not Loading Properly on Mac

If you are using a Mac® and see the following message when connecting
to a device from the KX Il Port Access Table, Java™ is not loaded

properly:
"Error while getting the list of open targets, please try again in a few
seconds".

If this occurs, check your Java installation from this website:
http://www.java.com/en/download/testjava.jsp
http://www.java.com/en/download/testjava.jsp

If your Java applet is inactive, it can be enabled from this page. If it is not
installed correctly, a message lets you know and you can then reinstall
Java.

160
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IPv6 Support Notes
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Operating System IPv6 Support Notes

Java
Java™ 1.7 supports IPv6 for the following:

e Solaris™ 10 (and later)
e Linux® kernel 2.1.2 (and later)/RedHat 6.1 (and later)
e Solaris 10 (and later)

e Windows XP® SP1 and Windows 2003®, Windows Vista® and
Windows 7 operating systems

The following IPv6 configurations are not supported by Java:
e J2SE does not support IPv6 on Microsoft® Windows"®.

Linux
e Itis recommended that Linux kernel 2.4.0 or higher is used when
using IPV6.

e An IPv6-enabled kernel will need to be installed or the kernel will
need to be rebuilt with IPv6 options enabled.

e Several network utilities will also need to be installed for Linux when
using IPv6. For detailed information, refer to
http://www.bieringer.de/linux/IPv6/IPv6-HOWTO/IPv6-HOWTO.html

Windows
e Windows XP and Windows 2003 users will need to install the
Microsoft IPv6 service pack to enable IPv6.

e For AKC with IPv6 on Windows XP, add the executable kxgui.exe to
your firewall exception list. View your log file on the client to identify
the full path for the location of the file kxgui.exe.

Samba
e IPv6 is not supported for use with virtual media when using Samba.

AKC Download Server Certification Validation IPv6 Support Notes

If you are connecting to a KX Il standalone device and support for AKC
download server certificate validation is enabled, the valid IPv6 format to
generate the certificate is either:

e CN =[fd07:02fa:6cff:2500:020d:5dff:£fe00:01c0] when
there is a leading 0

or

e CN =[fd07:02fa:6cff:2500:020d4:5dff:0000:01c0] when
there is no zero compression
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Dual Stack Login Performance Issues

If you are using the KX Il in a dual stack configuration, it is important you
configured the domain system (DNS) correctly in the KX 1l in order to
avoid delays when logging in.

See Tips for Adding a Web Browser Interface for information on
configuring your DNS in KX III.

CIM Notes

162

Windows 3-Button Mouse on Linux Targets

When using a 3-button mouse on a Windows"® client connecting to a
Linux® target, the left mouse button may get mapped to the center button
of the Windows client 3-button mouse.
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Windows 2000 Composite USB Device Behavior for Virtual Media

The Windows 2000° operating system does not support USB composite
devices, like Raritan’s D2CIM-VUSB, in the same manner as non-
composite USB devices.

As a result, the “Safely Remove Hardware” system tray icon does not
appear for drives mapped by the D2CIM-VUSB and a warning message
may appear when disconnecting the device. Raritan has not observed
any problems or issues from this message, however.

Raritan’s US engineering department has developed a configuration
which supports the “Safely Remove Hardware” icon and avoids this
Windows message. This configuration requires the use of the D2CIM-
DVUSB virtual media adapter and the Troubleshooting 3 USB Profile that
configures the D2CIM-DVUSB as a non-composite USB device
supporting a single virtual media connection. Raritan has successfully
tested this configuration in the US and Japan.

Connection BESRZGIEE Keyboard Video Mouse Tools View Yirtual Media Help &

== ;”% 1} ® Generic g
A ~ | HP Proliant DL360/DL380 G4 (HP SmartStart CD) |
Other Profiles Linux

””””””””””””””””” Mac 05-% {10.4.9 and later)
helonUsBralles HP Proliant DL360/DL380 G4 (Windows 2003 Server Installation)
BIOS IBM Thinkcentre Lenovo
RUBY Industrial Mainboard {(AwardBIOS)
BIOS Dell PowerEdge Keyboard Only
Supermicro Mainboard {Phoenix AwardBIOS)
SuSE Linux 9.2
BIOS Mac
BIOS Lenovo ThinkPad T61 and X61
BIOS HP Compaq DC7100/DC7600
Use Full Speed for Virtual Media CIM
BIOS Generic
Troubleshooting 1
Troubleshooting 2

Troubleshooting 3
BIOS HP Proliant DL145
BIOS Dell PowerEdge 1950{2950/2970/6950{R200
BIOS Dell Optiplex Keyboard Only

BIOS Asus P4C800 Motherboard
16M BladeCenter H with AMM
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Target Server Video Picture Not Centered (Mouse Out of Synch)
At certain resolutions when using an HDMI or DVI CIM with the KX I1I:

e The video display may not be centered properly - black rectangles
can be seen at the edges of the screen

e The mouse on the target may appear to be slightly out of synch

If either or both of these occur, you may be able to correct this by
adjusting the display scaling options from the target computer’s video
controller software.

For example, if your target computer uses the Catalyst Control Center
video controller, adjust the Underscan/Overscan setting as needed.

Virtual Media Notes

Cannot Connect to Drives from Linux Clients

If you cannot connect to a virtual media drive on a target server when
you connect from a client running Linux® Fedora™ 18 with Java™ 1.7
(update 45 and later), disable SELinux in Fedora 18 on the client to
resolve the problem.

Cannot Write To/From a File from a Mac Client

If you are connecting to the KX Il from a Mac® 10.8.5 client running
Safari® 6.1 with Java™ 1.7 and cannot write to/from a file on a target
server or access virtual media, do the following to correct this:

1. In Safari, select Preferences.
Under the Security tab, select Manage Website Settings.
Click on "Website for KX3".

Select "Run in unsafe mode" from the drop-down.

a H~ DN

Restart Safari.
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Virtual Media via VKC and AKC in a Windows Environment

Windows XP® operating system administrator and standard user
privileges vary from those of the Windows Vista® operating system and
the Windows 7° operating system.

When enabled in Vista or Windows 7, User Access Control (UAC)
provides the lowest level of rights and privileges a user needs for an
application. For example, a Run as Administrator option is provided for
Internet Explorer® for Administrator level tasks; otherwise these are not
accessible even though the user has an Administrator login.

Both features affect the types of virtual media that can be accessed by
users via Virtual KVM Client (VKC) and Active KVM Client (AKC). See
your Microsoft® help for additional information on these features and how
to use them.

Following is a list virtual media types users can access via VKC and AKC
when running in a Windows environment. The features are broken down
by client and the virtual media features that are accessible to each
Windows user role.

Windows XP

If you are running VKC and AKC in a Windows XP environment, users
must have Administrator privileges to access any virtual media type other
than CD-ROM connections, ISOs and ISO images.

Windows Vista and Windows 7

If you are running VKC and AKC in a Windows Vista or Windows 7
environment and UAC is enabled, the following virtual media types can
be accessed depending on the user's Windows role:

Client Administrator Standard User
AKC and Access to: Access to:
VKC

Fixed drives and fixed Removable drives

drive partitions e CD/DVD drives
e Removable drives

e CD/DVD drives
e [SO images

e |SOimages
¢ Remote ISO images

¢ Remote ISO images
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Virtual Media Support on Windows 7, Windows 2008 and Windows
XP Targets

Virtual media is not supported on a Windows 7, Windows 2008 or
Windows XP target server when connecting via VKC and AKC from
Windows 2008 or Windows 2012.

Virtual Media Not Refreshed After Files Added

After a virtual media drive has been mounted, if you add a file(s) to that
drive, those files may not be immediately visible on the target server.
Disconnect and then reconnect the virtual media connection.

Virtual Media Linux Drive Listed Twice

For KX 1lI, users who are logged in to Linux™ clients as root users, the
drives are listed twice in the Local Drive drop-down.

For example, you will see eg /dev/sdc and eg /dev/sdcl where the first
drive is the boot sector and the second drive is the first partition on the
disk.

Accessing Virtual Media on a Windows 2000

A virtual media local drive cannot be accessed on a Windows 2000°
server using a D2CIM-VUSB.

Disconnecting Mac and Linux Virtual Media USB Drives
In a Linux® or Mac® environment:

e For Linux users, if there is /dev/sdb and /dev/sdb1, the client only
uses /dev/sdbl and advertise it as removable disk

e /dev/sdb is not available for the user.

e For Linux users, if there is /dev/sdb but no /dev/sdbl, /dev/sdb is
used as a removable device

e For Mac users, /dev/diskl and /dev/disk1sl is used

Target BIOS Boot Time with Virtual Media

The BIOS for certain targets may take longer to boot if media is mounted
virtually at the target.

» To shorten the boot time:

1. Close the Virtual KVM Client to completely release the virtual media
drives.
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2. Restart the target.

Virtual Media Connection Failures Using High Speed for Virtual
Media Connections

Under certain circumstances it may be necessary to select the "Use Full
Speed for Virtual Media CIM" when a target has problems with "High
Speed USB" connections or when the target is experiencing USB
protocol errors caused by signal degradation due to additional
connectors and cables (for example, a connection to a blade server via a
dongle).

USB Port and Profile Notes

;
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VM-CIMs and DL360 USB Ports

HP® DL360 servers have one USB port on the back of the device and
another on the front of the device. With the DL360, both ports cannot be
used at the same time. Therefore, a dual VM-CIM cannot be used on
DL360 servers.

However, as a workaround, a USB2 hub can be attached to the USB port
on the back of the device and a dual VM-CIM can be attached to the
hub.

Help Choosing USB Profiles

When you are connected to a KVM target server via the Virtual KVM
Client (VKC), you can view information about USB profiles via the Help
on USB Profiles command on the USB Profile menu.

v HP Proliant DLIGO/OL3A0 G4 (HP SmartStart O

Generic

Troubleshooting 1
Trouhleshooting 2
Trouhleshooting 3

Add Other Profiles »

Help on LISE Profiles
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USB profile help appears in the USB Profile Help window. For detailed
information about specific USB profiles, see Available USB Profiles.

Raritan provides a standard selection of USB configuration profiles for a
wide range of operating system and BIOS level server implementations.
These are intended to provide an optimal match between remote USB
device and target server configurations.

The ‘Generic’ profile meets the needs of most commonly deployed target
server configurations.

Additional profiles are made available to meet the specific needs of other
commonly deployed server configurations (for example, Linux®, Mac OS
X®).

There are also a number of profiles (designated by platform name and
BIOS revision) that have been tailored to enhance the virtual media
function compatibility with the target server, for example, when operating
at the BIOS level.

‘Add Other Profiles’ provides access to other profiles available on the
system. Profiles selected from this list will be added to the USB Profile
Menu. This includes a set of ‘trouble-shooting’ profiles intended to help
identify configuration limitations.

The USB Profile Menu selections are configurable via the Console
Device Settings > Port Configuration page.

Should none of the standard USB profiles provided by Raritan meet your
target server requirements, Raritan Technical Support can work with you
to arrive at a solution tailored for that target. Raritan recommends that
you do the following:

1. Check the most recent release notes on the Raritan website
(www.raritan.com) on the Firmware Upgrade page to see if a solution
is already available for your configuration.

2. If not, please provide the following information when contacting
Raritan Technical Support:

a. Target server information, manufacturer, model, BIOS,
manufacturer, and version.

b. The intended use (e.g. redirecting an image to reload a server’s
operating system from CD).
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Changing a USB Profile when Using a Smart Card Reader

There may be certain circumstances under which you will need to
change the USB profile for a target server. For example, you may need
to change the connection speed to "Use Full Speed for Virtual Media
CIM" when the target has problems with the "High Speed USB"
connection speed.

When a profile is changed, you may receive a New Hardware Detected
message and be required to log in to the target with administrative
privileges to reinstall the USB driver. This is only likely to occur the first
few times the target sees the new settings for the USB device. Afterward,
the target will select the driver correctly.

Video Mode and Resolution Notes

Video Image Appears Dark when Using a Mac

If you are using a Mac® with an HDMI video port and the video seems too
dark, enable DVI Compatibility Mode on the CIM to help resolve the
issue.

See Configuring CIM Ports

Video Shrinks after Adjusting Target Clock

On HP® Proliant® DL380p G8 target servers, certain resolutions cause
the target video to shrink. This is caused when the server's clock
attempts to auto-adjust and detects the wrong active line length.

Depending on the resolution the target is set to, this occurs when
connecting to the HP target from the KX 1ll Remote Console or Local
Port, or both the Remote Console and Local Port. This issue was
detected at the following resolutions:

Target resolution Issue seen on Issue seen from
Local Port Remote Console
1440x900@60Hz Yes Yes
1400x1050@60Hz No Yes
1152x864@60Hz  No Yes

169

;

Raritan.



Appendix D: Informational Notes

Black Stripe/Bar(s) Displayed on the Local Port

Certain servers and video resolutions may display on the local port with
small black bars at the edge of the screen.

If this occurs:

1. Try a different resolution, or

2. If using a digital CIM, then change the Display Native Resolution on
the Port Configuration page to another resolution, or

3. [If using the HDMI CIM, use the DVI Compatibility Mode.

Contact Raritan Technical Support for additional assistance.

Sun Composite Synch Video

Sun™ composite synch video is not supported.

SUSE/VESA Video Modes

The SuSE X.org configuration tool SaX2 generates video modes using
modeline entries in the X.org configuration file. These video modes do
not correspond exactly with VESA video mode timing (even when a
VESA monitor is selected). The KX 1, on the other hand, relies on exact
VESA mode timing for proper synchronization. This disparity can result in
black borders, missing sections of the picture, and noise.

> To configure the SUSE video display:

The generated configuration file /etc/X11/xorg.conf includes a
Monitor section with an option named UseModes. For example,
UseModes "Modes[0]"

2. Either comment out this line (using #) or delete it completely.
3. Restart the X server.

With this change, the internal video mode timing from the X server is
used and corresponds exactly with the VESA video mode timing,
resulting in the proper video display on the KX III.
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Keyboard Notes
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French Keyboard

Caret Symbol (Linux Clients Only)

The Virtual KVM Client (VKC) do not process the key combination of Alt
Gr + 9 as the caret symbol (") when using French keyboards with Linux®
clients.

» To obtain the caret symbol:

From a French keyboard, press the ” key (to the right of the P key), then
immediately press the space bar.

Alternatively, create a macro consisting of the following commands:
1. Press Right Alt

2. Press 9.

3. Release 9.

4. Release Right Alt.

Note: These procedures do not apply to the circumflex accent (above
vowels). In all cases, the ” key (to the right of the P key) works on French
keyboards to create the circumflex accent when used in combination with
another character.

Accent Symbol (Windows XP Operating System Clients Only)

From the Virtual KVM Client (VKC), the key combination of Alt Gr + 7
results in the accented character displaying twice when using French
keyboards with Windows XP® clients.

Note: This does not occur with Linux® clients.

Numeric Keypad

From the Virtual KVM Client (VKC), the numeric keypad symbols display
as follows when using a French keyboard:

Numeric Displays
keypad as
symbol

/ ;
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Tilde Symbol

From the Virtual KVM Client (VKC), the key combination of Alt Gr + 2
does not produce the tilde (~) symbol when using a French keyboard.

> To obtain the tilde symbol:

Create a macro consisting of the following commands:
e Pressright Alt

e Press?2

e Release 2

o Release right Alt

Keyboard Language Preference (Fedora Linux Clients)

Because the Sun™ JRE™ on Linux® has problems generating the correct
KeyEvents for foreign-language keyboards configured using System
Preferences, Raritan recommends that you configure foreign keyboards
using the methods described in the following table.

Language Configuration method

us Intl Default

UK System Settings (Control Center)
French Keyboard Indicator

German Keyboard Indicator

Hungarian System Settings (Control Center)
Spanish System Settings (Control Center)

Swiss-German  System Settings (Control Center)

Norwegian Keyboard Indicator
Swedish Keyboard Indicator
Danish Keyboard Indicator
Japanese System Settings (Control Center)
Korean System Settings (Control Center)
Slovenian System Settings (Control Center)
Italian System Settings (Control Center)
Portuguese System Settings (Control Center)
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Note: The Keyboard Indicator should be used on Linux systems using
Gnome as a desktop environment.

When using a Hungarian keyboard from a Linux client, the Latin letter U
with Double Acute and the Latin letter O with Double Acute work only
with JRE 1.6 (and later).

There are several methods that can be used to set the keyboard
language preference on Fedora® Linux clients. The following method
must be used in order for the keys to be mapped correctly from the
Virtual KVM Client (VKC).

To set the keyboard language using System Settings:
From the toolbar, choose System > Preferences > Keyboard.
Open the Layouts tab.

Add or select the appropriate language.

Click Close.

Eal A

v

To set the keyboard language using the Keyboard Indicator:
1. Right-click the Task Bar and choose Add to Panel.

2. Inthe Add to Panel dialog, right-click the Keyboard Indicator and
from the menu choose Open Keyboard Preferences.

In the Keyboard Preferences dialog, click the Layouts tab.

4. Add and remove languages as necessary.

Macros Not Saving on Linux Target Servers

If you receive the following error message when you create and then
save a macro on a target server running Linux® Fedora™ 18 with Java™
1.7.0 (update 45 and later), disable SELinux in Fedora 18 on the target
server to resolve the problem.

"An error occurred attempting to write the new
keyboard macros. Macro was not added"
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Mac Keyboard Keys Not Supported for Remote Access

When a Mac® is used as the client, the following keys on the Mac®
keyboard are not captured by the Java™ Runtime Environment (JRE™):

e F9

e F10
e Fl1
e Fl4
e FI15

e Volume Up

e Volume Down
e Mute

e Eject

As a result, the Virtual KVM Client (VKC) are unable to process these
keys from a Mac client's keyboard.

174

Mouse Notes

Mouse Pointer Synchronization (Fedora)

When connected in dual mouse mode to a target server running Fedora®
7, if the target and local mouse pointers lose synchronization, changing
the mouse mode from or to Intelligent or Standard may improve
synchronization.

Single mouse mode may also provide for better control.

> Toresynchronize the mouse cursors:

e Use the Synchronize Mouse option from the Virtual KVM Client
(VKQ).

Single Mouse Mode when Connecting to a Target Under CC-SG
Control

When using Firefox® to connect to a KX Il target under CC-SG control
using DCIM-PS2 or DCIM-USBG?Z2, if you change to Single Mouse Mode
in the Virtual KVM Client (VKC), the VKC window will no longer be the
focus window and the mouse will not respond.

If this occurs, left click on the mouse or press Alt+Tab to return the focus
to the VKC window.
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Audio
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Audio Playback and Capture Issues

Features that May Interrupt an Audio Connection

If you use any of the following features while connected to an audio
device, your audio connection may be interrupted. Raritan recommends
you do not use these features if you are connected to an audio device:

e Video Auto-Sense
e Extensive use of the local port
e Adding users

Issues when Using a Capture Device and Playback Device
Simultaneously on a Target

On some targets, the simultaneous connection of capture devices and
playback devices may not work due to the USB hub controller and how it
manages the USB ports. Consider selecting an audio format that
requires less bandwidth.

If this does not resolve the issue, connect the D2CIM-DVUSB CIM's
keyboard and mouse connector to a different port on the target. If this
does not solve the problem, connect the device to a USB hub and
connect the hub to the target.

Audio in a Linux Environment

The following are known issues when using the audio feature in a Linux®
environment.

e Linux® users, use the default audio device for playback. Sound may
not come through if a non-default sound card is selected.

e SuSE 11 clients require Javas_1 6_0-sun-alsa (ALSA support for
java-1_6_0-sun) to be installed via YAST.

e For Logitech® headsets with a built in a mic, only the Mono Capture
option is available.

e In order to display the device, if you are running SUSE 11 and an
ALSA driver, log out of KX I, then log back in.

Additionally, if you connect and disconnect the audio device a
number of times, the device may be listed several times vs. just once
as it should.

e Using the audio feature with a Fedora Core® 13 target set to mono
16 bit, 44k may cause considerable interference during playback.
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Audio in a Windows Environment

On Windows® 64-bit clients, only one playback device is listed on the
Connect Audio panel when accessing the device through the Virtual
KVM Client (VKC).

The audio device is the default device, and is listed on the Connect
Audio panel as Java Sound Audio Engine.

Smart Card Notes

Virtual KVM Client (VKC) Smart Card Connections to Fedora
Servers

If you are using a smart card to connect to a Linux® Fedora® server via
Virtual KVM Client (VKC) upgrade the pcsc-lite library to 1.4.102-3 or
above.

CC-SG Notes

Virtual KVM Client Version Not Known from CC-SG Proxy Mode

When the Virtual KVM Client (VKC) is launched from CommandCenter
Secure Gateway (CC-SG) in proxy mode, the VKC version is unknown.

In the About Raritan Virtual KVM Client dialog, the version is displayed
as “Version Unknown”.

Moving Between Ports on a Device

If you move a between ports on the same Raritan device and resume
management within one minute, CC-SG may display an error message.

If you resume management, the display will be updated.

Browser Notes

Resolving Issues with Firefox Freezing when Using Fedora

If you are accessing Firefox® and are using a Fedora® server, Firefox
may freeze when it is opening.

To resolve this issue, install the libnpjp2.so Java™ plug-in on the server.
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Appendix E: Frequently Asked Questions

Question
What is Dominion KX I1?

How is KX III different from KX II ?

Answer

Dominion KX Il is a third-generation digital
KVM (keyboard, video, mouse) switch that
enables one, two, four or eight IT
administrators to access and control 8, 16, 32
or 64 servers over the network with BIOS-level
functionality. Dominion KX IIl is completely
hardware- and OS-independent; users can
troubleshoot and reconfigure servers even
when servers are down.

At the rack, Dominion KX Il provides the same
functionality, convenience, and space and cost
savings as traditional analog KVM switches.
However, Dominion KX IIl also integrates the
industry’s highest performing KVM-over-1P
technology, allowing multiple administrators to
access server KVM consoles from any
networked workstation as well as from the
iPhone® and iPad®.

The KX Ill is the next generation version of the
KX Il. Featuring a modern hardware design
with increased computing power and storage,
the KX Il provides KVM-over-IP access for IT
administration, as well as high performance IP
access for broadcast applications. KX llI
includes virtually all KX Il features with the
following advancements:

The KX IllI's new video processing engine
supports a broad range of applications from
traditional computer applications to the most
dynamic broadcast applications requiring 30
frames-per-second 1920x1080 video, 24 bit
color, digital audio, dual monitors and DVI,
HDMI, DisplayPort and VGA video.

With the industry’s first DVI-based local port,
the KX lllI's common user interface provides
new levels of productivity and performance for
at-the-rack administration and server access.

All KX 1l models feature a tiering port to
connect multiple Dominion KX Il switches
together and access the attached servers. Up
to 1024 servers can be accessed via a
consolidated port list.

KX 11l supports all Dominion and Paragon Il
CIMs supported by KX II.
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Question

How does Dominion KX 11l differ
from remote control software?

Can the Dominion KX Il be rack

mounted?

How large is the Dominion KX 111?

Appendix E: Frequently Asked Questions

Answer

When using Dominion KX Il remotely, the
interface, at first glance, may seem similar to
remote control software such as pcAnywhere™,
Windows® Terminal Services/Remote Desktop,
VNC, etc. However, because Dominion KX IlI
is not a software but a hardware solution, it's
much more powerful:

Hardware- and OS-independent — Dominion
KX 1l can be used to manage servers running
many popular OSs, including Intel®, Sun®,
PowerPC running Windows, Linux®, Solaris™,
etc.

State-independent/Agentless — Dominion KX
IIKX 1l does not require the managed server
OS to be up and running, nor does it require
any special software to be installed on the
managed server.

Out-of-band — Even if the managed server’s
own network connection is unavailable, it can
still be managed through Dominion KX III.

BIOS-level access — Even if the server is hung
at boot up, requires booting to safe mode, or
requires system BIOS parameters to be
altered, Dominion KX 111 still works flawlessly to
enable these configurations to be made.

Yes. The Dominion KX Il ships standard with
19" rack mount brackets. It can also be reverse
rack mounted so the server ports face forward.

Dominion KX 11l is only 1U high (except the
KX3-864 and KX3-464, which are 2U), fits in a
standard 19" rack mount and is only 11.4" (29
cm) deep. The Dominion KX3-832 and KX3-
864 are 13.8" (36 cm) deep.

Remote Access

;
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Question

How many users can remotely
access servers on each Dominion
KX 111?

Can | remotely access servers
from my iPhone or iPad?

Can two people look at the same
server at the same time?

Can two people access the same
server, one remotely and one from
the local port?

In order to access Dominion KX Il
from a client, what hardware,
software or network configuration
is required?

Answer

Dominion KX Il models offer remote
connections for up to eight users per user
channel to simultaneously access and control a
unique target server. For one-channel devices
like the DKX3-116, up to eight remote users
can access and control a single target server.
For two-channel devices, like the DKX3-216,
up to eight users can access and control the
server on channel one and up to another eight
users on channel two. For four-channel
devices, up to eight users per channel, for a
total of 32 (8 x 4) users, can access and
control four servers. Likewise, for the eight-
channel devices, up to eight users can access
a single server, up to an overall maximum of
32 users across the eight channels.

Yes. Users can access servers connected to
the KX Il using their iPhone or iPad.

Mobile access is provided through Mobile
Access Client, which requires the use of
CommandCenter Secure Gateway (CC-SG).

Yes. Actually, up to eight people can access
and control any single server at the same time.

Yes. The local port is completely independent
of the remote "ports.” The local port can
access the same server using the PC-Share
feature.

Because Dominion KX Il is completely Web-
accessible, it doesn’t require customers to
install proprietary software on clients used for
access.

Dominion KX Il can be accessed through
major Web browsers, including: Internet
Explorer® and Firefox®. Dominion KX Il can be
accessed on Windows®, Linux® and Mac®
desktops, via Raritan’s Windows Client, and
the Java™-based Virtual KVM Client™.

Dominion KX Il administrators can also
perform remote management (set passwords
and security, rename servers, change IP
address, etc.) using a convenient browser-
based interface.



Question

What is the file size of the applet
that’s used to access Dominion KX
1117 How long does it take to

retrieve?

Do you have a Windows KVM

Client?

Do you have a non-Windows KVM

Client?

Do your KVM Clients have multi-

language support?

Do your KVM Clients support dual

LCD monitors?

;
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Answer

The Virtual KVM Client (VKC) applet used to
access Dominion KX Il is approximately 500KB
in size. The following chart describes the time
required to retrieve Dominion KX III’s applet at
different network speeds:

100Mbps Theoretical .05 seconds
100Mbit network
speed

60Mbps Likely practical .08 seconds
100Mbit network
speed

10Mbps Theoretical 10Mbit .4 seconds
network speed

6Mbps Likely practical .8 seconds
10Mbit network
speed

512Kbps Cable modem 8 seconds
download speed

(typical)

Yes. We have a native .NET Windows Client
called the Raritan Active KVM Client (AKC).
See Active KVM Client (AKC) Help (on page
84)

Yes. The Virtual KVM Client (VKC) allows non-
Windows users to connect to target servers in
the data center. See Virtual KVM Client
(VKC) Help (on page 38)

Yes. The Dominion KX lII’'s remote HTML User
Interface and the KVM Clients support the
Japanese, Simplified Chinese and Traditional
Chinese languages. This is available stand-
alone as well as through CC-SG.

Yes. For customers wishing to enhance their
productivity by using multiple LCD monitors on
their desktops, the Dominion KX Il can launch
KVM sessions to multiple monitors, either in full
screen or standard modes.
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Question Answer
Do you support servers with dual  Yes, dual video cards are supported with an
video cards? extended desktop configuration available to the

remote user.

How do | access servers You can access servers at the rack or via
connected to Dominion KX Il if the modem.
network ever becomes

unavailable? Dominion KX Il offers a dedicated modem port

for attaching an external modem.

Universal Virtual Media

Question Answer
Which Dominion KX Ill models All Dominion KX Il models support virtual
support virtual media? media. It is available stand-alone and through

CommandCenter® Secure Gateway, Raritan’s
centralized management appliance.

Which types of virtual media does  Dominion KX Il supports the following types of

the Dominion KX Il support? media: internal and USB-connected CD/DVD
drives, USB mass storage devices, PC hard
drives and ISO images.
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Question
What is required for virtual media?

Is virtual media secure?

Does virtual media really support
audio?

What is a USB profile?
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Answer

A Dominion KX Il virtual media CIM is required.
There are two VGA-based CIMs: a D2CIM-
VUSB or D2CIM-DVUSB.

The D2CIM-VUSB has a single USB connector
and is for customers who will use virtual media
at the OS level.

The D2CIM-DVUSB has dual USB connectors
and should be purchased by customers who
wish to utilize virtual media at the BIOS level.
The D2CIM-DVUSB is also required for smart
card authentication, tiering/cascading and digital
audio.

Both support virtual media sessions to target
servers supporting the USB 2.0 interface.
Available in economical 32 and 64 quantity CIM
packages, these CIMs support Absolute Mouse
Synchronization™ as well as remote firmware
updates.

Our CIMs have traditionally supported analog
VGA video. Three new dual virtual media CIMs
support digital video formats, including DVI,
HDMI and DisplayPort. These are the D2CIM-
DVUSB-DVI, D2CIM-DVUSB-HDMI and
D2CIM-DVUSB-DP.

Yes. Virtual media sessions are secured using
256-bit AES, 128-bit AES or 128-bit RC4
encryption.

Yes. Audio playback and recording to a server
connected to the Dominion KX 1l is supported.
You can listen to sounds and audio playing on a
remote server in the data center using the
speakers connected to your desktop PC or
laptop. You can also record on the remote
server using a microphone connected to your
PC or laptop. A digital CIM or D2CIM-DVUSB
dual virtual media CIM is required.

Certain servers require a specifically configured
USB interface for USB-based services such as
virtual media. The USB profile tailors the KX lII's
USB interface to the server to accommodate
these server-specific characteristics.
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Question Answer

Why would | use a USB profile? USB profiles are most often required at the
BIOS level where there may not be full support
for the USB specification when accessing virtual
media drives. However, profiles are sometimes
used at the OS level, for example, for mouse
synchronization for Mac and Linux servers.

How is a USB profile used? Individual ports or groups of ports can be
configured by the administrator to use a specific
USB profile in the KX III's port configuration
page. A USB profile can also be selected in the
KX Il Client when required. See the user guide
for more information.

Do | always need to set a USB No. In many cases, the default USB profile is

profile when | use virtual media? sufficient when using virtual media at the OS
level or operating at the BIOS level without
accessing virtual media.

What profiles are available? Where Consult the user guide for the available profiles
can | find more information? and for more information.

Bandwidth and KVM-over-IP Performance
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Question

How is bandwidth used in KVM-

over-IP systems?

How does bandwidth affect K\VM-

over-1P performance?

i
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Answer

Dominion KX Il offers totally new video
processing that provides flexible, high
performance video, efficient use of bandwidth
and anytime/anywhere access via LAN, WAN
or Internet.

The Dominion KX Il digitizes, compresses and
encrypts the keyboard, video and mouse
signals from the target server and transmits IP
packets over the IP network to the remote
client to create the remote session to the user.
The KX Il provides an at-the-rack experience
based on its industry-leading video processing
algorithms.

Screen changes, i.e., video accounts for the
majority of the bandwidth used — and keyboard
and mouse activity are significantly less.

It is important to note that bandwidth is only
used when the user is active. The amount of
bandwidth used is based on the amount of

change to the server’s video display screen.

If there are no changes to the video — the user
is not interacting with the server — there is
generally little to no bandwidth used. If the user
moves the mouse or types a character, then
there is a small amount of bandwidth used. If
the display is running a complex screen saver
or playing a video, then there can be a larger
amount of bandwidth used.

In general, there is a trade-off between
bandwidth and performance. The more
bandwidth available, the better performance
can be. In limited bandwidth environments,
performance can degrade. The Dominion KX Il
has been optimized to provide strong
performance in a wide variety of environments.
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Question Answer

What factors affect bandwidth? There are many factors that determine how
much bandwidth will be used. The primary
factor, noted above, is the amount of change in
the target server’s video display. This is
dependent on the user’s task and actions.

Other factors include the server’s video
resolution, networking speed and
characteristics, the KVM Client Connection
Properties, client PC resources and video card

noise.
How much bandwidth does KX Ill  Bandwidth primarily depends on the user’s task
use for common tasks? and actions. The more the server’s video
screen changes, the more bandwidth is
utilized.
186 —= Voo
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Question

How do | optimize performance

and bandwidth?

| want to connect over the Internet.
What type of performance should |

expect?

| have a high bandwidth
environment. How can | optimize

performance?
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Answer

KX 1l provides a variety of settings in our
remote clients for the user to optimize
bandwidth and performance. The default
settings will provide an at-the-rack level of
performance in standard LAN/WAN
environments with economical use of
bandwidth.

Optimize For. Use this setting to configure the
video engine for standard IT/computer
applications or for video/broadcast
applications.

Compression. Move the slider to the left for
the highest possible video quality and to the
right for the least amount of bandwidth.

Noise Filter. In most cases, the default setting
will work best, however you can move to the
left for more responsive video and to the right
for lower bandwidth.

Other tips to decrease bandwidth include:

= Use a solid desktop background instead of
a complex image

= Disable screensavers

= Use a lower video resolution on the target
server

= Uncheck the "Show window contents while
dragging" option in Windows

= Use simple images, themes and desktops
(e.g., Windows Classic)

It depends on the bandwidth and latency of the
Internet connection between your remote client
and the KX IIl. With a cable modem or high
speed DSL connection, your performance can
be very similar to a LAN/WAN connection. For
lower speed links, use the suggestions above
to improve performance.

The default settings will work well. You can
move the Connection Properties settings to the
left for increased video performance.
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Question

Answer

What is the maximum remote (over The Dominion KX Il is the first and only KVM-
IP) video resolution supported? over-1P switch to support full high definition

(HD) remote video resolution — 1920x1080 at
frame rates up to 30 frames per second with
digital audio.

In addition, popular widescreen formats are
supported, including 1600x1200, 1680x1050
and 1440x900, so remote users can work with
today’s higher resolution monitors.

How much bandwidth is used for It depends on the type of audio format used,

audio?

What about servers with DVI
ports?

but to listen to CD quality audio, approximately
1.5 Mbps is used.

Servers with DVI ports that support DVI-A
(analog) and DVI-I (integrated analog and
digital) can use Raritan’s ADVI-VGA
inexpensive, passive adapter to convert the
server’s DVI port to a VGA plug that can be
connected to a KX Il CIM’s VGA plug.

Servers with DVI ports that support DVI-I or
DVI-D (digital) can use the new D2CIM-
DVUSB-DVI CIM.

IPv6 Networking

Question
What is IPv6?

188

Answer

IPVv6 is the acronym for Internet Protocol Version 6.
IPV6 is the "next generation" IP protocol which will
replace the current IP Version 4 (IPv4) protocol.

IPv6 addresses a number of problems in IPv4, such
as the limited number of IPv4 addresses. It also
improves IPv4 in areas such as routing and network
auto-configuration. IPv6 is expected to gradually
replace IPv4, with the two coexisting for a number of
years.

IPv6 treats one of the largest headaches of an IP
network from the administrator’s point of view —
configuring and maintaining an IP network.
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Question

Why does KX Ill support IPv6

networking?

What is "dual stack" and why

is it required?

How do | enable IPv6 on the

KX 111?

What if | have an external
server with an IPv6 address
that | want to use with my KX

"

What if my network doesn'’t

support IPv6?

Where can | get more
information on IPv6?

Appendix E: Frequently Asked Questions

Answer

U.S. government agencies and the Department of
Defense are now mandated to purchase IPv6-
compatible products. In addition, many enterprises
and foreign countries, such as China, will be
transitioning to IPv6 over the next several years.

Dual stack is the ability to simultaneously support
IPv4 and IPv6 protocols. Given the gradual transition
from IPv4 to IPv6, dual stack is a fundamental
requirement for IPv6 support.

Use the "Network Settings" page, available from the
"Device Settings" tab. Enable IPv6 addressing and
choose manual or auto-configuration. Consult the
user guide for more information.

The KX Il can access external servers via their IPv6
addresses, for example, an SNMP manager, syslog
server or LDAP server.

Using the KX III's dual-stack architecture, these
external servers can be accessed via: (1) an IPv4
address, (2) IPv6 address or (3) hostname. So, the
KX Il supports the mixed IPv4/IPv6 environment
many customers will have.

The KX lII’s default networking is set at the factory for
IPv4 only. When you are ready to use IPv6, then
follow the above instructions to enable IPv4/IPv6
dual-stack operation.

See www.ipv6.org for general information on IPv6.
The KX Il user guide describes the KX III's support
for IPv6.

Servers

Question
Does Dominion KX Il depend on a Absolutely not. Because users depend on the

Windows server to operate?

;
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Answer

KVM infrastructure to always be available in
any scenario whatsoever (as they will likely
need to use the KVM infrastructure to fix
problems), Dominion KX Il is designed to be
completely independent from any external
server.
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Question Answer

What should | do to prepare a Set the mouse parameter options to provide

server for connection to Dominion  users with the best mouse synchronization and

KX 117? turn off screensavers and any power
management features that affect screen
display.

What about mouse In the past, KVM-over-IP mouse

synchronization? synchronization was a frustrating experience.

The Dominion KX III's Absolute Mouse
Synchronization provides for a tightly
synchronized mouse without requiring server
mouse setting changes on Windows and
Apple® Mac servers. For other servers, the
Intelligent Mouse mode or the speedy, single
mouse mode can be used to avoid changing
the server mouse settings.

What comes in the Dominion KX Ill The following is included: (1) Dominion KX IlI

box? unit, (2) Quick Setup Guide, (3) standard 19"
rack mount brackets, (4) user manual CD-
ROM, (6) localized AC line cord and (7)
warranty certificate and other documentation.

Blade Servers

Question Answer

Can | connect blade servers to the Yes. Dominion KX Il supports popular blade

Dominion KX 1117? server models from the leading blade server
manufacturers: HP®, IBM®, Dell® and Cisco®.

Which blade servers are The following models are supported: Dell

supported? PowerEdge® 1855, 1955 and M1000e; HP

BladeSystem ¢3000 and c7000; IBM
BladeCenter® H, E and S; and Cisco UCS B-
Series.

Which CIM should | use? It depends on the type of KVM ports on the
specific make and model of the blade server
you are using. The following CIMs are
supported: DCIM-PS2, DCIM-USBG2, D2CIM-
VUSB and D2CIM-DVUSB.

Which types of access and control The Dominion KX Il provides automated and

are available? secure KVM access: (1) at the rack, (2)
remotely over IP, (3) via CommandCenter and
(4) by modem.
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Question

Do | have to use hotkeys to switch

between blades?

Can | access the blade server’s

management module?

How many blade servers can |
connect to a Dominion KX 111?

I’m an enterprise customer using
CommandCenter Secure Gateway.
Can | access blade servers via
CommandCenter Secure

Gateway?

What if | also want in-band or
embedded KVM access?

I’'m running VMware® on some of
my blade servers. Is this

supported?

Is virtual media supported?
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Answer

Some blade servers require you to use hotkeys
to switch between blades. With the Dominion
KX llIl, you don’t have to use these hotkeys.
Just click on the name of the blade server, and
the Dominion KX Il will automatically switch to
that blade without the explicit use of the
hotkey.

Yes. You can define the URL of the
management module and access it from the
Dominion KX Il or from our CommandCenter
Secure Gateway. If configured, one-click
access is available.

For performance and reliability reasons, you
can connect up to eight blade chassis to a
Dominion KX 1ll, regardless of model. Raritan
recommends connecting up to two times the
number of remote connections supported by
the device. For example, with a KX3-216 with
two remote channels, we recommend
connecting up to four blade server chassis.
You can, of course, connect individual servers
to the remaining server ports.

Yes. Once blade servers are configured on the
Dominion KX IIl, the CommandCenter Secure
Gateway user can access them via KVM
connections. In addition, the blade servers are
organized by chassis as well as
CommandCenter Secure Gateway custom
views.

In-band and embedded access to blade
servers can be configured within
CommandCenter Secure Gateway.

Yes. With CommandCenter Secure Gateway,
you can display and access virtual machines
running on blade servers.

This depends on the blade server. HP blades
can support virtual media. The IBM
BladeCenter (except for BladeCenter T)
supports virtual media if configured
appropriately. A virtual media CIM — D2CIM-
VUSB or D2CIM-DVUSB — must be used.
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Question

Is Absolute Mouse
Synchronization supported?

Is blade access secure?

Does the Dominion KSX Il or the
KX 111-101 support blade servers?

Answer

Servers with internal KVM switches inside the
blade chassis typically do not support absolute
mouse technology. For HP blade and some
Dell blade servers, a CIM can be connected to
each blade, so Absolute Mouse
Synchronization is supported.

Yes. Blade access uses all of the standard
Dominion KX Il security features such as 128-
bit or 256-bit encryption. In addition, there are
blade-specific security features such as per
blade access permissions and hotkey-blocking
that eliminates unauthorized access.

At this time, these products do not support
blade servers.

Installation

Question

Besides the unit itself, what do |
need to order from Raritan to
install Dominion KX I11?

Which kind of Cat5 cabling should
be used in my installation?

Which types of servers and PCs

can be connected to Dominion KX
1?2

How do | connect servers to
Dominion KX [11?

192

Answer

Each server that connects to Dominion KX IlI
requires a Dominion or Paragon computer
interface module (CIM), an adapter that
connects directly to the keyboard, video and
mouse ports of the server.

Dominion KX Il can use any standard UTP
(unshielded twisted pair) cabling, whether
Catb, Cat5e or Cat6. Often in our manuals and
marketing literature, Raritan will simply say
"Cat5" cabling for short. In actuality, any brand
UTP cable will suffice for Dominion KX IlI.

Dominion KX Il is completely vendor
independent. Any server with standards-
compliant keyboard, video and mouse ports
can be connected. In addition, servers with
serial ports can be controlled using the P2CIM-
SER CIM.

Servers that connect to the Dominion KX Il
require a Dominion or Paragon CIM, which
connects directly to the keyboard, video and
mouse ports of the server. Then, connect each
CIM to Dominion KX Il using standard UTP
(unshielded twisted pair) cable such as Cat5,
Cat5e or Cat6.
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Question

How far can my servers be from
Dominion KX 111?

Some operating systems lock up
when | disconnect a keyboard or
mouse during operation. What
prevents servers connected to
Dominion KX 11l from locking up
when | switch away from them?

Are there any agents
that must be installed on servers
connected to Dominion KX I11?

How many servers can be
connected to each Dominion KX I
unit?

What happens if | disconnect a
server from Dominion KX Il and
reconnect it to another Dominion
KX Il unit, or connectitto a
different port on the same
Dominion KX Il unit?

;

Raritan.
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Answer

In general, servers can be up to 150 feet (45
m) away from Dominion KX Ill, depending on
the type of server. (See Target Server Video
Resolution Supported Connection
Distances and Refresh Rates (on page 138))
For the D2CIM-VUSB CIMs that supports
virtual media and Absolute Mouse
Synchronization, a 100-foot (30 m) range is
recommended.

Each Dominion computer interface module
(DCIM) dongle acts as a virtual keyboard and
mouse to the server to which it is connected.
This technology is called KME
(keyboard/mouse emulation). Raritan’s KME
technology is data center grade, battle-tested
and far more reliable than that found in lower-
end KVM switches: it incorporates more than
15 years of experience and has been deployed
to millions of servers worldwide.

Servers connected to Dominion KX Il do not
require any software agents to be installed
because Dominion KX Il connects directly via
hardware to the servers’ keyboard, video and
mouse ports.

Dominion KX Il models range from 8, 16 or 32
server ports in a 1U chassis, to 64 server ports
in a 2U chassis. This is the industry’s highest
digital KVM switch port density.

Dominion KX Il will automatically update the
server port names when servers are moved
from port to port. Furthermore, this automatic
update does not just affect the local access
port, but propagates to all remote clients and
the optional CommandCenter Secure Gateway
management appliance.
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Question

How do | connect a serially
controlled (RS-232) device, such
as a Ciscorouter/switch or a
headless Sun server, to Dominion
KX 1117?

Answer

If there are only a few serially controlled
devices, they may be connected to a Dominion
KX Il using Raritan’s P2CIM-SER serial
converter.

Customers can also consider deploying the
Dominion KSX I, an integrated KVM and serial
switch. The DKSX-144 features four KVM-
over-IP ports and four serial ports.

The DKSX-188 features eight KVM-over-I1P
ports and eight serial ports.

However, if there are many serially controlled
devices, we recommend the use of Raritan’s
Dominion SX line of secure console servers.
Dominion SX offers more serial functionality at
a better price point than Dominion KX III. This
SX is easy to use, configure and manage, and
can be completely integrated with a Dominion
series deployment.
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Local Port - KX 11l

Question

Can | access my servers directly
from the rack?

Can | consolidate the local ports of
multiple KX IlIs?

When | am using the local port, do
| prevent other users from
accessing servers remotely?

Answer

Yes. At the rack, Dominion KX III functions just
like a traditional KVM switch — allowing control
of up to 64 servers using a single keyboard,
monitor and mouse. You can switch between
servers by the browser- based user interface or
via a hotkey.

Yes. You can connect the local ports of multiple
KX Il switches to another KX Il using the
"tiering" feature of the KX lll. You can then
access the servers connected to your KX llI
devices from a single point in the data center via
a consolidated port list.

No. The Dominion KX Il local port has a
completely independent access path to the
servers. This means a user can access servers
locally at the rack — without compromising the
number of users that access the rack remotely
at the same time.

]
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Question

Can | use a USB keyboard or
mouse at the local port?

Is there an onscreen display
(OSD) for local, at-the-rack
access?

How do | select between servers
while using the local port?

How do | ensure that only
authorized users can access
servers from the local port?

Appendix E: Frequently Asked Questions

Answer

Yes. The Dominion KX Il has USB keyboard
and mouse ports on the local port. Dominion KX
11l switches do not have PS/2 local ports.
Customers with PS/2 keyboards and mice
should utilize a PS/2 to USB adapter.

Yes, but Dominion KX III's at-the-rack access
goes way beyond conventional OSDs. Featuring
the industry’s first browser-based interface for
at-the-rack access, Dominion KX III's local port
uses the same interface for local and remote
access. Moreover, most administrative functions
are available at the rack.

The local port displays the connected servers
using the same user interface as the remote
client. Users connect to a server with a simple
click of the mouse or via a hotkey.

Users attempting to use the local port must pass
the same level of authentication as those
accessing remotely. This means that:

If the Dominion KX Il is configured to interact
with an external RADIUS, LDAP or Active
Directory” server, users attempting to access
the local port will authenticate against the same
server.

If the external authentication servers are
unavailable, Dominion KX Il fails over to its own
internal authentication database.

Dominion KX Il has its own stand-alone
authentication, enabling instant, out-of-the-box
installation.

Extended Local Port

;
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Question
What is the extended local port?

Answer

The Dominion KX2-808, KX2-832 and KX2-864
featured an extended local port. The
corresponding Dominion KX Il models do not
have an extended local port. Instead all KX IlI
models have a tiering port.

To extend the KX IlI's digital local port, you can
use the Raritan Cat5 Reach DVI product for
local and remote access up to 500 meters.

See Connecting a KX Il and Cat5 Reach DVI
- Provide Extended Local Port Functionality
(on page 122)

Dual Power Supplies

Question

Does Dominion KX Il have a dual
power option?

Does the power supply used by
Dominion KX Ill automatically
detect voltage settings?

If a power supply or input fails, will
| be notified?

Answer

Yes. All Dominion KX 1l models come equipped
with dual AC inputs and power supplies with
automatic failover. Should one of the power
inputs or power supplies fail, then the KX IIl will
automatically switch to the other.

Yes. Dominion KX III’'s power supply can be
used in AC voltage ranges from 100-240 volts,
at 50-60 Hz.

The Dominion KX Il front panel LED will notify
the user of a power failure. An entry will also be
sent to the audit log and displayed on the KX
remote client user interface. If configured by the
administrator, then SNMP or syslog events will
be generated.

Intelligent Power Distribution Unit (PDU) Control

Question

What type of remote power control
capabilities does Dominion KX IlI
offer?
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Answer

Raritan’s intelligent PDUs can be connected to
the Dominion KX Il to provide power control of
target servers and other equipment. For
servers, after a simple one-time configuration
step, just click on the server name to power on,
off or to recycle a hung server.

—
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Question

What type of power strips does
Dominion KX Il support?

How many PDUs can be
connected to a Dominion KX [1?

How do | connect the PDU to the

Dominion KX [11?

Does Dominion KX Il support
servers with multiple power

supplies?

Does the Dominion KX Il display
statistics and measurements from

the PDU?

Does remote power control require
any special configuration of

attached servers?

What happens when | recycle

power to a server?

Appendix E: Frequently Asked Questions

Answer

Raritan’s Dominion PX™ and Remote Power
Control (RPC) power strips.

These come in many outlet, connector and
amp variations. Note that you should not
connect the PM series of power strips to the
Dominion KX Il as these power strips do not
provide outlet-level switching.

Up to eight PDUs can be connected to a
Dominion KX Il device.

The D2CIM-PWR is used to connect the power
strip to the Dominion KX Ill. The D2CIM-PWR
must be purchased separately; it does not
come with the PDU.

Yes. Dominion KX III can be easily configured
to support servers with multiple power supplies
connected to multiple power strips. Four power
supplies can be connected per target server.

Yes. PDU-level power statistics, including
power, current and voltage, are retrieved from
the PDU and displayed to the user.

Some servers ship with default BIOS settings
such that the server does not automatically
restart after losing and regaining power. For
these servers, see the server’s documentation
to change this setting.

Note that this is the physical equivalent of
unplugging the server from the AC power line,
and reinserting the plug.

Ethernet and IP Networking

Question

What is the speed of Dominion KX
III's Ethernet interfaces?

;

Raritan.

Answer

Dominion KX Il supports gigabit as well as
10/100 Ethernet. KX Il supports two
10/100/1000 speed Ethernet interfaces, with
configurable speed and duplex settings (either
auto detected or manually set).
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Question

Can | access Dominion
KX Il over a wireless connection?

Does the Dominion KX Il offer
dual gigabit Ethernet ports to
provide redundant failover or load
balancing?

Can | use Dominion KX III with a
VPN?

Can | use KX 11l with a proxy
server?

How many TCP ports must be
open on my firewall in order to
enable network access to
Dominion KX [lI?

Are these ports configurable?

Can Dominion KX IIl be used with
Citrix®?

Can the Dominion KX IIl use
DHCP?

198

Answer

Yes. Dominion KX Il not only uses standard
Ethernet, but also very conservative bandwidth
with very high quality video. Thus, if a wireless
client has network connectivity to a Dominion
KX 111, servers can be configured and managed
at the BIOS level wirelessly.

Yes. Dominion KX Il features dual gigabit
Ethernet ports to provide redundant failover
capabilities. Should the primary Ethernet port
(or the switch/router to which it is connected)
fail, Dominion KX Il will failover to the
secondary network port with the same IP
address — ensuring that server operations are
not disrupted. Note that automatic failover must
be enabled by the administrator.

Yes. Dominion KX Il uses standard Internet
Protocol (IP) technologies from Layer 1 through
Layer 4. Traffic can be easily tunneled through
standard VPNSs.

Yes. KX Il can be used with a SOCKS proxy
server, assuming the remote client PC is
configured appropriately. Contact the user
documentation or online help for more
information.

Two ports are required: TCP port 5000 to
discover other Dominion devices and for
communication between Raritan devices and
CC-SG; and, of course, port 443 for HTTPS
communication.

Yes. Dominion KX III’'s TCP ports are
configurable by the administrator.

Dominion KX Il may work with remote access
products like Citrix if configured appropriately,
but Raritan cannot guarantee it will work with
acceptable performance. Customers should
realize that products like Citrix utilize video
redirection technologies similar in concept to
digital KVM switches so that two KVM-over-1P
technologies are being used simultaneously.

DHCP addressing can be used; however,
Raritan recommends fixed addressing since the
Dominion KX Il is an infrastructure device and
can be accessed and administered more
effectively with a fixed IP address.
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Question

I’'m having problems connecting to
the Dominion KX Il over my IP
network. What could be the

problem?

Appendix E: Frequently Asked Questions

Answer

The Dominion KX Il relies on your LAN/WAN
network. Some possible problems include:

Ethernet auto-negotiation. On some networks,
10/100 auto-negotiation does not work properly,
and the Dominion KX IIl unit must be set to 100
Mb/full duplex or the appropriate choice for its
network.

Duplicate IP address. If the IP address of the
Dominion KX IlI

is the same as another device, network
connectivity may be inconsistent.

Port 5000 conflicts. If another device is using
port 5000, the Dominion KX III default port must
be changed (or the other device must be
changed).

When changing the IP address of a Dominion
KX 1lI, or swapping in a new Dominion KX 111,
sufficient time must be allowed for its IP and
Mac® addresses to be known throughout the
Layer 2 and Layer 3 networks.

Local Port Consolidation, Tiering and Cascading

;
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Question

How do | physically connect
multiple Dominion KX Ill devices
together into one solution?

Answer

To physically connect multiple KX 11l devices
together for consolidated local access, you can
connect the Tiering ports of multiple "tiered" (or
"cascaded") KX Il switches to a "base" KX llI
using the Tiering port of the KX IIl. You can
then access the servers connected to your KX
11l devices from a single point in the data center
via a consolidated port list.

The Tiering port must be used to connect the
tiered KX Il switch to the base switch.

Access via the consolidated port list is
available in the data center or even from a
remote PC. All servers connected to the tiered
KX Ills can be accessed via a hierarchical port
list or via search (with wildcards).

Two levels of tiering are supported; up to 1024
devices can be accessed in a tiered
configuration. Remote power control is also
supported.

Virtual media, smart card and blade server
access via tiered access will be supported in a
future release. Of course these features are
available when accessed via a standard
remote connection.

While remote IP server access via the
consolidated port list is available as a
convenience, remote accessing a tiered server
from CommandCenter or via the KX Ill the
server is connected to, is recommended for
optimal performance.
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Question Answer

Do | have to physically connect Multiple Dominion KX Il units do not need to

Dominion KX Il devices together?  be physically connected together. Instead,
each Dominion KX Il unit connects to the
network, and they automatically work together
as a single solution if deployed with Raritan’s
CommandCenter Secure Gateway (CC-SG)
management appliance.

CC-SG acts as a single access point for
remote access and management.

CC-SG offers a significant set of convenient
tools, such as consolidated configuration,
consolidated firmware update and a single
authentication and authorization database.

Customers using CC-SG for centralized remote
access can make good use of the KX IIlI's
tiering (cascading) feature to consolidate the
local ports of multiple KX Il switches and
locally access up to 1024 servers from a single
console when in the data center.

Is CC-SG required? For customers wanting stand-alone usage
(without a central management system),
multiple Dominion KX Il units still interoperate
and scale together via the IP network. Multiple
Dominion KX Il switches can be accessed
from the KX Il Web-based user interface.

Can | connect an existing analog Yes. Analog KVM switches can be connected

KVM switch to Dominion KX [117? to one of Dominion KX III’s server ports. Simply
use a USB computer interface module (CIM),
and attach it to the user ports of the existing
analog KVM switch.
Analog KVM switches supporting hotkey-based
switching on their local ports can be tiered to a
Dominion KX 11l switch and switched via a
consolidated port list, both remotely and in the
data center.

Please note that analog KVM switches vary in
their specifications and Raritan cannot
guarantee the interoperability of any particular
third-party analog KVM switch. Contact Raritan
technical support for further information.

Computer Interface Modules (CIMs)

Raritan.

;
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Question Answer
What type of video is supported by Our CIMs have traditionally supported analog
your CIMs? VGA video. Three new CIMs support digital

video formats, including DVI, HDMI and
DisplayPort. These are the D2CIM-DVUSB-
DVI, D2CIM-DVUSB-HDMI and D2CIM-

DVUSB-DP.
Can | use computer interface Yes. Certain Paragon computer interface
modules (CIMs) from Paragon, modules (CIMs) may work with Dominion KX
Raritan’s analog matrix KVM IIKX 1lIl. (Please check the Raritan Dominion
switch, with Dominion KX 111? KX Ill Release Notes on the website for the

latest list of certified CIMs.)

However, because Paragon CIMs cost more
than Dominion KX Il CIMs (as they incorporate
technology for video transmission of up to
1,000 feet [304 m]), it is not generally advisable
to purchase Paragon CIMs for use with
Dominion KX Il Also note that when
connected to Dominion KX Ill, Paragon CIMs
transmit video at a distance of up to 150 feet
(46 m), the same as Dominion KX Il CIMs —
not at 1,000 feet (304 m), as they do when
connected to Paragon.

Does Dominion KX Ill support Yes. The Dominion KX Il supports Paragon Il

Paragon Dual CIMs? Dual CIMs (P2CIM-APS2DUAL and P2CIM-
AUSBDUAL), which can connect servers in the
data center to two different Dominion KX Il
switches.

If one KX Il switch is not available, the server
can be accessed through the second KX I
switch, providing redundant access and
doubling the level of remote KVM access.

Please note these are Paragon CIMs, so they
do not support the KX Il advanced features
such as virtual media, absolute mouse, audio,
etc.

Security
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Question

Is the Dominion KX Ill FIPS 140-2
Certified?

What kind of encryption does
Dominion KX IIl use?

Does Dominion KX Il support AES
encryption as recommended by
the U.S. government’s NIST and
FIPS standards?

Does Dominion KX Il allow
encryption of video data? Or does
it only encrypt keyboard and
mouse data?

How does Dominion KX IlI
integrate with external
authentication servers such as
Active Directory, RADIUS or
LDAP?

How are usernames and
passwords stored?

;

Raritan.
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Answer

The Dominion KX Il uses an embedded FIPS
140-2 validated cryptographic module running
on a Linux platform per FIPS 140-2
implementation guidelines. This cryptographic
module is used for encryption of KVM session
traffic consisting of video, keyboard, mouse,
virtual media and smart card data.

Dominion KX Il uses industry-standard (and
extremely secure) 256-bit AES, 128-bit AES or
128-bit encryption, both in its SSL
communications as well as its own data
stream. Literally no data is transmitted between
remote clients and Dominion KX 1l that is not
completely secured by encryption.

Yes. The Dominion KX Il utilizes the Advanced
Encryption Standard (AES) for added security.
256-bit and 128-bit AES is available.

AES is a U.S. government-approved
cryptographic algorithm that is recommended
by the National Institute of Standards and
Technology (NIST) in the FIPS Standard 197.

Unlike competing solutions, which only encrypt
keyboard and mouse data, Dominion KX 111
does not compromise security — it allows
encryption of keyboard, mouse, video and
virtual media data.

Through a very simple configuration, Dominion
KX 11l can be set to forward all authentication
requests to an external server such as LDAP,
Active Directory or RADIUS. For each
authenticated user, Dominion KX Ill receives
from the authentication server the user group
to which that user belongs. Dominion KX Il
then determines the user’s access permissions
depending on the user group to which he or
she belongs.

Should Dominion KX III’s internal
authentication capabilities be used, all
sensitive information, such as usernames and
passwords, is stored in an encrypted format.
Literally no one, including Raritan technical
support or product engineering departments,
can retrieve those usernames and passwords.
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Question

Does Dominion KX Il support
strong passwords?

Can | upload my own digital
certificate to the Dominion KX IIKX
12

Does the KX Il support a
configurable security banner?

My security policy does not allow
the use of standard TCP port
numbers. Can | change them?

Answer

Yes. The Dominion KX Il has administrator-
configurable, strong password checking to
ensure that user-created passwords meet
corporate and/or government standards and
are resistant to brute force hacking.

Yes. Customers can upload self-signed or
certificate authority-provided digital certificates
to the Dominion KX Il for enhanced
authentication and secure communication.

Yes. For government, military and other
security-conscious customers requiring a
security message before user login, the KX 111
can display a user-configurable banner
message and optionally require acceptance.

Yes. For customers wishing to avoid the
standard TCP/IP port numbers to increase
security, the Dominion KX III allows the
administrator to configure alternate port
numbers.
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Smart Cards and CAC Authentication

Question

Does Dominion KX Il support smart
card and CAC authentication?

What is CAC?

Which KX Ill models support smart
cards/CAC?

Answer

Yes. Smart cards and DoD common access
cards (CAC) authentication to target servers
is supported.

Mandated by Homeland Security
Presidential Directive 12 (HSPD-12), CAC is
a type of smart card created by the U.S.
government and used by U.S. military and
government staff. The CAC card is a
multitechnology, multipurpose card; the goal
is to have a single identification card. For
more information, see the FIPS 201
standards.

All Dominion KX Ill models are supported.
The Dominion KX [11-101 models do not
currently support smart cards and CAC.

Do enterprise and SMB customers use Yes. However, the most aggressive

smart cards, too?

deployment of smart cards is in the U.S.
federal government.
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Question

Which CIMs support
smart card/CAC?

Which smart card readers are
supported?

Can smart card/CAC authentication
work on the local port and via
CommandCenter?

Appendix E: Frequently Asked Questions

Answer

The D2CIM-DVUSB, D2CIM-DVUSB-DVI,
D2CIM-DVUSB-HDMI and D2CIM-DVUSB-
DP are the required CIMs.

The required reader standards are USB
CCID and PC/SC. Consult the user
documentation for a list of certified readers
and more information.

Yes. Smart card/CAC authentication works
on both the local port and via
CommandCenter. For the local port,
connect a compatible smart card reader to
the USB port of the Dominion KX I11.

Manageability

Question

Can Dominion KX IIl be remotely
managed and configured via Web
browser?

Can | back up and restore
Dominion KX III's configuration?

What auditing or logging does
Dominion KX Il offer?

;
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Answer

Yes. Dominion KX Ill can be completely
configured remotely via Web browser. Note
that this does require that the workstation have
an appropriate Java Runtime Environment
(JRE) version installed. Besides the initial
setting of Dominion KX III's IP address,
everything about the solution can be
completely set up over the network. (In fact,
using a crossover Ethernet cable and
Dominion KX III’s default IP address, you can
even configure the initial settings via Web
browser.)

Yes. Dominion KX III’s device and user
configurations can be completely backed up for
later restoration in the event of a catastrophe.

Dominion KX III's backup and restore
functionality can be used remotely over the
network, or through your Web browser.

For complete accountability, Dominion KX IlI
logs all major user events with a date and time
stamp. For instance, reported events include
(but are not limited to): user login, user logout,
user access of a particular server,
unsuccessful login, configuration changes, etc.
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Question

Can Dominion KX Il integrate with
syslog?

Can Dominion KX Il integrate with
SNMP?

Can an administrator log-off a
user?

Can Dominion KX III’'s internal
clock be synchronized with a
timeserver?

Answer

Yes. In addition to Dominion KX III’s own
internal logging capabilities, Dominion KX III
can send all logged events to a centralized
syslog server.

Yes. In addition to Dominion KX III’'s own
internal logging capabilities, Dominion KX Il
can send SNMP traps to SNMP management
systems. SNMP v2 and v3 are supported.

Yes, administrators can view which users are
logged into which ports and can log-off a user
from a specific port or from the device if
required.

Yes. Dominion KX Il supports the industry-
standard NTP protocol for synchronization with
either a corporate timeserver, or with any
public timeserver (assuming that outbound
NTP requests are allowed through the
corporate firewall).
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Documentation and Support

Question
Is online help available?

Where do | find documentation on
the Dominion KX 111?

What documentation is available?

Answer

Yes. Online help is available from the KX 111
user interface, and at raritan.com with the
documentation.

Online help includes KX Il administration and
end user information on using the Remote
Console, Virtual KVM Client (VKC) Active KVM
Client (AKC) and Local Console, as well KX 1lI
specifications, informational notes, using KX Il
with Paragon I, connecting KX Il to the Cat5
Reach DVI, connecting KX IlI to the T1700-
LED, and so on.

The documentation is available at raritan.com.
The documentation is listed by firmware
release.

A Quick Setup Guide, online help, a PDF
version of the help in the form of an
Administrators Guide and a Users Guide, as
well as Release Notes and other information
are available.
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Question

What CIM should | use for a

parti

How long is the hardware warranty

cular server?

Appendix E: Frequently Asked Questions

Answer

Consult the CIM Guide available with the KX Il

documentation. Note that DVI, HDMI and

DisplayPort video standards are supported with

the digital video CIMs.

The Dominion KX Il comes with a standard

for the KX 11I? two-year warranty, which can be extended to 5
years of warranty coverage.

Miscellaneous

Question Answer

What is Dominion KX IlI's default

|P address?

What is Dominion KX lII's default
username and password?

I changed and subsequently forgot
Dominion KX III's administrative
password; can you retrieve it for

me?

;

Raritan.

192.168.0.192

The Dominion KX III's default username and
password are admin/raritan (all lower case).
However, for the highest level of security, the
Dominion KX III forces the administrator to
change the Dominion KX Il default
administrative username and password when
the unit is first booted up.

Dominion KX Il contains a hardware reset
button that can be used to factory reset the
device, which will reset the administrative
password on the device to the default
password.
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Question Answer

How do | migrate from the In general, KX Il customers can continue to

Dominion KX Il to Dominion KX 111? use their existing switches for many years. As
their data centers expand, customers can
purchase and use the new KX Ill models.
Raritan’s centralized management appliance,
CommandCenter Secure Gateway (CC-SG)
Release 6.0 supports KX Il and KX IlI switches
seamlessly.

Will my existing KX 1l CIMs work Yes. Existing KX II CIMs will work with the

with Dominion KX Il switches? Dominion KX Il switch. In addition, select
Paragon CIMs will work with the KX IIl. This
provides an easy migration to KX IlI for
Paragon Il customers who wish to switch to
KVM over IP. However, you may want to
consider the D2CIM-VUSB and D2CIM-
DVUSB CIMs that support virtual media, audio
and Absolute Mouse Synchronization.
Additionally, digital video CIMs supporting DVI,
HDMI, and Display Port are also available.
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» U.S./Canada/Latin America

Monday - Friday

8am.-6p.m ET

Phone: 800-724-8090 or 732-764-8886

For CommandCenter NOC: Press 6, then Press 1

For CommandCenter Secure Gateway: Press 6, then Press 2
Fax: 732-764-8887

Email for CommandCenter NOC: tech-ccnoc@raritan.com
Email for all other products: tech@raritan.com

» China

Beijing

Monday - Friday

9 a.m. - 6 p.m. local time
Phone: +86-10-88091890

Shanghai

Monday - Friday

9 a.m. - 6 p.m. local time
Phone: +86-21-5425-2499

GuangZhou

Monday - Friday

9 a.m. - 6 p.m. local time
Phone: +86-20-8755-5561

> India

Monday - Friday
9 a.m. - 6 p.m. local time
Phone: +91-124-410-7881

> Japan

Monday - Friday

9:30 a.m. - 5:30 p.m. local time
Phone: +81-3-5795-3170

Email: support.japan@raritan.com

> Europe

Eu rope

Monday - Friday

8:30 a.m. - 5 p.m. GMT+1 CET
Phone: +31-10-2844040

Email: tech.europe@raritan.com

United Kingdom
Monday - Friday

8:30 a.m. to 5 p.m. GMT
Phone +44(0)20-7090-1390

France

Monday - Friday

8:30 a.m. - 5 p.m. GMT+1 CET
Phone: +33-1-47-56-20-39

Germany

Monday - Friday

8:30 a.m. - 5:30 p.m. GMT+1 CET
Phone: +49-20-17-47-98-0
Email: rg-support@raritan.com

» Melbourne, Australia

Monday - Friday
9:00 a.m. - 6 p.m. local time
Phone: +61-3-9866-6887

> Taiwan

Monday - Friday

9 a.m. - 6 p.m. GMT -5 Standard -4 Daylight
Phone: +886-2-8919-1333

Email: support.apac@raritan.com





